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Safety  

The caution and danger statements that this document contains can be referenced 

in the multilingual IBM® Safety Information document that is provided with every 

IBM System Storage™ DS4000 Storage Subsystem. Each caution and danger 

statement is numbered for easy reference to the corresponding statements in the 

translated document. 

v   Danger: These statements indicate situations that can be potentially lethal or 

extremely hazardous to you. A danger statement is placed just before the 

description of a potentially lethal or extremely hazardous procedure, step, or 

situation. 

v   Caution: These statements indicate situations that can be potentially hazardous 

to you. A caution statement is placed just before the description of a potentially 

hazardous procedure step or situation. 

v   Attention: These notices indicate possible damage to programs, devices, or data. 

An attention notice is placed just before the instruction or situation in which 

damage could occur.

Before installing this product, read the following danger and caution notices. 
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Statement 1: 

  

 

DANGER

Electrical current from power, telephone, and communication cables is 

hazardous. 

To avoid a shock hazard: 

v   Do not connect or disconnect any cables or perform installation, 

maintenance, or reconfiguration of this product during an electrical storm. 

v   Connect all power cords to a properly wired and grounded electrical outlet. 

v   Connect to properly wired outlets any equipment that will be attached to 

this product. 

v   When possible, use one hand only to connect or disconnect signal cables. 

v   Never turn on any equipment when there is evidence of fire, water, or 

structural damage. 

v   Disconnect the attached power cords, telecommunications systems, 

networks, and modems before you open the device covers, unless 

instructed otherwise in the installation and configuration procedures. 

v   Connect and disconnect cables as described in the following table when 

installing, moving, or opening covers on this product or attached devices.

 To Connect: To Disconnect: 

1.   Turn everything OFF.  

2.   First, attach all cables to devices. 

3.   Attach signal cables to connectors. 

4.   Attach power cords to outlet. 

5.   Turn device ON.  

1.   Turn everything OFF.  

2.   First, remove power cords from outlet. 

3.   Remove signal cables from connectors. 

4.   Remove all cables from devices.
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Statement 3: 

  

 

CAUTION: 

When laser products (such as CD-ROMs, DVD drives, fiber optic devices, or 

transmitters) are installed, note the following: 

v   Do not remove the covers. Removing the covers of the laser product could 

result in exposure to hazardous laser radiation. There are no serviceable parts 

inside the device. 

v   Use of controls or adjustments or performance of procedures other than those 

specified herein might result in hazardous radiation exposure.

  

 

DANGER

Some laser products contain an embedded Class 3A or Class 3B laser diode. 

Note the following. 

Laser radiation when open. Do not stare into the beam, do not view directly 

with optical instruments, and avoid direct exposure to the beam. 

Class 1 Laser statement 

  

 

IEC 825-11993 CENELEC EN 60 825 

 

Safety v



Statement 4: 

  

 

 

   

≥ 18 kg (39.7 lb) ≥ 32 kg (70.5 lb) ≥ 55 kg (121.2 lb)
  

CAUTION: 

Use safe practices when lifting. 

 Statement 5: 

  

 

CAUTION: 

The power control button on the device and the power switch on the power 

supply do not turn off the electrical current supplied to the device. The device 

also might have more than one power cord. To remove all electrical current from 

the device, ensure that all power cords are disconnected from the power source.

1

2
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Statement 29: 

  

 

CAUTION: 

This equipment is designed to permit the connection of the earthed conductor of 

the dc supply circuit to the earthing conductor at the equipment. 

This equipment is designed to permit the connection of the earthed conductor of 

the dc supply circuit to the earthing conductor at the equipment. If this 

connection is made, all of the following conditions must be met: 

v   This equipment shall be connected directly to the dc supply system earthing 

electrode conductor or to a bonding jumper from an earthing terminal bar or 

bus to which the dc supply system earthing electrode conductor is connected. 

v   This equipment shall be located in the same immediate area (such as, adjacent 

cabinets) as any other equipment that has a connection between the earthed 

conductor of the same dc supply circuit and the earthing conductor, and also 

the point of earthing of the dc system. The dc system shall not be earthed 

elsewhere. 

v   The dc supply source shall be located within the same premises as this 

equipment. 

v   Switching or disconnecting devices shall not be in the earthed circuit 

conductor between the dc source and the point of connection of the earthing 

electrode conductor.

 Statement 30: 

  

 

CAUTION: 

To reduce the risk of electric shock or energy hazards: 

v   This equipment must be installed by trained service personnel in a 

restricted-access location, as defined by the NEC and IEC 60950-1, First 

Edition, The Standard for Safety of Information Technology Equipment. 

v   Connect the equipment to a reliably grounded safety extra low voltage (SELV) 

source. An SELV source is a secondary circuit that is designed so that normal 

and single fault conditions do not cause the voltages to exceed a safe level (60 

V direct current). 

v   The branch circuit overcurrent protection must be rated 20 A. 

v   Use 12 American Wire Gauge (AWG) or 2.5 mm2 copper conductor only, not 

exceeding 4.5 meters in length. 

v   Incorporate a readily available approved and rated disconnect device in the 

field wiring.

  

 

 

Safety vii



CAUTION: 

This unit has more than one power source. To remove all power from the unit, 

all DC MAINS must be disconnected.
  

 

 Statement 8: 

  

 

CAUTION: 

Never remove the cover on a power supply or any part that has the following 

label attached. 

  

 

Hazardous voltage, current, and energy levels are present inside any component 

that has this label attached. There are no serviceable parts inside these 

components. If you suspect a problem with one of these parts, contact a service 

technician.
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About  this  document  

This document describes procedures for adding new Fibre Channel or SATA hard 

drives or new IBM System Storage DS4000 drive expansion enclosures containing 

new Fibre Channel or SATA hard drives to an existing IBM DS4000 Storage 

Subsystem configuration. This document also describes the procedure for 

migrating either Fibre Channel hard drives or IBM System Storage DS4000 storage 

expansion enclosures containing Fibre Channel hard drives from one DS4000 

storage subsystem to another. 

FAStT product renaming 

IBM has renamed some FAStT family products. Table 1 identifies each DS4000 

product name with its corresponding previous FAStT product name. Note that this 

change of product name only indicates no change in functionality or warranty. All 

products listed below with new names are functionally-equivalent and 

fully-interoperable. Each DS4000 product retains full IBM service as outlined in 

service contracts issued for analogous FAStT products. 

 Table 1. Mapping of FAStT names to DS4000 Series names 

Previous FAStT Product Name  Current® DS4000 Product Name  

IBM TotalStorage® FAStT Storage Server IBM TotalStorage DS4000 

FAStT DS4000 

FAStT Family DS4000 Mid-range Disk System 

FAStT Storage Manager vX.Y (for example 

v9.10) 

DS4000 Storage Manager vX.Y (for example 

v9.10) 

FAStT100 DS4100 

FAStT600 DS4300 

FAStT600 with Turbo Feature DS4300 Turbo 

FAStT700 DS4400 

FAStT900 DS4500 

EXP700 DS4000 EXP700 

EXP710 DS4000 EXP710 

EXP100 DS4000 EXP100 

FAStT FlashCopy® FlashCopy for DS4000 

FAStT VolumeCopy VolumeCopy for DS4000 

FAStT Remote Mirror (RM) Enhanced Remote Mirroring for DS4000 

FAStT Synchronous Mirroring Metro Mirroring for DS4000 

Global Copy for DS4000
(New Feature = Asynchronous Mirroring 

without Consistency Group) 

Global Mirroring for DS4000
(New Feature = Asynchronous Mirroring 

with Consistency Group)
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Who should read this document 

This document is intended for system administrators who are familiar with the 

IBM System Storage DS4000 storage subsystem components, terminology, and 

DS4000 Storage Subsystem administrative tasks. 

Illustrations 

Illustrations contained in this document depict general visual characteristics of the 

DS4000 Storage Subsystem, storage expansion unit, and Fibre Channel drive 

hardware cited. They are not intended for use as detailed DS4000 storage hardware 

images. 

Using this document 

Before you proceed to complete any storage addition or migration procedures 

detailed in this publication, familiarize yourself with the principles, prerequisite 

instructions at Chapter 2, “Prerequisites to adding capacity and hard drive 

migration,” on page 41, as well as the following storage addition or migration 

procedures applicable to your specific needs. 

v   Chapter 3, “Adding or migrating hard drives,” on page 55 

v   Chapter 4, “Adding or migrating storage expansion enclosures,” on page 69 

v   Chapter 5, “Upgrading a storage subsystem in a functioning configuration,” on 

page 115

Your familiarity with the principles, preliminary procedures, and detailed steps 

described in this document is critical to prevent loss of data availability, and in 

some cases, loss of data. If you have questions about the procedures described in 

this document, please contact the IBM Help Center in your geography for 

assistance. 

Important: 

1.   Do not mix SATA and Fibre Channel drives in the same enclosure (DS4700 and 

EXP810). 

2.   Do not place SATA drives in a Fibre Channel enclosure (DS4300, EXP700, 

EXP710). 

3.   Do not place Fibre Channel drives in a SATA enclosure (DS4100, DS4200 

Express, or EXP420). 

4.   Do not mix SATA drive expansion enclosures (EXP100) and Fibre Channel drive 

enclosures (EXP700 and EXP710) in the same drive loop or the same DS4000 

Storage Subsystem unless you purchase the Fibre Channel/SATA intermix 

premium feature entitlement and upgrade the controller firmware to 06.10.11.xx 

or higher. 

5.   Do not mix EXP500 storage expansion enclosures with EXP710 and EXP810 

storage expansion enclosures in a DS4000 Storage Subsystem configuration. 

6.   Do not mix storage expansion enclosures running at different FC speeds in the 

same redundant drive channel/loop pair. Please refer to the Installation, User’s, 

and Maintenance Guide for your particular DS4000 storage subsystem for specific 

information about which storage expansion enclosure model types and FC 

speeds are supported, and whether you can attach expansion enclosures with 

different FC speeds behind it. 
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7.   Always check the information that is shipped with the storage expansion 

enclosures, the DS4000 controller firmware readme files, the Installation, User’s, 

and Maintenance Guide for your specific DS4000 Storage Subsystem and storage 

expansion enclosure, and this guide for: 

v   the latest storage subsystem/storage expansion enclosure compatibility. 

v   any requirements of the installed microcode and firmware to support the 

DS4000 Storage Subsystem and storage expansion enclosure.

How to send your comments 

Your feedback is important to help us provide the highest quality of information. If 

you have any comments about this document, please either fill out the Readers’ 

comments form (RCF) at the back of this document and give it to an IBM 

representative, or submit it in one of the following ways: 

v   E-mail 

–   Submit your comments over the Internet to: 

starpubs@us.ibm.com
–   Submit your comments over IBMLink™ from the U.S.A. to: 

STARPUBS at SJEVM5
–   Submit your comments over IBMLink from Canada to: 

STARPUBS at TORIBM
–   Submit your comments over IBM Mail Exchange to: 

USIB3WD at IBMMAIL
Be sure to include the name and order number of the document and, if 

applicable, the specific location of the text that you are commenting on, such as 

a page or table number. 

v   Mail 

Complete the Readers’ comments form (RCF) at the back of this document and 

return it by mail. If the RCF Business Reply Mailer has been removed, you can 

address your comments to: 

International Business Machines Corporation 

Information Development 

Dept. GZW 

9000 South Rita Road 

Tucson, Arizona 85744-0001 

U.S.A.
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Chapter  1.  Introduction  

Scalability is a primary attribute of the IBM System Storage DS4000 Storage 

Subsystem family. Whenever the need arises, you can expand a DS4000 Storage 

Subsystem from its minimum to its maximum capacity configuration. To expand 

DS4000 Storage Subsystem configurations you can purchase additional equipment 

or, in some cases, migrate equipment from DS4000 Storage Subsystem 

configurations previously deployed. 

The typical DS4000 Storage Subsystem drive connects to both Controller A and 

Controller B. Taken together, these connections represent dual drive loops or a 

redundant drive loop pair. You must connect drive loops in pairs to enable 

redundant drive loop configurations (two data paths per drive enclosure). 

Note:  In the DS4200 Express, DS4700 Express, and the DS4800 Storage Subsystem 

publications, these redundant drive loop pairs are referred to as redundant 

drive channel pairs. In addition, the DS4200 Express, DS4700 Express, and 

DS4800 have two ports per drive channel. Even though you can cable two 

different Fibre Channel cable loops per drive channel, these two physically 

cabled Fibre Channel loops are viewed logically as a single drive channel or 

loop by the DS4200, DS4700 Express, or DS4800 controller. 

Table 2 provides a list of the maximum allowable number of drives and drive loop 

pairs for each DS4000 Storage Subsystem by machine type and model number. It 

also specifies storage expansion enclosure license requirements. 

 Important:  

 Do not intermix Fibre Channel devices (such as the DS4300 Storage Subsystem and 

EXP700 and EXP710 storage expansion enclosure) and SATA devices (such as the 

DS4100 Storage Subsystem and EXP100 storage expansion enclosure) in the same 

storage subsystem environment unless you purchase the Fibre Channel/SATA 

intermix premium feature entitlement and upgrade the DS4000 Storage Subsystem 

controller firmware to 06.10.11.xx or higher. See “IBM System Storage DS4000 Fibre 

Channel and Serial ATA Intermix Premium Feature” on page 25 for more 

information. 

  Table 2. Maximum allowable drives and drive loop pairs in DS4000 storage servers 

Product name 

Machine 

type 

Model 

number 

Maximum 

number of 

drives 

Maximum 

number of 

drive 

loop/channel 

pairs 

Storage 

expansion unit 

license 

requirement 

IBM System Storage 

DS4100 Storage 

Subsystem (Single 

Controller model) 

1724 1SC, 1Sx 14 0 None. The 

DS4100 Single 

Controller 

Storage 

Subsystem does 

not support 

storage 

expansion 

enclosure 

attachment. 
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Table 2. Maximum allowable drives and drive loop pairs in DS4000 storage 

servers (continued) 

Product name 

Machine 

type 

Model 

number 

Maximum 

number of 

drives 

Maximum 

number of 

drive 

loop/channel 

pairs 

Storage 

expansion unit 

license 

requirement 

IBM System Storage 

DS4100 Storage 

Subsystem 

1724 100 56 1 None 

IBM System Storage 

DS4200 Express 

Storage™ Subsystem 

1814 7VA, 7VH  112 1 Supports no 

storage 

expansion 

enclosures. 

Must purchase 

1–3 and 4–6 

storage 

expansion 

enclosure 

attachment 

entitlements to 

connect up to 

the maximum 

number of 

storage 

expansion 

enclosures. 

IBM System Storage 

DS4300 Fibre 

Channel Storage 

Subsystem 

1722 60X 

60U 

56 1 Purchase 

storage 

expansion 

enclosure 

entitlements in 

increments up 

to three storage 

expansion 

enclosures per 

DS4300 Storage 

Subsystem. 

IBM System Storage 

DS4300 Fibre 

Channel Storage 

Subsystem (with 

Turbo option) 

112 1 None. The 

DS4300 (with 

Turbo option) 

includes a 

seven storage 

expansion unit 

entitlement. 

IBM System Storage 

DS4300 Fibre 

Channel Storage 

Subsystem (Single 

Controller model) 

6LU 

6LX 

14 0 None. The 

DS4300 Single 

Controller 

Storage 

Subsystem does 

not support 

storage 

expansion 

enclosure 

attachment. 
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Table 2. Maximum allowable drives and drive loop pairs in DS4000 storage 

servers (continued) 

Product name 

Machine 

type 

Model 

number 

Maximum 

number of 

drives 

Maximum 

number of 

drive 

loop/channel 

pairs 

Storage 

expansion unit 

license 

requirement 

IBM System Storage 

DS4400 Fibre 

Channel Storage 

Subsystem2 

1742 1RU 

1RX 

224 2 None 

IBM System Storage 

DS4500 Fibre 

Channel Storage 

Subsystem2 

1742 90X 

90U 

224 2 None 

IBM System Storage 

DS4700 Express 

Fibre Channel 

Storage Subsystem3 

1814 70A 70H 

70S 70T 

112 1 Supports no 

storage 

expansion 

enclosures. 

Must purchase 

1–3 and 4–6 

storage 

expansion 

enclosure 

attachment 

entitlements to 

connect up to 

the maximum 

number of 

storage 

expansion 

enclosures. 

72A 72H 

72S 72T 

112 1 Comes  with 1–3 

storage 

expansion 

enclosure 

attachments (64 

drives total). 

Must purchase 

4–6 storage 

expansion 

enclosure 

attachments to 

get 112 drives. 

IBM System Storage 

DS4800 Fibre 

Channel Storage 

Subsystem2 

1815 80x2 224 2 Comes  with 

entitlement to 

attach up to 112 

drives, must 

purchase 

additional 

entitlements to 

attach up to 224 

drives. 

82x, 84x 

88x2 

224 2 None 
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Table 2. Maximum allowable drives and drive loop pairs in DS4000 storage 

servers (continued) 

Product name 

Machine 

type 

Model 

number 

Maximum 

number of 

drives 

Maximum 

number of 

drive 

loop/channel 

pairs 

Storage 

expansion unit 

license 

requirement 

IBM System Storage 

FAStT200 Fibre 

Channel Storage 

Subsystem 

3542 1RU 

1RX 

38 1 None 

IBM System Storage 

FAStT200 High 

Availability (HA)  

Fibre Channel 

Storage Subsystem1 

2RU 

2RX 

66 1 None 

IBM System Storage 

FAStT500 Fibre 

Channel Storage 

Subsystem2 

3552 1RU 

1RX 

224 2 None 

Notes:  

1.   The maximum number of drives supported by the FAStT200 HA Storage Subsystem 

(models 2RU and 2RX) assumes attachment to 4 14-drive storage expansion enclosures 

containing 56 Fibre Channel drives. 

2.   The maximum number of drives supported by FAStT500, DS4400, DS4500, and DS4800 

Storage Subsystems assumes their attachment to 16 14-drive storage expansion 

enclosures. In addition, for the DS4500 and DS4800 storage subsystem, the maximum 

number of drives can also be supported by connecting 14 16-drive storage expansion 

enclosures. 

3.   For the DS4200 Express and DS4700 Express storage subsystem, the maximum number 

of drives can also be supported by connecting six 16-drive storage expansion enclosures. 

4.   There are two  cases in which the maximum number of drives in a drive loop/channel 

will be less than the supported maximum of 112 drives. These cases arise, when: 

a.   intermixing storage expansion enclosures have different drive slots capacities; or, 

b.   intermixing a DS4000 storage subsystem having internal drive slots with storage 

expansion enclosures containing different drive slots capacities.

These two  cases arise because IBM does not support partially filled storage enclosures; 

that is, where some slots are left empty in order to ensure that the maximum number of 

drives in the drive loop does not exceed 112. See the intermixing EXP500 and EXP700 or 

EXP100, EXP810 and EXP710 sections for more information.
  

Intermixing storage expansion enclosures 

This section contains information on the following topics: 

v   Intermixing EXP500 and EXP700 storage expansion enclosures 

v   Intermixing EXP700 or EXP100 and EXP710 storage expansion enclosures 

v   Intermixing EXP100, EXP710 and EXP810 storage expansion enclosures

For  important information about using the Fibre Channel and SATA Intermix 

premium feature, including configuration and setup requirements, see “IBM 

System Storage DS4000 Fibre Channel and Serial ATA Intermix Premium Feature” 

on page 25. 
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For hardware compatibility, ensure that the environmental service module (ESM) 

firmware for each storage expansion enclosure and the storage server controller 

firmware are either at or above the levels that are recommended in Table 19 on 

page 45 and Table 20 on page 48. 

DS4000 Storage Subsystems support the addition of external drive enclosures to: 

v   Provide additional storage capacity (as in the case of DS4400, DS4500, and 

DS4800 Storage Subsystems) 

v   Enable the expansion of a storage subsystem’s capacity beyond that of a given 

DS4000 Storage Subsystem chassis (as in the case of DS4100 and DS4300 Storage 

Subsystems)

When increasing the capacity of your storage subsystem in either of these ways, 

you might choose to add external drive enclosures of the same model and type or 

of different types. IBM does not support the combination of every DS4000 external 

drive enclosure type and model in every DS4000 Storage Subsystem configuration. 

In addition, not all controller firmware versions support all available storage 

expansion enclosures or storage subsystems. Restrictions on the connection of drive 

enclosures that differ by model and type to DS4000 Storage Subsystems are 

documented in this section. 

Table 3 indicates, by model, which DS4000 expansion enclosures can coexist in the 

same redundant drive loop of a DS4000 Storage Subsystem. 

 Table 3. Mixed DS4000 expansion enclosure compatibility in storage subsystems by model 

DS4000 

expansion 

enclosure 

DS4000 

EXP100 

(SATA) 

DS4000 

EXP420 

DS4000 

EXP500 

(Fibre 

Channel) 

DS4000 

EXP700 

(Fibre 

Channel) 

DS4000 

EXP710 

(Fibre 

Channel) 

DS4000 EXP810 

(Fibre Channel / 

SATA) 

IBM System 

Storage 

DS4000 

EXP100 

(SATA) 

U�1� U�2� U�2� U�8� 

IBM System 

Storage 

DS4000 

EXP420 

(SATA) 

U�9� 

IBM System 

Storage 

DS4000 

EXP500 (Fibre 

Channel) 

U�4� 

(1 Gbps 

only) 

U�3� 

(1 Gbps 

only) 

IBM System 

Storage 

DS4000 

EXP700 (Fibre 

Channel) 

U�2� U�3� 

(1 Gbps 

only) 

U�3� U�5� 

IBM System 

Storage 

DS4000 

EXP710 (Fibre 

Channel) 

U�2� U�5� U�5� U�6� 
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Table 3. Mixed DS4000 expansion enclosure compatibility in storage subsystems by 

model (continued) 

IBM System 

Storage 

DS4000 

EXP810 (Fibre 

Channel / 

SATA) 

U�8� U�6� U �6� �7� 

�1�Requires controller firmware 06.10.11.xx or higher (DS4300 with 

Turbo option, DS4400, and DS4500), 06.12.03.xx or higher (DS4300 dual 

controller standard/Base, DS4100 Base) or 06.14.xx.xx and 06.15.xx.xx 

(DS4800). Controller firmware 06.16.xx.xx does not support EXP100. 

Note: There are versions of 05.41.xx.xx controller firmware that also 

provide DS4000 EXP100 support for DS4300 (with dual controller 

standard/Base or Turbo option), DS4400, and DS4500 Storage 

Subsystems or versions of 05.42.xx.xx xx controller firmware that also 

provide DS4000 EXP100 support for DS4100 Storage Subsystems. 

However, IBM recommends that you use controller firmware version 

06.12.xx.xx or higher for the DS4100, DS4300 (with Base or Turbo 

option), DS4400, and DS4500 Storage Subsystems, instead. 

�2� Supported only with Fibre Channel/SATA intermix entitlement 

purchase and controller firmware version 06.12.xx.xx. In addition, the 

storage subsystem must also be in the DS4000 Storage Subsystem list 

that supports the FC/SATA intermix premium feature. 

�3� Requires controller firmware 05.2x.xx.xx–05.40.xx.xx. 

�4� Requires controller firmware 04.xx.xx.xx or 05.xx.xx.xx. 

�5� Requires controller firmware 06.10.11.xx or higher. 

�6� Requires controller firmware 06.16.xx.xx or higher for DS4800 and 

DS4700 Express subsystems. The EXP810 supports SATA drives with 

controller firmware version 06.16.8x.xx or higher. 

�7� Currently, the EXP810 supports SATA drives or intermixing with 

EXP100 SATA drive expansion enclosures in DS4300 dual controller 

standard/base or Turbo and DS4500 subsystems with controller 

firmware version 06.19.xx. Please contact your IBM representative or 

IBM Support for information about EXP810 and EXP100 enclosures 

intermixing behind other DS4000 storage subsystems in future releases. 

�8� Requires controller firmware version 06.19.xx with the DS4300 and 

DS4500 subsystems. 

�9� EXP420 is supported as drive expansion enclosure attachment to 

DS4200 only. Requires controller firmware 06.16.8x.xx or 06.16.9x.xx. 

  

Table 4 indicates what DS4000 expansion enclosures can attach to DS4000 Storage 

Subsystems by model. 

 Table 4. DS4000 expansion enclosure compatibility with DS4000 Storage Subsystems by 

model 

DS4000 

storage 

device 

DS4000 

EXP100 

(SATA) 

DS4000 

EXP420 

(SATA) 

DS4000 

EXP500 

(Fibre 

Channel) 

DS4000 

EXP700 

(Fibre 

Channel) 

DS4000 

EXP710 

(Fibre 

Channel) 

DS4000 

EXP810 

(Fibre 

Channel 

and SATA) 
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Table 4. DS4000 expansion enclosure compatibility with DS4000 Storage Subsystems by 

model (continued) 

DS4100 

Storage 

Subsystem 

(Base model, 

SATA) 

U�2� 

DS4100 

Storage 

Subsystem 

(Single 

Controller 

model, SATA) 

DS4200 

Storage 

Subsystem 

(SATA) 

U 

DS4300 

Storage 

Subsystem 

(Single 

Controller 

model, Fibre 

Channel) 

DS4300 

Storage 

Subsystem 

(Turbo 

option, Fibre 

Channel) 

U�2��3� U�2� U�4� U�6� 

DS4300 

Storage 

Subsystem 

(Base model, 

Fibre 

Channel) 

U�1� U U�4� 

DS4400 

Storage 

Subsystem 

(Fibre 

Channel, 

SATA) 

U�2��3� U 

(1 Gbps 

only) 

U�2� U�4� 

DS4500 

Storage 

Subsystem 

(Fibre 

Channel, 

SATA) 

U�2��3� U 

(1 Gbps 

only) 

U�2� U�4� U�6� 

DS4700 

Express 

Storage 

Subsystem 

(Fibre 

Channel) 

U�4� U�5� 
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Table 4. DS4000 expansion enclosure compatibility with DS4000 Storage Subsystems by 

model (continued) 

DS4800 

Storage 

Subsystem 

(Fibre 

Channel, 

SATA) 

U�2��3� U�4� U�5� 

FAStT200 

Storage 

Subsystem 

(Fibre 

Channel) 

U 

(1 Gbps 

only) 

U 

(1 Gbps 

only) 

FAStT500 

Storage 

Subsystem 

(Fibre 

Channel) 

U 

(1 Gbps 

only) 

U 

(1 Gbps 

only) 
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Table 4. DS4000 expansion enclosure compatibility with DS4000 Storage Subsystems by 

model (continued) 

�1� The DS4300 base will support FC/SATA intermix only when the controller 

firmware is of version 06.12.xx.xx or higher and the Fibre Channel/SATA 

intermix entitlement is purchased. 

In addition, although the DS4300 Storage Subsystem (Base model) will support 

Fibre Channel or SATA drives with controller firmware version 05.41.xx.xx, it 

will not support both in a mixed environment. It will, however, support SATA 

drives in an attached storage enclosure (only), but never in the DS4300 Storage 

Subsystem, itself. In addition, before the DS4300 Storage Subsystem (Base 

model) will support a DS4000 EXP100 drive enclosure, it is necessary to 

remove all Fibre Channel drives from the DS4300 chassis. 

�2� The intermix of DS4000 EXP700 and EXP710 Fibre Channel drive 

enclosures with DS4000 EXP100 SATA drive enclosures in a given DS4000 

Storage Subsystem is supported only with Fibre Channel/SATA intermix 

entitlement purchase and controller firmware version 06.10.11.xx or higher. The 

DS4800 Storage Subsystems do not support the attachment of EXP700 drive 

expansion enclosures. You must upgrade the EXP700 drive expansion 

enclosure to EXP710 before attaching to the DS4800 Storage Subsystem. 

�3� DS4000 Storage Subsystems require the following firmware to manage 

EXP100 expansion enclosures. 

DS4100 Base  

Either 5.42.xx.xx or 06.12.1x.xx. Version 6.12.1x.xxx is recommended. 

DS4300 Base or Turbo and DS4500 

Either 05.41.5x.xx or 06.1x.xx.xx. Version 06.19.xx.xx is recommended. 

DS4400 

06.1x.xx.xx. Version 06.12.xx.xx or higher is recommended. 

DS4800 

Version 06.15.xx.xx is recommended (6.16.xx.xx does not support 

EXP100).

�4� Requires controller firmware version 06.1x.xx.xx or higher. Version 

06.19.xx.xx is recommended for DS4300 dual controller standard/Base or Turbo 

and DS4500 (also see footnote 6). DS4400 requires controller firmware version 

06.12.xx.xx. For DS4700 Express, version 06.16.8x.xx or higher is required. For 

DS4800, version 06.16.8x.xx or higher is recommended, if there are no EXP100 

enclosures in the configuration; otherwise, controller version version 6.15.xx.xx 

is recommended for DS4800. 

�5� Requires controller firmware 06.16.18.xx or higher for DS4800 and 

06.16.4x.xx or higher for DS4700 Express. Currently, EXP810 does not support 

intermixing with EXP100 SATA drive expansion enclosures in the DS4700 and 

DS4800 storage subsystems. 

�6� Requires controller firmware version 06.19.xx.xx. This version of controller 

firmware does not support DS4000 EXP500 or EXP700 storage expansion 

enclosures; however, the EXP700 enclosures can be upgraded using the DS4000 

EXP700 Models 1RU/1RX Switched-ESM Option Upgrade Kits enabling them to 

be supported in DS4000 storage subsystems with 06.19.xx.xx controller 

firmware installed. 
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Table 5. Storage expansion enclosures supported by controller firmware versions 

Controller 

firmware version EXP storage expansion enclosures 

EXP100 EXP420 EXP500 EXP700 EXP710 EXP810 

5.3x.xx.xx No No Yes Yes No No 

5.40.xx.xx No No Yes Yes No No 

5.41.xx.xx Yes No No No No No 

5.42.xx.xx Yes No No No No No 

6.00.xx.xx No No No Yes Yes No 

6.10.xx.xx No No No Yes No No 

6.12.xx.xx Yes No No Yes Yes No 

6.14.xx.xx Yes No No No Yes No 

6.15.xx.xx Yes No No No Yes No 

6.16.2x.xx No No No No Yes Yes 

6.16.8x.xx/
6.16.9x.xx 

No Yes No No Yes Yes 

6.19.xx.xx Yes No No No Yes Yes
  

Currently, IBM supports the following storage expansion enclosure models: 

EXP100, EXP420, EXP500, EXP700, EXP710, and EXP810. Table 6 lists those drive 

expansion enclosure models that are considered of the same storage enclosure type 

for the purpose of grouping together in an intermixed SATA/Fibre Channel 

storage expansion enclosure loop configuration.

Note:  The EXP420 and EXP500 are not listed in Table 6 because they are not 

supported in an intermixed SATA/Fibre Channel storage expansion 

enclosure loop configuration.

 Table 6. DS4000 drive expansion enclosure models compatible in intermixed loop 

configurations only when contiguously grouped 

Group-compatible EXP100 

models 

Group-compatible EXP700 

models 

Group-compatible 

EXP710 and EXP810 

models 

1710-10X 1740-1RU 1740-710 , 1812-81A2 

1710-10U 1740-1RX 1740-1RU1 , 1812-81H2 

1724-1XP 1740-1RX1 

1.   Consider this EXP700 model as an EXP710 for grouping purposes; only after it is 

upgraded with the DS4000 EXP700 field upgrade to switched ESMs. 

2.   EXP810 FC/SATA Intermix is supported at the enclosure level only. You cannot intermix 

Fibre Channel and SATA drives within the same enclosure. DS4700 Express and DS4800 

storage subsystems do not support the intermix of EXP810 expansion enclosures (either 

Fibre Channel or SATA E-DDMs)  with EXP100 expansion enclosures.
  

You can mix DS4000 System Storage EXP500 (which operates only at 1 Gbps) and 

DS4000 System Storage EXP700 (which operates at either 1 Gbps or 2 Gbps) 

storage expansion enclosures in the same redundant drive loop pair in all DS4400 

and DS4500 Storage Subsystem configurations. However, you must set the EXP700 
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to 1 Gbps. There is no restriction to the physical sequence of mixed EXP700 and 

EXP500 expansion enclosures in the same redundant drive loop pair. You cannot 

mix these enclosures in the same redundant drive loop pair in DS4100, DS4200, 

DS4300, DS4700, and DS4800 Storage Subsystem configurations. See “Intermixing 

EXP500 and EXP700 storage expansion enclosures” on page 12 for more 

information. 

Not all available DS4000 storage subsystems support all available DS4000 storage 

expansion enclosures. For example, the DS4700 Express Storage Subsystem 

supports only the DS4000 EXP710 and EXP810 storage expansion enclosures The 

DS4200 Express storage subsystem supports only the DS4000 EXP420 storage 

expansion enclosure. See Table 3 on page 5 for more information. 

Although you can intermix the EXP700 and EXP100 storage expansion enclosures 

with EXP710 storage expansion enclosures in the same redundant drive loop pair 

in a DS4000 Storage Subsystem configuration, you must group together all DS4000 

EXP710 storage expansion enclosures in the redundant drive loop. See 

“Intermixing EXP700 or EXP100 and EXP710 storage expansion enclosures” on 

page 14 and Table 6 on page 10 for additional information. 

Currently, the EXP810 drive expansion enclosures can be intermixed in the same 

redundant drive channel/loop pair with the EXP100 (controller firmware version 

06.19.xx) and EXP710 drive expansion enclosures only. The EXP810 enclosure speed 

switch must be set at 2Gbps. See “Intermixing EXP100, EXP710 and EXP810 

storage expansion enclosures” on page 19 and Table 6 on page 10 for additional 

information. 

Do not intermix the EXP500 (which operates only at 1 Gbps) and EXP710, EXP810 

or EXP100 (which operates only at 2 Gbps) storage expansion enclosures in the 

same redundant drive loop pair. Also, do not attach these storage expansion 

enclosures to the same controller. 

Although there are no restrictions against cabling either DS4000 EXP100 and 

DS4000 EXP700 or DS4000 EXP810 and DS4000 EXP710 storage expansion 

enclosures together, for ease of future maintenance and possible troubleshooting, 

IBM recommends that, if possible, you plan your configuration to allow for 

grouping all DS4000 drive expansion enclosures by type in a DS4000 Storage 

Subsystem redundant drive loop. 

 Attention:   Even though IBM supports intermixing different drive expansion 

enclosure models in the same redundant drive loop, IBM recommends use of a 

single drive expansion enclosure model (for example, EXP100, EXP500, EXP700, 

EXP710, or EXP810) in a given redundant drive loop. 

 Important:  

 Do not change the speed of a drive loop while the DS4000 Storage Subsystem is 

powered on. Such a speed change will cause unpredictable results. Also, the drive 

expansion enclosures must be power cycled for the new speed setting to be 

correctly recognized. 

 To change the speed of a drive loop: 

__ Step 1.   Prepare applications for DS4000 Storage Subsystem shutdown. 

__ Step 2.   Shutdown the DS4000 Storage Subsystem. 

__ Step 3.   Shutdown the DS4000 storage expansion enclosures. 
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__ Step 4.   Change the storage expansion enclosure speed settings. 

__ Step 5.   Power on the DS4000 storage expansion enclosures. 

__ Step 6.   Power on the DS4000 Storage Subsystem. 

__ Step 7.   Restore DS4000 Storage Subsystem host application operations.

Note:  For additional information on turning a storage server on and off, see the 

DS4000 Storage Subsystem Installation, User’s, and Maintenance Guide. For more 

information on these guides, see the following Web site: 

www.ibm.com/servers/storage/support/disk/ 

See “DS4000 Storage Subsystem drive loop schemes” on page 26 and “Setting 

enclosure IDs” on page 31 for details on cabling DS4000 Storage Subsystems and 

storage expansion enclosures together as well as setting their enclosure IDs. 

Intermixing EXP500 and EXP700 storage expansion 

enclosures 

When connecting the EXP500 and EXP700 enclosures in the same DS4000 Storage 

Subsystem, although the EXP700 storage expansion enclosure is capable of 

operating at 2 Gbps, you must set the Fibre Channel speed of drive loops in a 

mixed storage expansion enclosure environment to the lowest Fibre Channel speed 

supported by all hardware in the loop, which is 1 Gbps. 

If one of the drive loops in a DS4000 Storage Subsystem configuration is set to 1 

Gbps, you must set all of the drive loops to 1 Gbps. This speed restriction applies 

to all four drive loops in either the DS4400 or DS4500 Storage Subsystem 

configuration, even where some of the drive loops consist only of EXP700 storage 

expansion enclosures that might otherwise operate at 2 Gbps. 

Figure 1 on page 13 illustrates cabling of DS4000 System Storage EXP500 and 

EXP700 storage expansion enclosures in a mixed configuration.
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There are maximum limits to the number of Fibre Channel hard drives that you 

can configure in redundant drive loop pairs. The maximum number of drives 

dictates a fixed number of supported EXP500 and EXP700 drive enclosure 

combinations.Table 7 on page 14 lists the numbers of EXP500 and EXP700 storage 

expansion enclosures that you can combine for use in a single redundant drive 

loop pair. Table 7 on page 14 assumes that a DS4000 Storage Subsystem is 

generally capable of addressing the maximum of 112 Fibre Channel hard drives for 

each redundant drive loop pair. 

 Important:  

 IBM supports only those EXP500 and EXP700 Storage Expansion Unit 

combinations listed in Table 7 on page 14. 

Minihub speed
must be set to
1Gbps for all

four drive
minihubs

Drive loop
A

Drive loop
B

EXP500 and
EXP700 drive
enclosures are

in the same
drive loop

d
s
h

0
0

0
2

4

DS4400 Storage Server

DS4000 EXP700

DS4000 EXP700

DS4000 EXP500

  

Figure 1. DS4000 EXP500 and EXP700 cabling in a mixed configuration
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Table 7. Supported EXP500 and EXP700 enclosure combinations per redundant drive loop 

pair 

Total number of 

EXP500 enclosures per 

redundant drive loop 

pair 

Total number of 

EXP700 enclosures 

per redundant 

drive loop pair 

Maximum number of 

storage expansion 

enclosures per 

redundant drive loop 

pair 

Maximum number 

of drives per 

redundant drive 

loop pair 

11 0 11 110 

10 0 10 100 

9 1 10 104 

8 2 10 108 

7 3 10 112 

6 3 9 102 

5 4 9 106 

4 5 9 110 

3 6 9 114 

2 6 8 104 

1 7 8 108 

0 8 8 112
  

Note:  The combination of three EXP500 and six EXP700 storage expansion 

enclosures has the maximum number of 114 drives per redundant drive loop 

pair. You can have this maximum number of hard drives per drive loop pair 

only in this mixed EXP500 and EXP700 configuration. 

Intermixing EXP700 or EXP100 and EXP710 storage expansion 

enclosures 

Attention:  Please read this section carefully. Before intermixing EXP700/EXP710 

and EXP100 drive expansion enclosures in a DS4000 Storage Subsystem, you must 

purchase IBM System Storage DS4000 SATA and Fibre Channel storage expansion 

enclosure intermix entitlement. You must also check the controller firmware 

requirements in Table 3 on page 5 for intermix compatibility. 

It is possible to intermix EXP700 or EXP100, and EXP710 storage expansion 

enclosures in the same drive loop. To do so, however, you must group all of the 

EXP710 storage expansion enclosures together to enable the EXP710 Reliability and 

Serviceability (RAS) features and to optimize the data transferring between the 

EXP710. These intermixing requirements must also be met if you are upgrading 

some (but not all) of the EXP700 storage expansion enclosures in a drive loop with 

the EXP700 Models 1RU/1RX Switched-ESM Option Upgrade Kit (P/N 25R0166). 

Once upgraded, these EXP700 drive expansion enclosures are considered EXP710 

drive expansion enclosures, even though the machine type and models might be 

still be shown as EXP700 machine types and models. 

 Important:  

 IBM does not support any configuration in which EXP710 drive expansion 

enclosures are not grouped together. 
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Figure 2 though Figure 4 on page 17 show three acceptable EXP700 and EXP710 

intermixing cabling configurations in which all EXP710 storage expansion 

enclosures are grouped together. Note that in Figure 4 on page 17, the EXP710 

storage expansion enclosures are grouped together, even though the EXP700 

storage expansion enclosures are not grouped together. 

Although illustrations Figure 2 through Figure 6 on page 19 incorporate the DS4000 

DS4300 Storage Subsystem for the sake of example, other DS4000 storage servers 

might be acceptable replacements. The DS4000 EXP100 would also intermix 

successfully with an EXP710 when substituted for an EXP700 in an equivalent loop 

configuration.
  

d
s
h
0
0
0
1
3

EXP700

EXP700

EXP710

EXP710

  

Figure 2. Acceptable intermixed EXP700 (or EXP100) and EXP710 loop configuration (1 of 3)
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Figure 3. Acceptable intermixed EXP700 (or EXP100) and EXP710 loop configuration (2 of 3)
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In Figure 5 on page 18 and Figure 6 on page 19, the intermixed configurations 

shown are not supported because the EXP710 storage expansion enclosures in the 

redundant drive loop are not grouped together. When substituting a DS4000 

EXP100 for an EXP700 enclosure in an equivalent drive loop cabling configuration, 

the intermixed drive loop cabling is also not supported.
 

d
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h
0
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5

EXP700

EXP710

EXP710

EXP700

  

Figure 4. Acceptable (not recommended) intermixed EXP700 (or EXP100) and EXP710 loop 

configuration (3 of 3)
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Figure 5. Unacceptable intermixed EXP700 (or EXP100) and EXP710 loop configuration (1 of 

2)
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Intermixing EXP100, EXP710 and EXP810 storage expansion 

enclosures 

With controller firmware 6.19.xx.xx.xx, the DS4300 and DS4500 support the 

intermixing of the EXP810 with EXP710s and EXP100s; however, you can only 

intermix the EXP710 and EXP100 with the EXP710 in the DS4700 and DS4800 

storage subsystems with controller firmware versions 6.16.8x.xx or 6.16.9x.xx 

installed. Even though storage expansion enclosures (EXP710s and EXP810s) do not 

need to be grouped by drive enclosure type, IBM recommends that you do group 

d
s
h
0
0
0
1
7

EXP710

EXP700

EXP710

EXP700

  

Figure 6. Unacceptable intermixed EXP700 (or EXP100) and EXP710 loop configuration (2 of 

2)
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them by enclosure type in a redundant drive channel pair; this simplifies 

maintenance and troubleshooting. In addition, the EXP810 Link Rate switch must 

be set at 2 Gbps. 

Note:  The Link Rate setting only becomes effective after the EXP710 and EXP100 

are powered up. Do not change the setting while the EXP810 is operational. 

Schedule a time to shut down the entire DS4000 configuration to change the 

Link Rate speed setting. 

There are maximum limits to the number of Fibre Channel hard drives that you 

can configure in redundant drive channel pairs. The maximum number of drives 

dictates a fixed number of supported EXP100 and/or EXP710 and EXP810 drive 

enclosure combinations. Table 8 lists the numbers of EXP100 and/or EXP710 and 

EXP810 storage expansion enclosures that you can combine for use in a single 

redundant drive channel/loop pair. Table 8 also assumes that a DS4000 Storage 

Subsystem is generally capable of addressing the maximum of 112 Fibre Channel 

hard drives for each redundant drive channel/loop pair. 

 Table 8. Supported EXP810 and EXP710, and/or EXP100 enclosure combinations per 

redundant drive channel/loop pair in a DS4000 subsystem with no internal drive slots 

configuration 

Total number of 

EXP810 

enclosures per 

redundant drive 

channel/loop pair 

Total number of 

EXP710 and/or 

EXP100 

enclosures per 

redundant drive 

channel/loop pair 

Maximum 

number of 

storage 

expansion drives 

per redundant 

drive 

channel/loop pair 

Maximum number of drives in 

a mixed EXP710 and EXP810 

drive channel/loop pair 

0 8 8 112 

1 6 7 100 

2 5 7 102 

3 4 7 104 

4 3 7 106 

5 2 7 108 

6 1 7 110 

7 0 7 112
  

IBM recommends that you do not mix EXP100s and/or EXP710s and EXP810s 

together in the same redundant drive channel/loop pair if you plan to operate the 

EXP810 at a higher speed. Therefore, IBM recommends that you connect all of the 

EXP710s and/or EXP100s to a redundant drive channel pair and all of the EXP810s 

to the other (second) redundant drive channel pair in a DS4800 storage subsystem 

configuration. 

Table 9 on page 21 shows the supported EXP810 and EXP710 storage expansion 

enclosures combinations per redundant drive channel/loop pair in a DS4700 

Express configuration. The table assumes that a DS4700 Express storage subsystem 

is generally capable of addressing the maximum of 112 Fibre Channel hard drives 

for each redundant drive channel/loop pair. 

(The DS4700 Express (with its internal drives) is already counted as one enclosure 

against the maximum number of enclosures that can be in a redundant 

channel/loop pair.) 
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Table 9. Supported EXP810 and EXP710 enclosure combinations per redundant drive 

channel/loop pair in a DS4700 Express configuration 

Number of 

EXP810s 

Total 

number of 

drives in 

EXP810s 

Number of 

EXP710s 

Total 

number of 

drives in 

EXP710s 

Total 

number of 

drives in 

the DS4700 

Express/
DS4800 

Total number of 

drives in a mixed 

EXP710 and EXP810 

drive loop 

0 0 6 84 16 = 100 

1 16 5 70 16 = 102 

2 32 4 56 16 = 104 

3 48 3 42 16 = 106 

4 64 2 28 16 = 108 

5 80 1 14 16 = 110 

6 96 0 0 16 = 112
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Attention:   

1.   Do not connect a combination of more than eight EXP710/EXP100 or seven 

EXP810 storage expansion enclosures to the two ports of a dual-ported drive 

channel. Failure to observe this limitation might result in loss of data 

availability. 

2.   Do not connect more than four EXP810 storage expansion enclosures to each 

port of the dual-ported drive channel. There are no restrictions to four or less 

storage expansion enclosures connected per drive port for the EXP710 and the 

EXP100 storage expansion enclosures; however, IBM recommends using the 

same rule for the EXP710/EXP100 enclosures to maximize drive channel 

performance. 

3.   It is recommended that you add storage expansion enclosures to the DS4800 

drive ports in a round-robin fashion. For example, if you have 4 EXP810s 

needing to be cabled to the DS4800, instead of cabling all 4 EXP810s to one 

drive port of a drive channel, you should distribute the enclosures to all drive 

ports, which results in one enclosure per drive port of a drive channel. 

4.   Do not connect more than the recommended maximum number of enclosures 

per drive channel (8 for 14-drive and 7 for 16-drive enclosures). When mixing 

14-drive and 16-drive enclosures, the maximum number of expansion 

enclosures is 7 per redundant drive channel pair. 

5.   DS4800 supports storage expansion enclosures operating at different Fibre 

Channel speeds (for example, 2 Gbps or 4 Gbps) only when they are installed 

in separate redundant drive channel pairs. DS4800 does not support a mix of 

storage expansion enclosures operating at different Fibre Channel speeds in the 

same redundant drive channel pair. 

6.   Even though you can intermingle EXP710 and EXP810 storage expansion 

enclosures in the same redundant drive channel pair, it is recommended that 

you cable storage together expansion enclosures of the same type to facilitate 

maintenance and troubleshooting in the event of failures. For instance, if you 

have EXP710s and EXP810s in the same redundant drive channel pair, it is 

preferred that you group the EXP710s together and the EXP810s together.

Table  10 shows the supported EXP810, EXP710, and EXP100 storage expansion 

enclosures combinations per redundant drive channel/loop pair in a DS4300 Turbo 

configuration. The table assumes that a DS4300 storage subsystem is generally 

capable of addressing the maximum of 112 Fibre Channel hard drives for each 

redundant drive channel/loop pair. 

 Table 10. Possible combinations of 14-drive and 16-drive storage expansion enclosures per 

drive loop for DS4300 dual controller Turbo models only 

Number of 

EXP810s (16 

drives/unit) 

Total 

number of 

drives in 

EXP810s 

Number of 

EXP710/ 

EXP100s (14 

drives/unit) 

Total 

number of 

drives in 

EXP710/ 

EXP100s 

Total 

number of 

drives in 

the DS4300 

Total number 

of drives in a 

mix  EXP710s 

and EXP810s 

drive loop 

0 0 7 98 14 = 112 

1 16 5 70 14 = 100 

2 32 4 56 14 = 102 

3 48 3 42 14 = 104 

4 64 2 28 14 = 106 

5 80 1 14 14 = 108 

6 96 0 0 14 = 110
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Figure 7 and Figure 8 on page 24 illustrate acceptable cabling of EXP710 and 

EXP810 storage expansion enclosures in a mixed configuration. 

Figure 9 on page 25 shows a recommended cabling example of the EXP810 and 

EXP710 enclosures in the same drive channel pair in a DS4800 configuration. All of 

the EXP810 are cabled together to one port of the dual-port drive channel in each 

of the controllers. Similarly all of the EXP710s are cabled together to the other port 

of the dual-port drive channel. 

  

  

Figure 7. Acceptable intermixed DS4000 EXP710 and EXP810 loop configuration
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Figure 8. Acceptable intermixed DS4000 EXP710 and EXP810 loop configuration

 

24 Adding  and Migrating Drives and Expansion  Enclosures  to DS4000 Storage  Servers



IBM System Storage DS4000 Fibre Channel and Serial ATA  Intermix 

Premium Feature 

The DS4000 FC/SATA Intermix premium feature supports the concurrent 

attachment of Fibre Channel and SATA storage expansion enclosures to a single 

DS4000 controller configuration. 

With this premium feature, you can create and manage distinct arrays or logical 

drives that are built from either Fibre Channel disks or SATA disks in a DS4000 

Storage Subsystem, and allocate the drives to the appropriate applications in the 

attached host servers. 

Notes:  

1.   For the most current information on the DS4000 Fibre Channel and SATA 

(FC/SATA) Enclosure Intermix premium feature, see the IBM System Storage 

Support Web site: 

www.ibm.com/servers/storage/support/disk/ 

2.   EXP810 FC/SATA Intermix is supported at the enclosure level only. You cannot 

intermix Fibre Channel and SATA drives within the same enclosure. For the 

most current information on the DS4000 Fibre Channel and SATA (FC/SATA) 

Enclosure Intermix premium feature and regarding future support for other 

Fibre Channel/SATA intermix combinations of DS4000 storage subsystems and 

storage expansion enclosures, contact your IBM reseller or representative, or 

check the DS4000 Interoperability Matrix at the IBM System Storage Support 

Web site: 

www-03.ibm.com/servers/storage/disk/ds4000/pdf/interop-matrix.pdf 
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Figure 9. Preferred intermixed DS4000 EXP710 and EXP810 loop configuration
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3.   You must purchase the DS4000 FC/SATA Enclosure Intermix premium feature 

for each DS4000 Storage Subsystem that will have drive channels/loops 

intermixing SATA and Fibre Channel technology drives. 

To ensure a successful intermixing of storage expansion enclosures, please see 

Appendix A, Appendix A, “IBM System Storage DS4000 Fibre Channel and Serial 

ATA Intermix Premium Feature Installation Overview,” on page 129, for detailed 

information including: 

v   Intermix premium feature installation instructions 

v   Controller firmware requirements 

v   Supported combinations of DS4000 storage subsystems and storage expansion 

enclosures 

v   Recommended cabling schemes 

v   Important restrictions

The following restrictions apply to the use of the DS4000 FC/SATA Intermix 

premium feature, and should be noted: 

Setting Enclosure IDs with unique single digit values 

Enclosure IDs (sometimes known as tray IDs, or server IDs) consist of two 

digits: x10 and x1. In 14-drive expansion enclosures (EXP100/EXP700/
EXP710), you can set the enclosure ID manually. Ensure that the single 

digit (x1) of the enclosure ID is unique for every enclosure in a redundant 

drive loop pair. 

Grouping DS4000 storage expansion enclosures in a redundant drive loop 

 

 

Attention: 

Configurations that do not follow this DS4000 storage expansion 

enclosures grouping restriction are not supported.

 When mixing enclosures with Fibre Channel and SATA drives in a drive 

loop (DS4300/DS4400/DS4500) or behind a drive channel port 

(DS4700/DS4800), always group the enclosures with the same drive 

interface technology together.

DS4000 Storage Subsystem drive loop schemes 

Although a variety of cable loop schemes might function acceptably, IBM 

recommends consistent use of only one such scheme when connecting DS4000 

Storage Subsystems and expansion enclosures. Figure 10 on page 27 illustrates the 

only cable loop scheme that IBM recommends when connecting DS4000 Storage 

Subsystems and expansion enclosures.
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Legend: 

�1� Recommended cabling for EXP100, EXP500, EXP700, and EXP710 with 

DS4000 Storage Subsystem 

�2� Recommended cabling for EXP810 with DS4000 Storage Subsystem

IBM cautions against inconsistent use of any cable loop scheme. Figure 11 on page 

28 through Figure 14 on page 31 show unacceptable cabling loop schemes. 

 Attention:   Do not use the cable schemes illustrated in Figure 11 on page 28 or 

Figure 14 on page 31 because they will affect diagnostic capability in the event of 

drive loop failures. 

v   Do not connect more than 4 enclosures behind each drive channel port. 

v   For non-EXP810, connect to the IN port of the ESM on the left and the OUT port 

of the ESM on the right. 

v   For EXP810, connect to port 1B on either the right or left ESM.
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Figure 10. Recommended cable loop scheme for connecting DS4000 storage devices
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Legend: 

�1� Method not recommended for cabling for EXP100, EXP500, EXP700, and 

EXP710 with DS4000 Storage Subsystem 

�2� Method not recommended for cabling for EXP810 with DS4000 Storage 

Subsystem
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Figure 11. Not  recommended for alternate cable loop scheme, when connecting DS4000 

storage devices
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Legend: 

�1� Not recommended cabling for EXP100, EXP500, EXP700, and EXP710 with 

DS4000 Storage Subsystem 

�2� Not recommended cabling for EXP810 with DS4000 Storage Subsystem
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Figure 12. Not  recommended alternate cable loop scheme for connecting DS4000 storage 

devices
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Legend: 

�1� Unacceptable cabling for EXP100, EXP500, EXP700, and EXP710 with 

DS4000 Storage Subsystem 

�2� Unacceptable cabling for EXP810 with DS4000 Storage Subsystem

Note:  The cable loop scheme in Figure 13 is unacceptable because both drive loops 

are connected to the IN port of the EXP700. Although this restriction does 

not specifically apply to other storage expansion enclosures, you should still 

avoid connecting both drive loops in the IN port to prevent accidental 

miscabling in the EXP700 environment. 
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Figure 13. Unacceptable cable loop scheme for connecting DS4000 storage devices
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Legend: 

�1� Unacceptable cabling for EXP100, EXP500, EXP700, and EXP710 with 

DS4000 Storage Subsystem 

�2� Unacceptable cabling for EXP810 with DS4000 Storage Subsystem

Note:  The cable loop scheme in Figure 14 is unacceptable because of the random 

pattern between the storage expansion enclosures. 

Setting enclosure IDs 

Each drive enclosure (including the DS4000 storage subsystem with internal drive 

slots) in a DS4000 Storage Subsystem configuration must have a unique drive 

enclosure ID. DS4000 controllers use a combination of the enclosure ID and the 

number of the physical slot that a hard drive occupies to create a unique loop 

address or arbitrated loop physical address (AL_PA) for each drive in a drive loop. 

The enclosure ID consists of two digits, a tens (x10) digit and a ones (x1) digit. 

IBM recommends the use of the tens digit portion of the enclosure ID to 

differentiate enclosures from different redundant drive loop/channel pairs and the 

singles digit portion to differentiate enclosures in the same redundant drive 

loop/channel pair. The possible values for the tens and the ones digits are 0-9 for 

EXP420, EXP500, and EXP810 drive enclosures, and 0-7 for EXP100, EXP700, and 

EXP710 drive enclosures. 

The enclosure ID of each enclosure (including the DS4000 storage subsystem with 

internal drive slots) in a redundant drive loop must have unique ones digit IDs. 

This setting will enforce hard AL_PAs (unchangeable between Loop Initializations 

[LIPs]) for the drives and facilitate drive loop problem troubleshooting in the event 

of an error. If the ones digits are not unique, two or more devices will have the 

same hard AL_PA. In such a case, the controller will use soft AL_PAs for the 
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Figure 14. Unacceptable cable loop scheme for connecting DS4000 storage devices
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devices that have identical hard AL_PAs. (This was previously a best practice 

recommendation, but it is now a requirement.) 

 Important:  

 Changing enclosure IDs on 14-drive enclosures and storage subsystems with the 

mechanical enclosure ID switch requires the power cycle of the DS4000 subsystem 

and all enclosures in the configuration to activate the new settings. Changing the 

enclosure IDs on 16-drive enclosures and storage subsystems (EXP420s, EXP810s, 

DS4700s, or DS4200s) does not require the power cycle of all enclosures and the 

DS4000 subsystem, if there are no 14-drives enclosures intermixed in the 

configuration or if the 16-drive enclosures are only connected to a DS4000 

controller with 16 internal drive slots (DS4200 or DS4700). If the enclosure IDs of 

the enclosures or storage subsystems with the mechanical enclosure ID switch in 

your DS4000 subsystem configuration are not currently set to have unique single 

digit values for the enclosures in the same redundant drive loop pair, make the 

changes to the enclosure IDs in the next maintenance schedule. This will prevent 

unnecessary downtime when you add enclosures of different type (especially 

EXP810s) to the existing enclosures in the redundant drive loop/channel pair. 

 You do not have to manually assign an enclosure ID for an EXP810 storage 

expansion enclosure. The enclosure ID is automatically assigned. However, if you 

do manually assign the enclosure ID for the EXP810, ensure that the enclosure ID 

of the EXP810s in the same drive loop are unique.

Note:  If you are using an EXP100, EXP710, and EXP810 in a drive loop, you must 

set the enclosure ID for the EXP100 and EXP710. The EXP810 enclosure ID is 

automatically set. 

The problem with soft AL_PA addressing is that addresses can change between 

LIPs. This possibility increases the difficulty of troubleshooting drive loop 

problems because it is difficult to ascertain whether the same device with a 

different address or a different device might be causing a problem. Because the 

DS4000 Storage Subsystem can support more enclosures than available values of 

the enclosure ID ones digit, Table 11 on page 33 through Table 15 on page 36 

suggest enclosure ID settings for various drive expansion enclosure families to 

minimize soft addressing in a drive loop. Also note that soft AL_PA addressing 

might result in an excessive number of drive loop information events posting in 

the DS4000 storage subsystem Major Events Log (MEL); especially in a DS4000 

storage subsystem having different storage enclosure types intermixed in the same 

redundant drive loop pair; for example, DS4300 subsystem configurations 

intermixed with EXP810s and EXP100s in the same drive loop. 

 Important:  

 The recommended enclosure ID settings were changed, starting with this release of 

the IBM System Storage DS4000 Hard Drive and Storage Expansion Enclosure 

Installation and Migration Guide. The ID settings were modified to avoid having 

enclosure IDs of 0 (zero) in a drive loop/channel. Due to the physical design and 

movement of the mechanical enclosure ID switch, it is possible to leave the switch 

in a dead zone between ID numbers, which returns an incorrect enclosure ID to 

the storage management software. The most commonly returned enclosure ID is 0 

(zero). In addition to causing the subsystem management software to report an 

incorrect enclosure ID, this behavior also results in an enclosure ID conflict error 

with the storage expansion enclosure or DS4000 storage subsystem in which the ID 

has been intentionally set to 0 (zero). 
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The DS4200 Express and DS4700 Express storage subsystems and the EXP420 and 

EXP810 storage expansion enclosures do not have mechanical ID switches and are 

not susceptible to this problem. These storage subsystems and storage expansion 

enclosures automatically set the enclosure IDs. IBM recommends not making any 

changes to these settings, unless the automatic enclosure ID settings result in 

non-unique single digit settings for all enclosures (including the storage 

subsystems with internal drive slots) in a given drive loop/channel. 

  Table 11. EXP500 Storage Expansion Enclosure ID settings 

Storage expansion enclosure 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop if 

applicable/supported 

1st unit 

(storage expansion enclosure 

or storage server with internal 

drive slots) 

10 x0 

(where x is 3-7) 

2nd unit 

(EXP500) 

11 x1 

(where x is 3-7) 

3rd unit 

(EXP500) 

12 x2 

(where x is 3-7) 

4th unit 

(EXP500) 

13 x3 

(where x is 3-7) 

5th unit 

(EXP500) 

14 x4 

(where x is 3-7) 

6th unit 

(EXP500) 

15 x5 

(where x is 3-7) 

7th unit 

(EXP500) 

16 x6 

(where x is 3-7) 

8th unit 

(EXP500) 

17 x7 

(where x is 3-7) 

9th unit 

(EXP500) 

18 x8 

(where x is 3-7) 

10th unit 

(EXP500) 

19 x9 

(where x is 3-7) 

11th unit 

(EXP500) 

21 x0 

(where x is 3-7)
  

Note:  Drives in the 11th enclosures of each drive loop in Table 11 will have soft 

AL_PAs. 

Table 12 suggests enclosure ID settings that minimize soft addressing for EXP100 

storage expansion enclosures in a drive loop. 

 Table 12. EXP100 Storage Expansion Enclosure ID settings 

Storage expansion enclosure 

(unmixed) 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop if 

applicable/supported 

1st unit 

(EXP100 Expansion Enclosure 

or DS4000 Storage Subsystem 

with internal drive slots) 

10 x0 

(where x is 3-7) 

 

Chapter 1. Introduction 33



Table 12. EXP100 Storage Expansion Enclosure ID settings (continued) 

Storage expansion enclosure 

(unmixed) 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop if 

applicable/supported 

2nd unit 

(EXP100) 

11 x1 

(where x is 3-7) 

3rd unit 

(EXP100) 

12 x2 

(where x is 3-7) 

4th unit 

(EXP100) 

13 x3 

(where x is 3-7) 

5th unit 

(EXP100) 

14 x4 

(where x is 3-7) 

6th unit 

(EXP100) 

15 x5 

(where x is 3-7) 

7th unit 

(EXP100) 

16 x6 

(where x is 3-7) 

8th unit 

(EXP100) 

17 x7 

(where x is 3-7) 

9th unit 

(EXP100, where the first unit is 

a DS4300 only) 

21 

  

Note:  Except for the drives in the 9th unit, all drives in the drive loops described 

in Table 12 on page 33 will be assigned hard AL_PAs. 

Table 13 suggests enclosure ID settings that minimize soft addressing for EXP700 or 

EXP710 storage expansion enclosures in a drive loop. 

 Table 13. EXP700 or EXP710 Storage Expansion Enclosure ID settings 

Storage expansion enclosure 

(unmixed) 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop if 

applicable/supported 

1st unit 

(storage expansion enclosure 

or DS4000 Storage Subsystem 

with internal drive slots) 

10 x0 

(where x is 3-7) 

2nd unit 

(EXP700) 

11 x1 

(where x is 3-7) 

3rd unit 

(EXP700) 

12 x2 

(where x is 3-7) 

4th unit 

(EXP700) 

13 x3 

(where x is 3-7) 

5th unit 

(EXP700) 

14 x4 

(where x is 3-7) 

6th unit 

(EXP700) 

15 x5 

(where x is 3-7) 

7th unit 

(EXP700) 

16 x6 

(where x is 3-7) 
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Table 13. EXP700 or EXP710 Storage Expansion Enclosure ID settings (continued) 

Storage expansion enclosure 

(unmixed) 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop if 

applicable/supported 

8th unit 

(EXP700) 

17 x7 

(where x is 3-7)
  

Note:  All drives in drive loops described in Table 13 on page 34 will be assigned 

hard AL_PAs. 

Table 14 suggests enclosure ID settings that minimize soft addressing for the 

EXP500 and EXP700 storage expansion enclosure when intermixed in a redundant 

drive loop. 

 Table 14. Intermixed EXP500 and EXP700 Storage Expansion Enclosure ID settings 

Storage expansion enclosure 

models (intermixed) 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop 

1st unit 

(EXP500 or EXP700) 

10 x0 

(where x is 3-7) 

2nd unit 

(EXP500 or EXP700) 

11 x1 

(where x is 3-7) 

3rd unit 

(EXP500 or EXP700) 

12 x2 

(where x is 3-7) 

4th unit 

(EXP500 or EXP700) 

13 x3 

(where x is 3-7) 

5th unit 

(EXP500 or EXP700) 

14 x4 

(where x is 3-7) 

6th unit 

(EXP500 or EXP700) 

15 x5 

(where x is 3-7) 

7th unit 

(EXP500 or EXP700) 

16 x6 

(where x is 3-7) 

8th unit 

(EXP500 or EXP700) 

17 x7 

(where x is 3-7) 

9th unit 

(EXP500 or EXP700) 

18 for EXP500 or 21 for 

EXP700 

x8 

where x is 3-7 for EXP500 or 

x1 for EP700 where x is 3-7 

and is not a number that was  

chosen for the 2nd unit above 

10th unit 

(EXP500 or EXP700) 

19 for EXP500 or 22 for 

EXP700 

x9
where x is 3-7 for EXP500 or 

x2 for EP700 where x is 3-7 

and is not a number that was  

chosen for the 3rd unit above 

  

Note:  The drives in the 9th and 10th enclosures in each drive loop described in 

Table 14 will have soft AL_PAs.
Table 15 on page 36 suggests enclosure ID settings that minimize soft addressing 

for the EXP700 and EXP710 storage expansion enclosure when intermixed in a 

redundant drive loop. 
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Table 15. Intermixed EXP700 and EXP710 Storage Expansion Enclosure ID settings 

Storage expansion enclosure 

models (intermixed) 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop 

1st unit 

(storage expansion enclosure 

or DS4000 Storage Subsystem 

with internal slots) 

10 x0 

(where x is 3-7) 

2nd unit 

(EXP700 or EXP710) 

11 x1 

(where x is 3-7) 

3rd unit 

(EXP700 or EXP710) 

12 x2 

(where x is 3-7) 

4th unit 

(EXP700 or EXP710) 

13 x3 

(where x is 3-7) 

5th unit 

(EXP700 or EXP710) 

14 x4 

(where x is 3-7) 

6th unit 

(EXP700 or EXP710) 

15 x5 

(where x is 3-7) 

7th unit 

(EXP700 or EXP710) 

16 x6 

(where x is 3-7) 

8th unit 

(EXP700 or EXP710) 

17 x7 

(where x is 3-7)
  

Table 16 suggests enclosure ID settings that minimize soft addressing for the 

EXP100, EXP710, and EXP810 storage expansion enclosures when intermixed in a 

redundant drive loop. The DS4200 and DS4700 storage subsystems and the EXP420 

and EXP810 storage expansion enclosures do not have mechanical enclosure ID 

switches. These storage subsystems and storage expansion enclosures automatically 

set the enclosure IDs. In DS4000 configurations with these storage subsystems or 

expansion enclosures, IBM recommends not making any changes to these settings, 

unless the automatic enclosure ID settings result in non-unique single digit settings 

for any enclosures (including the storage subsystems with internal drive slots) in a 

given drive loop/channel. Use the following table only in configurations that have 

an intermix of storage subsystems and/or expansion enclosures with mechanical 

enclosure ID switches (EXP100, EXP710 or DS4300) and storage subsystems and/or 

expansion enclosures with electronic enclosure ID (EXP810, DS4700). 

 Table 16. Intermixed EXP100, EXP710, and EXP810 Storage Expansion Enclosure ID 

settings 

Storage expansion enclosure 

models (intermixed) 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop 

1st unit 

(EXP810 or EXP100) EXP710, 

or DS4000 Storage Subsystem 

with internal slots 

10 x0(where x is 3-7) 

2nd unit 

(EXP810 or EXP710) 

11 x1(where x is 3-7) 

3rd unit 

(EXP810 or EXP710) 

12 x2(where x is 3-7) 
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Table 16. Intermixed EXP100, EXP710, and EXP810 Storage Expansion Enclosure ID 

settings (continued) 

Storage expansion enclosure 

models (intermixed) 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop 

4th unit 

(EXP810 or EXP710) 

13 x3(where x is 3-7) 

5th unit 

(EXP810 or EXP710) 

14 x4(where x is 3-7) 

6th unit 

(EXP810 or EXP710) 

15 (or 16 if connected to the 

DS4700 storage subsystem 

having default enclosure ID 

set at 85) 

x5 (or x6 if connected to the 

DS4700 storage subsystem 

having default enclosure ID 

set at 85)(where x is 3-7) 

7th unit 

(EXP810 or EXP710) 

17 x7(where x is 3-7)

  

Note:  Use the values of the enclosure IDs in the first redundant drive 

loop/channel pair column as recommended settings for the EXP420s 

attaching to DS4200s. 

Determining firmware levels 

There are two different methods to determine DS4000 Storage Subsystem, 

expansion unit, drive, and ESM firmware versions. Each method uses the DS4000 

Storage Manager client that manages the DS4000 storage subsystem with the 

attached expansion unit. 

Method one: 

For controllers with firmware version 6.1x.xx.xx or later, go to the Subsystem 

Management window and select Storage Subsystem -> View Profile. For 

controllers with firmware version 5.xx.xx.xx.xx or earlier select View -> Storage 

Subsystem Profile. When, under either circumstance, the Storage Subsystem 

Profile window opens, select the All tab and scroll through the Profile For Storage 

Subsystem to locate the following information.

Note:  The Profile For Storage Subsystem contains all the profile information for 

the entire subsystem. Therefore, it might be necessary to scroll through a 

large amount of information to locate the firmware version numbers.

DS4000 Storage Subsystem 

v   NVSRAM version 

v   Appware version (Appware is a reference to controller firmware). 

v   Bootware version (Bootware is a reference to controller firmware.)
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See the following example or snapshot of profile information. 

 Controller in Enclosure 0, Slot A 

Status: Online 

Current configuration 

Firmware version: 06.10.07.00 

Appware version: 06.10.07.00 

Bootware version: 06.10.07.00 

NVSRAM version: 1722F600R910V05 

  

Drives 

v   Firmware version 

v   ATA translator card (for EXP810 SATA drive CRU only)

ESM 

v   ESM card firmware version

Method two: 

Select the appropriate procedure from the following options and complete it to 

obtain the specified firmware version. 

To obtain the controller firmware version: 

Right click the Controller icon in the Physical View pane of the Subsystem 

Management window and select Properties. The Controller Enclosure 

properties window opens and displays the properties for that controller. 

 You must perform this step for each individual controller. 

To obtain the drive and ATA translator firmware version: 

Right Click the Drive icon in the Physical View pane of the Subsystem 

Management window and select Properties. The Drive Properties window 

opens and displays the properties for that drive. 

 You must perform this step for each individual drive. 

To obtain the ESM firmware version: 

1.   In the Physical View pane of the Subsystem Management window, click 

the Drive Enclosure Component icon (which is the icon furthest to the 

right). The Drive Enclosure Component Information window opens. 

2.   Click the ESM icon in the left pane. The ESM information displays in 

the right pane of the Drive Enclosure Component Information window. 

3.   Locate the firmware version of each ESM in the drive enclosure.

To  obtain the drive enclosure component firmware version: 

1.   Click the Drive Enclosure Component icon (the icon located furthest to 

the right) in the Drive Enclosure frame in the Physical View pane of the 

Subsystem Management window. The Drive Enclosure Component 

Information window opens. 

2.   Click the ESM icon in the left pane. The ESM information displays in 

the right pane of the Drive Enclosure Component Information window. 

3.   Locate the firmware version of each ESM in the drive enclosure. 

You must perform this step for each drive expansion enclosure.
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Determining the product ID and model of a drive 

You can determine the product ID and model of a drive from the storage server 

profile through the menu option in the DS4000 Subsystem Management window. 

To get the profile, in the DS4000 Subsystem Management window, either click 

View -> Storage Subsystem Profile (if the controller firmware version is 05.xx.xx, 

or earlier) or Storage Subsystem -> View Profile (if the controller firmware 

version is 06.xx.xx, or later). When the Storage Subsystem Profile window displays, 

click on the Drives tab and scroll down to the information about the drive which 

product ID and model you want to verify. See Table 17 for a sample profile 

indicating the product ID of the drive in slot 1 of enclosure ID 1 as ST3146807FC. In 

addition, the Speed and Current Data Rate fields show that this drive is a 10Krpm 

drive and is operating at 2 Gbps Fibre Channel data rate. 

 Table 17. Snapshot of profile information identifying the product ID of the drive in slot 1 of 

enclosure ID 1 as ST3146807FC 

HOT SPARE COVERAGE: 

 The following arrays are not protected: 1, 2 

  

 Total hot spare drives: 0 

  Standby: 0 

  In use: 0 

  

DETAILS: 

 Drive at Enclosure 1, Slot 1 

  Drive port: 1, Channel: 1; ID: 8/0xD9 

  Drive port: 2, Channel: 2; ID: 8/0xD9 

  Drive path redundancy: OK 

  Status: Optimal 

  Raw capacity: 136.732 GB 

  Usable capacity: 136.732 GB 

  Current data rate: 2 Gbps 

  Product ID: ST3146807FC        !# 

  Firmware version: B350 

  Serial number: 3HY062YK00007309FAT1 

  Vendor: IBM-ESXS 

  Date of manufacture: May 29, 2002 

  World-wide name: 20:00:00:04:cf:56:43:fb 

  Drive type: Fibre Channel 

  Speed: 10033 RPM 

  Mode: Assigned 

  Associated array: 1 

  

 Drive at Enclosure 1, Slot 2 

  Drive port: 1, Channel: 2; ID: 9/0xD9 

  Drive port: 2, Channel: 1; ID: 9/0xD9 

  Drive path redundancy: OK 

  Status: Optimal 

  Raw capacity: 136.732 GB 

  Usable capacity: 136.732 GB 

  Current data rate: 2 Gbps 

  

 

  

DS4000 Storage Manager installation and support guides 

This publication frequently cites IBM System Storage DS4000 Storage Manager 

installation and support guides, which support various versions and operating 

system environments. There are currently two, namely: 
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v   IBM System Storage DS4000 Storage Manager Installation and Support Guide for 

AIX®, HP-UX, Solaris and Linux® on Power 

v   IBM System Storage DS4000 Storage Manager Installation and Support Guide for 

Intel-based Operating System Environments

Visit  the following Web site to access documentation related to your particular 

operating system and DS4000 Storage Manager version. 

www.ibm.com/servers/storage/support/disk/ 

See Appendix C, “Additional DS4000 documentation,” on page 161 for more 

information. 
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Chapter  2.  Prerequisites  to adding  capacity  and  hard  drive  

migration  

Perform the preliminary steps detailed in this chapter before you add storage 

capacity or migrate hard drives. After you meet these prerequisite requirements, 

proceed to any of the following sections to address your particular storage 

hardware addition or migration requirements: 

v   Chapter 3, “Adding or migrating hard drives,” on page 55 

v   Chapter 4, “Adding or migrating storage expansion enclosures,” on page 69 

v   Chapter 5, “Upgrading a storage subsystem in a functioning configuration,” on 

page 115

Failure to perform the steps listed in this section might result in loss of data 

availability, and in some cases, loss of data. Perform the following steps on the 

DS4000 Storage Subsystem to which you will migrate or add new hard drives: 

__ Step  1.   Complete a full backup of all data residing on the DS4000 Storage 

Subsystem. 

__ Step  2.   Verify that the backup was successful. 

__ Step  3.   Verify that the DS4000 Storage Subsystem has the latest controller 

firmware, nonvolatile storage random access memory (NVSRAM), 

and ESM firmware. 

 Attention:  Before upgrading the controller firmware, please consult 

the readme file that is packaged with the firmware code for any 

special prerequisite tasks or any ESMs firmware version and/or 

stepping stone controller firmware that must be installed first before 

the controller can be upgraded to the firmware code that is in the 

firmware package. Failure to do this might result in lost of data 

availability. There are certain minimum controller firmware version 

requirements associated with various drive expansion enclosures. See 

Table 3 on page 5 and Table 4 on page 6, and Table 5 on page 10 for 

related information. 

__ Step  4.   Verify that the drive firmware is at the latest level. If it is not, see 

“Upgrading drive firmware levels” on page 49. 

__ Step  5.   Verify that the DS4000 Storage Subsystem to which you will migrate 

the hard drives is in optimal state. If it is not, perform the appropriate 

steps listed in the Recovery Guru to bring the storage subsystem into 

optimal state. 

__ Step  6.   Use the Read_Link_Status function of the Storage Manager client 

program and the DS4000 Storage Subsystem management event log 

(MEL) to verify that the drive loops are in optimal state. If the DS4000 

storage subsystem controller firmware is version 06.10.xx.xx or higher, 

use the drive channel diagnostics to determine if the drive loop is 

optimal. 

__ Step  7.   Investigate and resolve any errors that reported in the DS4000 Storage 

Subsystem MEL. 

__ Step  8.   Save and store the storage subsystem profile of the DS4000 Storage 

Subsystem. 
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__ Step  9.   It is necessary to purchase the Fibre Channel/SATA intermix premium 

feature option and follow the associated instructions to activate the 

Fibre Channel/SATA premium feature. 

__ Step 10.   Before adding or migrating hard drives, be sure you establish drive 

model compatibility. Refer to the information for your drive options 

for the most current environment for your drive. You can also refer to 

Table 18, which follows. 

 Table 18. Drive capacity / interface type and speed compatibilities 

Product ID Drive capacity Drive interface 

type and speed† 

Notes 

Fibre Channel (FC) disk device modules 

ST39103FC !# 10K / 9.1GB 1 Gbps FC-AL 

ST318203FC !# 10K / 18.2GB 1 Gbps FC-AL 

ST136403FC !# 10K / 36.4GB 1 Gbps FC-AL 

ST318304FC !# 10K / 18.2GB 1 Gbps FC-AL 

ST336704FC !# 10K / 36.4GB 1 Gbps FC-AL 

ST173404FC !# 10K / 73.4GB 1 Gbps FC-AL 

ST318451FC !# 15K / 18.2GB 1 Gbps FC-AL 

ST336605FC !# 10K / 36.4GB 2 Gbps FC-AL 

ST373405FC !# 10K / 73.4GB 2 Gbps FC-AL 

ST318452FC !# 15K / 18.2GB 1 Gbps FC-AL 

ST336752FC !# 15K / 36.4GB 1 Gbps FC-AL 

ST318432FC F 15K / 18.2GB 2 Gbps FC-AL 

ST336732FC F 15K / 36.4GB 2 Gbps FC-AL 

ST318307FC F 10K / 18.2GB 2 Gbps FC-AL Available as FRU 

replacements only 

ST336607FC F 10K / 36.4GB 2 Gbps FC-AL 

ST373307FC F 10K / 73.4GB 2 Gbps FC-AL 

ST3146807FC F 10K / 146GB 2 Gbps FC-AL 

ST318453FC F 15K / 18.2GB 2 Gbps FC-AL 

ST336753FC F 15K / 36.4GB 2 Gbps FC-AL 

ST373453FC F 15K / 73.4GB 2 Gbps FC-AL 

HUS103073FLF21 10K / 73.4GB 2 Gbps FC-AL 

HUS103014FLF21 10K / 146GB 2 Gbps FC-AL 

HUS103030FLF21 10K / 300GB 2 Gbps FC-AL 

HUS103036FLF21 10K / 36.4G 2 Gbps FC-AL Available as FRU 

replacements only 

HUS103018FLF21 10K / 1.2G 2 Gbps FC-AL Available as FRU 

replacements only 

HUS103009FLF21 10K / 9.1G 2 Gbps FC-AL Available as FRU 

replacements only 
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Table 18. Drive capacity / interface type and speed compatibilities (continued) 

ST318454FC F 15K / 18.2G 2 Gbps FC-AL  Available as FRU 

replacements only 

ST336754FC F 15K / 36.4GB 2 Gbps FC-AL  

ST373454FC F 15K / 73.4GB 2 Gbps FC-AL  

ST3146854FC F 15K / 146GB 2 Gbps FC-AL  

ST336854FC F 15K / 36.4GB 4 Gbps FC-AL  

(can also operate 

at 2Gbps) 

ST373554FC F 15K / 73.4GB 4 Gbps FC-AL  

(can also operate 

at 2Gbps) 

ST3146854FC F 15K / 146GB 4 Gbps FC-AL  

(can also operate 

at 2Gbps) 

MAX3036FD F 15K / 36.4GB 4 Gbps FC-AL  

(can also operate 

at 2Gbps) 

MAX3073FD F 15K / 73.4GB 4 Gbps FC-AL  

(can also operate 

at 2Gbps) 

MAX3147FD F 15K / 146GB 4 Gbps FC-AL  

(can also operate 

at 2Gbps) 

Serial ATA (SATA) Disk Device Modules 

MAXTOR  7Y250MO 7.2K / 250G 1.5 Gbps SATA 

can operate at 

enclosure 2Gbps 

FC speed 

For DS4100 and 

EXP100 only 

ST3250823NS 

71P7313 

7.2K / 250G 1.5 Gbps SATA 

can operate at 

enclosure 2Gbps 

FC speed 

For DS4100 and 

EXP100 only 

ST3400832NS 

39M4575 

7.2K / 400G 1.5 Gbps SATA 

can operate at 

enclosure 2Gbps 

FC speed 

For DS4100 and 

EXP100 only 

ST3500641NS 

39M4557 39M0181 

IBM 

7.2K / 500G 3 Gbps SATA II 

can operate at 

either enclosure 

2Gbps or 4Gbps 

FC speed 

For DS4700 Express 

and EXP810 only 

ST3500641NS 

42D0392 39M0181 

IBMV 

7.2K / 500G 3 Gbps SATA II 

can operate at 

either enclosure 

2Gbps or 4Gbps 

FC speed 

For DS4200 and 

EXP420 only 
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Table 18. Drive capacity / interface type and speed compatibilities (continued) 

† In general, FC drives are capable of operating at lower FC operating speeds than the FC 

speed for which the drive is rated. For example, 2 Gbps FC drives will also work at a 1 

Gbps FC speed; 4 Gbps FC drives will also operate at 2 Gbps. Do not automatically 

assume that a given hard drive CRU  can operate in a lower FC speed environment without 

first checking the documentation of the DS4000 storage subsystem or storage expansion 

enclosure: the drive might not be certified or might not have the correct form factor for 

that DS4000 storage subsystem or storage expansion enclosure.
  

 Important:  

 Do not store DS4000 Storage Subsystem profiles in the same location as the logical 

drives defined on your DS4000 Storage Subsystem. Should you do so, and a RAID 

array failure occurs during subsequent migration, the data will be lost. 

 If you are migrating drives from another DS4000 Storage Subsystem, you must also 

perform the preceding steps 1 on page 41 through 10 on page 42 on the DS4000 

Storage Subsystem from which you intend to migrate hard drives. You must also 

perform the following steps to flush server-cached I/O to disks. 

__ Step 1.   Stop all programs, services or processes in the host servers that access 

the logical drives defined in the migrated hard drives. 

__ Step 2.   Verify that there are no programs, services, or processes running in the 

background that might write data to the logical drives. (For example, 

Microsoft® MSCS service periodically writes to the “Quorum” disk.) 

__ Step 3.   Unmount the file systems to flush I/O from the server cache to disk. 

Notes:  

a.   In a Microsoft Windows® environment, it is also necessary for you 

to remove the drive letter or the mount points of the mapped LUNs 

instead of unmounting the file systems. 

b.   Consult documentation associated with your particular operating 

system for detailed information regarding the unmount procedure.

After you meet prerequisites described in this section, proceed to any of the 

following sections to address your particular drive migration requirements. 

v   Chapter 3, “Adding or migrating hard drives,” on page 55 

v   Chapter 4, “Adding or migrating storage expansion enclosures,” on page 69 

v   Chapter 5, “Upgrading a storage subsystem in a functioning configuration,” on 

page 115

Verifying controller, NVSRAM, and ESM firmware file levels 

The controller firmware and NVSRAM of the DS4000 Storage Subsystem to which 

you will migrate hard drives, and the ESM firmware in the DS4000 storage 

expansion enclosures must be at the levels indicated in Table 19 on page 45 to 

ensure firmware compatibility between the migrating and original hardware. 

Additionally, DS4000 Storage Manager version 8.3 or higher client software, in 

conjunction with the controller firmware level 5.30.xx.xx or higher, allows you to 

upgrade the ESM firmware while the storage subsystem receives I/O from the host 

server if you select only one drive expansion enclosure to download the ESM 

firmware at a time in the Select drive enclosure to download ESM firmware 

window. 
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Note:  Always check the readme document included with the DS4000 Storage 

Subsystem controller firmware package for any ″no I/Os″ requirement 

during the controller firmware download. Certain controller firmware 

upgrade scenarios may require that you first quiesce host I/Os. 

Tip: Even though you can upgrade the DS4000 Storage Subsystem and ESM 

firmware while it processes I/O from the host server, schedule upgrades to occur 

during time periods of low I/O between the DS4000 Storage Subsystems and host 

servers. 

Table 19 lists IBM DS4000 machine types and model numbers, as well as their 

current firmware (AppWare or BootWare) and NVSRAM versions. 

 Table 19. Compatible controller firmware and NVSRAM version by machine type and model 

number 

Product name/model 

Machine 

type 

Model 

number 

Firmware version 

(AppWare / 

BootWare) NVSRAM  version1 

IBM System Storage 

DS4100 Storage 

Subsystem (Single 

Controller model) 

1724 1SC 06.12.27.xx N1724F10LR842V01 

IBM System Storage 

DS4100 Storage 

Subsystem 

1724 100 06.12.27.xx N1724F100R912V05 

IBM System Storage 

FAStT200 Fibre 

Channel Storage 

Subsystem 

3542 1RU 

1RX 

5.30.25.00 N3542-1RUR830V09 

IBM System Storage 

FAStT200 HA Fibre 

Channel Storage 

Subsystem 

2RU
2RX 

5.30.25.00 N3542-2RUR830V12 

IBM System Storage 

FAStT500 Fibre 

Channel Storage 

Subsystem 

3552 1RU 

1RX 

5.30.25.00 

(Appware) 

05.30.03.00 

(Bootware) 

N3552F500R830V05 

IBM System Storage 

DS4200 Express 

Storage Subsystem 

2916 51 06.16.88.xx or 

6.16.9x.xx 

N1814D420R916V01.dlp 

IBM System Storage 

DS4300 Fibre 

Channel Storage 

Subsystem 

1722 60X 

60U 

06.19.xx.xx N1722F600R919V04 

IBM System Storage 

DS4300 Fibre 

Channel Storage 

Subsystem (with 

Turbo option) 

06.19.xx.xx N1722F600R919V0 

IBM System Storage 

DS4300 Fibre 

Channel Storage 

Subsystem (Single 

Controller model) 

6LU 

6LX 

5.34.xx.xx N1722F60LR834V04 
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Table 19. Compatible controller firmware and NVSRAM version by machine type and model 

number (continued) 

Product name/model 

Machine 

type 

Model 

number 

Firmware version 

(AppWare / 

BootWare) NVSRAM  version1 

IBM System Storage 

DS4400 Fibre 

Channel Storage 

Subsystem 

1742 1RU 

1RX 

06.12.27.xx 

(Appware)
06.10.07.00 

(Bootware) 

N1742F700R912V05 

IBM System Storage 

DS4500 Fibre 

Channel Storage 

Subsystem 

1742 90X 

90U 

06.19.xx.xx N1742F900R919V02 

IBM System Storage 

DS4700 Express Fibre 

Channel Storage 

Subsystem 

1814 70A/H 

72A/H 

06.16.8x.xx or 

06.16.9x.xx for 

EXP810 and/or 

EXP710 

N1814D470R916V10 
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Table 19. Compatible controller firmware and NVSRAM version by machine type and model 

number (continued) 

Product name/model 

Machine 

type 

Model 

number 

Firmware version 

(AppWare / 

BootWare) NVSRAM  version1 

IBM System Storage 

DS4800 Fibre 

Channel Storage 

Subsystem 

1815 80x 06.16.8x.xx or 

06.16.9x.xx for 

EXP810 and/or 

EXP710 

N1815D480R916V08 

82x 

84x 

88x 

06.15.2x.xx for 

EXP100 and/or 

EXP710 storage 

expansion 

enclosures 

6.16.xx.xx for 

EXP810 and/or 

EXP710 storage 

expansion 

enclosures

CAUTION:  

If you do not use 

the correct 

controller 

firmware version 

for the specific 

EXP100 or EXP810 

storage expansion 

enclosure shown 

above, the storage 

expansion 

enclosure might 

not be seen by the 

controller, causing 

drives in the 

enclosures to be 

reported as 

missing. This 

could result in 

failed logical 

drives and arrays. 

EXP710 drive 

enclosures is 

supported by both 

controller 

firmware version 

06.15.xx.xx and 

06.16.xx.xx. 

N1815D480R916V08

  

Notes:  

1.   The DS4000 storage subsystems that are shipped from the factory will show the 

NVSRAM version with an ″M″ prefix instead of the ″N″ prefix. Both the ″M″ 

prefix and the ″N″ prefixed NVSRAM versions are the same if the rest of the 

version information is the same. For example, the N1815D480R915V05 and 

M1815D480R915V05 versions are the same because both versions share the 

same ″1815D480R915V05″ string. The M1815D480R915V05 version was loaded 
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to the DS4800 storage subsystem at the factory. The N1815D480R915V05 version 

is the one that was posted to the DS4000 support web site for download.

 Important::  

 Visit the following Web site either to verify software version levels or to identify 

possible interim updates to firmware and NVSRAM file versions described in 

Table 19 on page 45. 

www-1.ibm.com/servers/storage/support/disk/ 

 Do not automatically update the DS4000 controller firmware and NVSRAM to the 

levels indicated in Table 19 on page 45 (or higher) before you upgrade the ESM 

firmware on the storage expansion enclosures to versions indicated in Table 20. 

Consult the readme file that is included in the controller firmware code package 

for any prerequisite tasks or required ESM firmware upgrades or stepping stone 

controller firmware upgrades that need to be performed first before upgrading the 

controller firmware to a particular version. 

Table 20 lists IBM DS4000 storage expansion enclosure models by name, machine 

type, model number, and current ESM firmware version. 

 Table 20. Compatible expansion unit ESM firmware version by machine type and model 

number 

DS4000 Storage Expansion Unit product 

name/model 

Machine 

type 

Model 

number 

ESM firmware 

version 

IBM System Storage DS4000 EXP100 1710 10U 9563 or later is 

required for the new 

250 GB drive CRU  

and the 400G SATA 

drive option/CRU. 

IBM System Storage DS4000 EXP500 3560 1RU
1RX 

9166 

IBM System Storage DS4000 EXP700 1740 1RU
1RX 

9330 

IBM System Storage DS4000 EXP710 1740 710 9640 

IBM System Storage DS4000 EXP420 1812 8VA, 8VH  9865 or higher 

IBM System Storage DS4000 EXP810 1812 81A, 81H, 

81S, 81T 

9880 or higher

  

Perform the following steps to upgrade ESM and controller firmware for a 

down-level DS4000 storage subsystem: 

__ Step 1.   Upgrade the DS4000 Storage Manager software to the latest version. 

That is DS4000 Storage Manager version 9.1x. For additional 

information, see the IBM System Storage DS4000 Storage Manager 

installation and support guide for the appropriate server operating system 

environment at: 

www-1.ibm.com/servers/storage/support/disk/

Note:  To ensure the highest level of software compatibility, update the 

host server’s multi-path software (Redundant Disk Array 

Controller [RDAC], IBMSAN.CDM, or Linux failover adapter 

driver) to the level that is either supported by or released with 
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the controller firmware that you intend to download. See the 

following Web site for current details on software compatibility: 

www.ibm.com/servers/storage/support/disk/ 

__ Step 2.   Upgrade the storage expansion enclosure ESM firmware. With DS4000 

Storage Manager version 8.3 or higher and controller firmware version 

05.3x.xx.xx or higher, you can update the ESM firmware while the 

DS4000 Storage Subsystem is processing I/O from the host server if the 

ESM firmware download is performed to only one storage expansion 

enclosure at a time. If you select multiple entries in the ESM firmware 

download window for ESM firmware download, you must quiesce 

I/Os from the host servers before starting the ESM firmware download 

process. 

 Important: 

 Even though the DS4000 Storage Subsystem supports controller and 

ESM firmware upgrade while the DS4000 Storage Subsystem processes 

I/O from the host server, schedule controller and ESM firmware 

upgrades to occur during time periods of low I/O between the DS4000 

Storage Subsystems and host servers. 

__ Step 3.   Upgrade the controller firmware and NVSRAM. See Table 19 on page 

45 and the web site listed earlier in conjunction with step1 on page 48. 

Note:  See the readme file in the DS4000 Storage Manager controller 

firmware package associated with the appropriate host operating 

system environment for a support statement about the 

concurrent controller firmware download (that is, downloading 

code to the DS4000 Storage Subsystem while it is processing I/O 

from the host server).

Upgrading drive firmware levels 

Attention:  1 Gbps Fibre Channel drives will not operate correctly in a 2 Gbps 

Fibre Channel drive loop; neither will 2 Gbps Fibre Channel drives operate 

correctly in a 4 Gbps FC operating environment. Always make certain that a Fibre 

Channel drive can operate at the Fibre Channel speed of the drive loop involved 

before inserting it into the drive slots in a DS4000 Storage Subsystem configuration. 

If needed, contact IBM support to ensure the compatibility of your drives before 

migrating them from one DS4000 configuration to another. 

Before you begin migration, upgrade the drive firmware to the latest level. Do not 

move or migrate Fibre Channel drives from a 1 Gbps Fibre Channel environment 

to a 2 Gbps Fibre Channel environment unless you have installed the latest 

firmware documented to enable their operation in a 2 Gbps Fibre Channel 

environment. 

Downloading drive firmware 

 

Important: 

The following procedures assume you using controller firmware at version 

6.10.xx.xx or later. If you are using an earlier version refer to the following 

IBM web site for the appropriate firmware version documentation:

www.ibm.com/servers/storage/support/disk/ 
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This section provides instructions for downloading DS4000 drive firmware. See the 

online help for additional information. 

Important: 

1.   IBM supports firmware download with I/O, sometimes referred to as 

″concurrent firmware download″. This feature is not supported for drive 

firmware. 

2.   Before starting the drive firmware download process: 

v   Stop all I/O activity before downloading drive firmware to a DS4000 Storage 

Server. 

v   Unmount the file systems on all logical drives accessing the drives that you 

select for firmware upgrade. 

v   Complete a full backup of all data residing on the drives that you select for 

firmware upgrade.

Downloading Storage Manager version 9.1x drive firmware 

To download drive firmware for DS4000 Storage Manager version 9.1x, perform 

the following steps: 

 1.   From the Enterprise Management window, select a storage subsystem. 

 2.   On the Enterprise Management window’s menu bar, click Tools → Manage 

Device. The Subsystem Management window opens. 

 3.   On the Subsystem Management window’s menu bar, click Advanced → 

Maintenance → Download → Drive Firmware/Mode pages .... The Download 

Drive Firmware wizard window opens to the Introduction page. Read the 

instructions displayed and click Next.

Note:  Storage Manager version 9.1x offers you the option to download and 

update up to four different firmware file types simultaneously. Previous 

Storage Manager versions did not offer this capability. 

 4.   Click Browse to locate the server directory that contains the firmware that you 

plan to download. 

 5.   Select the firmware file that you plan to download and click OK. The file 

appears listed in the ″Selected Packages″ window pane. 

 6.   Select the firmware file for any additional drive types that you intend to 

download and click OK. Additional files appear listed in the ″Selected 

Packages″ window pane. A maximum total of four drive types are possible. 

 7.   Click Browse to repeat step 6 until you have selected each firmware file that 

you plan to download. 

 8.   When you have finished specifying the firmware packages for download, 

select Next. 

 9.   The Select Drive window opens, containing two tabs, a Compatible Drives 

tab and an Incompatible Drives tab. The Compatible Drives tab contains a 

list of the drives compatible to the firmware package types that you selected. 

From that list, select the drives to which you plan to download the drive 

firmware that you selected in steps 6 and 7. 

Note:  The firmware that you propose to download should be listed on the 

Compatible Drives tab. If your particular drives’ product ID matches 

the firmware type, however, and it is not listed as compatible on the 

tab, contact your IBM technical support representative for additional 

instructions. 

10.   Select the Compatible Drives tab. 
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Press and hold the Ctrl key while using your mouse to select multiple drives 

individually, or press and hold the shift key while using your mouse to select 

multiple drives listed in series. The compatible firmware that you selected in 

steps 5 on page 50 and 6 on page 50 will download to the drives that you 

select. 

11.   Click Finish to initiate download of the drive firmware to each compatible 

drive that you selected in step 9 on page 50. 

12.   The Download Drive Firmware warning opens and prompts: ″Do you want to 

continue?″ Type yes and click OK to start the drive firmware download. 

13.   The Download Progress window opens. Do not intervene until the download 

process completes. 

14.   Every drive scheduled for firmware download will be designated as in 

progress until successful or failed.

Note:  Complete the following two steps if you receive a failure. 

a.   Click the Save as button to save the error log. 

b.   On the Subsystem Management window’s menu bar, click 

Advanced →Trouble Shooting → Open Event Log and complete the 

following tasks necessary to save the storage subsystem event log 

before contacting your IBM Service Representative and proceeding 

to step 16. 

1)   Click the Select all button. 

2)   Click Save the Storage Subsystem Event Log.
15.   When the Close button appears active, the drive firmware download process 

is complete. 

16.   Click Close to exit the Download Progress window. 

17.   Use either of the following procedures to determine or verify what level of 

drive firmware resides on a particular drive: 

v   Right-click on that drive in the Logical/Physical View in the Subsystem 

Management window and click Properties. The associated drive firmware 

version will be listed in the drive properties table. 

v   Right-click on Storage Subsystem → View Profile in the Logical/Physical 

View of the Subsystem Management window.

Downloading Storage Manager version 8.x drive firmware 

To download drive firmware for DS4000 Storage Manager version 8.x, perform the 

following steps: 

 1.   From the Enterprise Management window, select a storage subsystem. 

 2.   Click Tools → Manage Device. The Subsystem Management window opens. 

 3.   Click Advanced → Download → Drive Firmware. The Download Drive 

Firmware window opens. It presents a list of all installed drives. 

 4.   From the list of all installed drives, select the drive to which you plan to 

download drive firmware. 

Press and hold the Ctrl key while using your mouse to select multiple drives 

singly, or press and hold the shift key while selecting multiple drives in series 

by using your mouse pointer. 

 5.   Click Browse to identify the directory that contains the drive firmware that 

you intend to download. 

 6.   Select the file containing the drive firmware that you intend to download. 

 7.   Select Start. The Confirm Download window appears. 
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8.   Type yes when the Confirm Download window prompts: Are you sure you 

want to continue? 

 9.   The download begins and the Status window indicates progress. Do not 

intervene until the download process completes. 

10.   When the Cancel button appears active, the download process is complete. 

Press Cancel to close the Status window. 

11.   To determine or verify the level of drive firmware residing on a particular 

drive, click View → Subsystem Profile in the Logical/Physical View of the 

Subsystem Management window.

Bringing storage subsystems and drive loops into optimal state 

Note:  For additional information on how to make this determination, see the 

DS4000 Problem Determination Guide associated with your particular DS4000 

hardware model. 

After you have updated or verified that a DS4000 Storage Subsystem is using the 

latest firmware and NVSRAM: 

__ Step 1.   Bring the DS4000 Storage Subsystem to its optimal state before 

reconfiguring it with new hardware. 

__ Step 2.   Use the DS4000 Storage Manager client program to display the status 

of the DS4000 Storage Subsystem and to correct any problems that 

might cause the DS4000 Storage Subsystem to enter its Needs 

Attention state. 

__ Step 3.   Verify that all indicator lights on the storage subsystem are in their 

optimal state. 

__ Step 4.   In addition, use the Read_Link_Status function of the DS4000 Storage 

Manager client program and the DS4000 Storage Subsystem MEL  to 

verify that all components in the drive loop are in their optimal states 

(that is, there are no drive loop component errors in the event log and 

no errors in the Read_Link_Status window.) If you are using controller 

firmware 06.10.xx.xx or later, use the drive channel diagnostics to 

determine if the drive loop/channel is optimal. See the DS4000 Storage 

Manager Client program Subsystem Management window Online help 

for more information on the RLS and drive channel diagnostics if they 

are supported by the installed version of your controller firmware. 

Drive channel diagnostics are only available if you are using controller 

firmware version 06.10.xx.xx or later. 

__ Step 5.   If the arrays are in degraded state due to a failed drive, correct the 

problem before migration.

If necessary, contact the IBM Help Center for assistance with event log 

interpretation. 

It is necessary for certain tasks to be completed before proceeding to add drives or 

enclosures. Before you add drives or enclosures, verify that the storage subsystem 

involved is not performing any of the following tasks. 

v   Dynamic logical drive capacity expansion (dynamic volume expansion [DVE] or 

dynamic capacity expansion [DCE]) 

v   Logical drive segment size modification 

v   Array RAID-level modification 

v   User-initiated array redundancy checking (menu option Array -> Check 

Redundancy in the Subsystem Management window) 
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v   Remote mirror logical drive synchronization 

v   FlashCopy or VolumeCopy logical drive creation 

v   Logical drive reconstruction or copyback. This action is sometimes referred to as 

logical drive sparing.

Saving the storage subsystem profile 

Use the DS4000 Storage Manager client program to save a DS4000 Storage 

Subsystem profile. Such a profile is necessary to restore a storage subsystem 

configuration in the event of a catastrophic failure. Migration from one DS4000 

Storage Subsystem configuration to another will require that you save both DS4000 

Storage Subsystem configuration profiles involved. For details on this procedure, 

see one of the following: 

v   DS4000 Storage Manager client program Client Subsystem Management window 

online help 

v   IBM System Storage DS4000 Storage Manager installation and support guide 

associated with your particular operating system environment located at: 

www-1.ibm.com/servers/storage/support/disk/ 

v   Saving a module profile report and state capture information to help prevent data loss 

located at: 

www-3.ibm.com/pc/support/site.wss/document.do?lndocid=MIGR-4VVPEF
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Important:  

 Do not store DS4000 Storage Subsystem profiles in the same location as the logical 

drives defined on your DS4000 Storage Subsystem. Should you do so, and a RAID 

array failure occurs during subsequent migration, the data will be lost. 

Handling static-sensitive devices 

Attention:  Static electricity can damage electronic devices and your system. To 

avoid damage, keep static-sensitive devices in their static-protective packages until 

you are ready to install them. 

To reduce the possibility of electrostatic discharge (ESD), observe the following 

precautions: 

v   Limit your movement. Movement can cause static electricity to build up around 

you. 

v   Handle the device carefully, holding it by its edges or its frame. 

v   Do not touch solder joints, pins, or exposed printed circuitry. 

v   Do not leave the device where others can handle and possibly damage the 

device. 

v   While the device is still in its static-protective package, touch it to an unpainted 

metal part of the system unit for at least two seconds. This drains static 

electricity from the package and from your body. 

v   Remove the device from its package and install it directly into your system unit 

without setting it down. If it is necessary to set the device down, place it in its 

static-protective package. Do not place the device on your system unit cover or 

on a metal table. Take additional care when handling devices during cold 

weather because heating reduces indoor humidity and increases static electricity.
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Chapter  3.  Adding  or  migrating  hard  drives  

To add one or more hard drives to the DS4000 storage subsystem configuration or 

place the drives (that made up a RAID array) in different drive slots, see the 

following sections: 

v   If you want to add one or more new hard drives to an existing DS4000 storage 

subsystem, see “Adding one or more new hard drives” on page 56.

Note:  Any hard drive, whether new or old, might contain configuration data. 

Unless you intend to migrate drives from another DS4000 Storage 

Subsystem (retaining their configuration data), always use the this 

procedure to add one or more hard drives to an existing DS4000 storage 

subsystem configuration. 

v   If you are migrating drives from one DS4000 subsystem configuration to another, 

see “Migrating one or more hard drives” on page 61. 

v   If you want to place the drives (that made up a RAID array) in different drive 

slots, see “Migrating arrays within storage subsystems” on page 65.

Before performing the appropriate procedure, please review the Chapter 2, 

“Prerequisites to adding capacity and hard drive migration,” on page 41 in 

Chapter 2 and the information in the “Overview and rules” section, which follows. 

Overview and rules 

While adding a hard drive to either a controller or a drive expansion enclosure, 

observe these important rules: 

v   Observe proper electrostatic discharge (ESD) procedures when handling 

electronic equipment. See “Handling static-sensitive devices” on page 54 for 

additional information. 

v   Never alter the physical configuration of a DS4000 Storage Subsystem while it is 

powered off unless you are instructed to do so as part of a DS4000 configuration 

procedure. Specifically, never attach storage components to, or remove storage 

components from, a configured DS4000 Storage Subsystem while it is powered 

off. 

v   Before migrating hard drives, perform the following steps to establish drive 

model compatibility: 

__ 1.   Check the drive CRU form factor options. 

__ 2.   If the form factors are not the same, there are no replacement parts (this 

includes bezels and drive trays). 

__ 3.   If the form factors are the same, check to see if the drive is supported by 

the DS4000 subsystem. 

__ 4.   Ensure that the drive can operate at the storage subsystem drive 

loop/channel FC speed. See Table 18 on page 42 for more information.
v    The following DS4000 Storage Subsystem devices support 2 Gbps Fibre Channel 

hard drives: 

–   DS4000 EXP700 storage expansion enclosures 

–   DS4000 EXP710 storage expansion enclosures 

–   DS4000 EXP810 storage expansion enclosures 

–   DS4200 Express, DS4300, and DS4700 Express storage subsystems 
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1 Gbps Fibre Channel drives will not work properly when you insert them 

into the drive slots of the aforementioned DS4000 storage devices.
 Attention:  Always make certain that a Fibre Channel drive can operate at 

the Fibre Channel speed of the drive loop involved before inserting it into the 

drive slots in a DS4000 Storage Subsystem configuration. If needed, contact 

IBM support to ensure the compatibility of your drives before migrating them 

from one DS4000 configuration to another. 

To identify a 1 Gbps Fibre Channel drive, locate the product’s label and 

examine its ID or Model Number. Hard drives with ID or Model Number 

values that end with “04FC” or “03FC” are 1 Gbps Fibre Channel drives. For 

example, “ST173404FC”, “ST318203FC” and “ST136403FC” are model 

numbers that appear on several 1 Gbps Fibre Channel hard drives. 1 Gbps 

Fibre Channel drives can also be mounted in a tray with the front bezel that 

is about .75 inches (1.9 centimeters) wider than the 2 Gbps drive tray bezel. 

You can also obtain the drive product model and ID through the DS4000 

Storage Subsystem profile. For information on how to do so, see 

“Determining the product ID and model of a drive” on page 39.

Note:  You can refer to Table 18 on page 42 for information on the maximum 

FC speed at which a given drive model can operate.
v    The only DS4000 storage expansion enclosures that support the 4 Gbps drive, in 

addition to the 2 Gbps drive, are the EXP420 and EXP810; however, they can 

support only one drive speed in a single drive channel/loop pair. The 2 Gbps 

drives will either be put in bypassed mode or be not seen by the controllers 

when inserting into an EXP420 or EXP810 operating at 4 Gbps FC speed. 

v   The Fibre Channel drive option/CRU for the EXP700 and EXP710 is not 

compatible with the Fibre Channel drive option/CRU for the EXP810 even 

though the reported drive product ID is the same for both EXP710 and EXP810 

drive CRU. Please consult the EXP710, EXP700 and EXP810 product 

documentation or the appropriate Installation, User’s, and Maintenance Guide for 

the correct part number for drive options and drive CRUs for your drive 

expansion enclosure. 

v   Do not mix SATA and Fibre Channel drives or enclosures together in the same 

drive loop behind a DS4000 storage subsystem unless the FC/SATA intermix 

premium feature is purchased and the DS4000 Storage Subsystem is in the 

storage subsystem list that support FC/SATA intermix feature. 

v   Do not install SATA drives in Fibre Channel drive expansion enclosures. 

v   Do not install Fibre Channel drives in SATA drive expansion enclosures.

Adding one or more new hard drives 

The following procedure outlines the steps necessary to add one or more new hard 

drives to empty drive slots in either DS4100, DS4200 Express, FAStT200, DS4300, or 

DS4700 Express controllers or in EXP100, EXP500, EXP700, EXP710, or EXP810 

storage expansion enclosures. If you plan to add a used drive, ensure that there is 

no configuration data on the drive that you need to preserve. Add drives to a 

DS4000 Storage Subsystem only while it is powered on and in optimal state. See 

the DS4000 Problem Determination Guide or “Bringing storage subsystems and drive 

loops into optimal state” on page 52 for additional information on how to make 

this determination. 

Perform the steps as stated in activities 1-3, to add one or more new drives to the 

DS4000 storage subsystem. 
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Do not perform the steps in this procedure if you are migrating drives from 

another DS4000 storage subsystem. This procedure will delete the logical drive 

configuration in the migrated hard drives. Use the “Migrating expansion 

enclosures with hard drives having defined logical drive configurations” on page 

73 section, instead. 

Activity 1: Disabling the drive migration settings 

Important: Unless you have already done so, please review the information in 

Chapter 1 and perform the prerequisites described in Chapter 2 before performing 

the activities described in this chapter. 

Before you add drives to the subsystem, perform this activity to remove any 

configuration data that they might contain. 

__ Step 1.   Open the Storage Manager client program’s Enterprise Management 

window. 

__ Step 2.   Right-click on the name of the DS4000 Storage Subsystem to which you 

intend to add drives and click Execute Script. 

__ Step 3.   A script editor window opens. Click File -> Load Script. 

__ Step 4.   A Load Script file selection window opens. Locate and select the file 

named DisableDriveMigration.scr and click OK. The 

DisableDriveMigration.scr file is normally located in the SCRIPTS 

directory of the IBM DS4000 Storage Manager Installation Compact 

Disc (CD). Use this file to reset the DS4000 storage subsystem setting to 

ignore configuration data that might reside on newly discovered hard 

drives. Figure 16 on page 60 provides a listing of the 

DisableDriveMigration.scr file. 

__ Step 5.   Click Tools -> Verify and Execute to run the script. 

__ Step 6.   When the script completes execution, reset both DS4000 controllers to 

enable the DS4000 drive migration setting. 

If you used the DisableDriveMigration.scr script associated with this 

document and described in Figure 15 on page 59, it is not necessary for 

you to perform this step because the last two commands in that script 

file automatically reset the controllers. 

To reset the controllers, open the Storage Subsystem Management 

window and sequentially (one at a time) reset each controller by 

clicking Advanced -> Reset Controller. Then, follow the instructions in 

the Reset Controller window when it opens.

Activity 2: Inserting drives 

__ Step 1.   Insert drives as pairs (two at a time) into the empty drive slots. 

__ Step 2.   Wait (up to five minutes) until each drive pair has fully spun up and 

displayed in the DS4000 Storage Subsystem Management window 

before inserting the next drive pair.

Activity 3: Re-enabling the drive migration settings 

Perform this activity to re-enable the drive migration settings if you performed 

“Activity 1: Disabling the drive migration settings” to disable DS4000 storage 

subsystem drive migration settings. If you do not, whenever you might 

subsequently, even momentarily remove a drive from the storage subsystem for 

any reason, its configuration data will be cleared. When the storage subsystem next 

recognizes such a drive, it will display it as unconfigured. 

Attention: In order to prevent data loss, set the DS4000 Storage Subsystem drive 

migration to enable after you complete the hard drive addition process. 
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__ Step 1.   Open the Storage Manager client program Enterprise Management 

window. 

__ Step 2.   Right-click on the name of the DS4000 Storage Subsystem to which you 

want to add drives and click Execute Script. 

__ Step 3.   A script editor window opens. Click File -> Load Script. 

__ Step 4.   A Load Script file selection window opens. Locate, and select the file 

named EnableDriveMigration.scr and click OK. The file 

EnableDriveMigration.scr is normally located in the SCRIPTS directory 

of the IBM DS4000 Storage Manager Installation CD. Use this file to 

reset the DS4000 Storage Subsystem setting in order to check for 

configuration data that might reside on newly discovered hard drives. 

Figure 15 on page 59 provides a listing of the EnableDriveMigration.scr 

file. 

__ Step 5.   Click Tools -> Verify and Execute to run the script. 

__ Step 6.   When the script completes execution, reset both DS4000 controllers to 

enable the DS4000 drive migration setting. 

If you use the EnableDriveMigration.scr script associated with this 

document and described in Figure 15 on page 59, it is not necessary for 

you to perform this step because the last two commands in that script 

file automatically reset the controllers. 

To reset the controllers, open the Storage Subsystem Management 

window and sequentially (one at a time) reset each controller by 

clicking Advanced -> Reset Controller, and then following the 

instructions in the Reset Controller window when it opens. 

Result: The newly added drives are ready for you to configure and 

map to host servers.

The next two figures list the EnableDriveMigration.scr and 

DisableDriveMigration.scr files. 
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// Name: Enable Drive Migration 

// 

// Date: 11-20-2005 

// Revision: 1.4 

//   Version 1.4 fixed the misleading on/off comment - CMVC 296330. 

// Comments: 

// This script is intended to work with controllers at Firmware 05.30.xx.xx and 

// higher only. 

// 

// This script returned the FAStT to it’s default operation of importing 

// configuration informration from disks. 

// 

// This script will reboot both controllers in the FAStT unit. If your 

// hosts are configured for multi-path support, this can be done with I/O 

// running to the controllers. If your hosts are not configured for 

// redundant access you must schedule downtime before running this 

// script. 

// 

// See the directions at the bottom of this script if you do not have multi 

// path software installed and wish to prevent the controller restarts 

// 

// Show the current state of Drive Migration 

show "Showing the current state of Drive Migration. The return value should"; 

show "be 82, which means drive migration is disable."; 

show " "; 

show controller[a] nvsrambyte[0x35]; 

show controller[b] nvsrambyte[0x35]; 

// 

// Setting Drive Migration to Enable 

show "Setting Drive Migration to Enable"; 

set controller[a] nvsrambyte[0x35] = 0x02,0x00; 

set controller[b] nvsrambyte[0x35] = 0x02,0x00; 

show "Showing the new state of Drive Migration. The return value should"; 

show "be 80, which means drive migration is enable. This should be the "; 

show "default setting for the DS4000 controllers. "; 

show " ";show controller[a] nvsrambyte[0x35]; 

show controller[b] nvsrambyte[0x35]; 

// 

// Reset Controllers to make changes active. Note: 

// To prevent the controllers from restarting, add ’//’ to the beginning 

// of each of the lines below. This will comment out the restart of the 

// controllers. Important: The controllers will have to be restarted for the 

// changes in this script to take effect. 

// 

show "Resetting controller A"; 

reset Controller [a]; 

show "Resetting controller B"; 

reset Controller [b]; 

show "Drive Migration is now enabled."; 

  

Figure 15. EnableDriveMigration.scr file listing
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// Name: Disable Drive Migration 

// Date: 11-20-2005 

// Revision: 1.4 

//   Version 1.4 fixed the misleading on/off comment - CMVC 296330. 

// Comments: 

// This script is intended to work with controllers at Firmware 05.30.xx.xx and higher only. 

// This script allows the addition of disk drives while the system is running 

// and by clearing the configuration of any drives as unused capacity 

// regardless of past configuration of these drives. 

// 

// Attention: This setting should not be left active after the new disks 

// have been added to the subsystem. Leaving this setting active could 

// cause the configuration for the DS4000/FAStT to be lost if the DS4000/FAStT 

// is power cycled. Please run the EnableDriveMigration.scr after all of 

// the disks are added. IN ADDITION, DO NOT USE THIS SCRIPT IF YOU WANT 

// TO PRESERVE THE DATA IN THE DRIVES THAT YOU ARE PLANNING TO ADD INTO 

// THE EXISTING DS4000 STORAGE SUBSYSTEM CONFIGURATION. Please refer to 

// the DS4000 adding capacity and drive migration publication for more information. 

// 

// This script will reboot both controllers in the FAStT unit. If your 

// hosts are configured for multi-path support, this can be done with I/O 

// running to the controllers. If your hosts are not configured for 

// redundant access you much schedule downtime before running this script. 

// 

// Show the current state of Drive Migration 

show "Showing the current state of Drive Migration. The return value should"; 

show "be 80, which means drive migration is enable. This should be the "; 

show "default setting for the DS4000 controllers. "; 

show " "; 

show controller[a] nvsrambyte[0x35]; 

show controller[b] nvsrambyte[0x35]; 

// 

// Setting Drive Migration to Disable 

show "Setting Drive Migration to Disable"; 

set controller[a] nvsrambyte[0x35] = 0x02,0x02; 

set controller[b] nvsrambyte[0x35] = 0x02,0x02; 

show "Showing the new state of Drive Migration. The return value should be"; 

show "82, which means drive migration is disable. Please run the enableDrive"; 

show "Migration.scr script as soon as you complete the inserting of "; 

show "new drives into the DS4000 storage subsystem slots."; 

show " "; 

show controller[a] nvsrambyte[0x35]; 

show controller[b] nvsrambyte[0x35]; 

// 

// Reset Controllers to make changes active 

// To prevent the controllers from restarting, add ’//’ to the beginning of each of the 

// lines below. This will comment out the restart of the controllers. Important: The 

// controllers will have to be restarted for the changes in this script to take effect. 

show "Resetting controller A"; 

reset Controller [a]; 

show "Resetting controller B"; 

reset Controller [b]; 

// 

show "Drive Migration is now disabled. Add the new drives to the subsystem,"; 

show "then execute the EnableDriveMigrationScript.scr to re-enable drive "; 

show "migration."; 

  

Figure 16. DisableDriveMigration.scr file listing
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Migrating one or more hard drives 

Note:  When migrating hard drives from multiple DS4000 storage servers to a 

single DS4000 Storage Subsystem, move all of the hard drives from the first 

DS4000 Storage Subsystem as an independent ″set″ to the destination 

DS4000 Storage Subsystem. Before moving hard drives as a set from 

subsequent DS4000 Storage Subsystem, ensure that all of the hard drives 

from the previous set have been successfully transferred to the destination 

DS4000 Storage Subsystem. If you do not transfer hard drives as ″sets″ to 

the destination DS4000 Storage Subsystem, the newly relocated 

arrays/logical drives that are defined in these drives might not appear in 

the Subsystem Management window. If you encounter problems while 

migrating drives, stop any further action and contact IBM support to avoid 

data loss. 

The procedure for migrating hard drives that contain configuration data you want 

to preserve, is found in the following sections: 

v   “Activity 1: Preliminary activities” 

v   “Activity 2: Verifying the drive migration enable settings” on page 63 

v   “Activity 3: Removing the drives to be migrated” on page 63

Do  not use the procedure in this section if you are unsure of the quality of the data 

on the hard drives. Importing incorrect configuration data from hard drives could 

cause a DS4000 Storage Subsystem failure. Use the Chapter 3, “Adding or 

migrating hard drives,” on page 55 section, instead. 

Activity 1: Preliminary activities 

The following procedure describes the steps that you must perform to migrate one 

or more drives from a functioning DS4000 Storage Subsystem configuration to 

another DS4000 Storage Subsystem configuration. Drives described in the following 

steps are those that contain configuration data that you want to preserve. Add 

such drives to a DS4000 Storage Subsystem only while it is powered on and in its 

optimal state. See the DS4000 Problem Determination Guide or “Bringing storage 

subsystems and drive loops into optimal state” on page 52 for additional 

information on how to assess the state of a DS4000 Storage Subsystem. 

 Important:  

 Before you attempt to complete the drive migration procedure, review the 

information provided in Chapter 1 and perform the steps documented in 

Chapter 2, “Prerequisites to adding capacity and hard drive migration,” on page 

41. 

 Before you remove drives from a functioning DS4000 Storage Subsystem, perform 

the following steps to ensure that you successfully migrate the drives to the 

destination DS4000 Storage Subsystem. 

__ Step  1.   Perform a backup of the logical drives defined in the hard drives that 

you plan to migrate. 

__ Step  2.   Stop all programs, services or processes in the host servers that access 

the logical drives defined in the migrated hard drives. Ensure that 

there are not any running background programs, services or processes 

that write data to the logical drives. (For example, the Microsoft 

MSCS service periodically writes to the “Quorum” disk.) 

__ Step  3.   Unmount the file systems to flush I/O from the server cache to disks. 
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Notes:  

a.   In a Microsoft Windows environment, remove the drive letter or 

the mount points of the mapped LUNs instead of unmounting the 

file systems. 

b.   Refer to the documentation associated with your particular 

operating system for detailed information regarding the Unmount 

procedure.
__ Step  4.   Verify that the DS4000 Storage Subsystem controller and NVSRAM of 

both the source and destination systems are at or above levels 

described in Table 19 on page 45. 

__ Step  5.   Verify that the names of the logical drives that are associated with 

hard drives on both the source and destination systems are unique. If 

they are not, make the necessary changes. 

__ Step  6.   In addition to array configuration information, any storage 

partitioning configuration data that may reside on drives you plan to 

migrate will migrate with those drives when installed on another 

DS4000 Storage Subsystem. For this reason, take the following 

precautions to facilitate the migration process and prevent problems 

in storage partitioning configuration data migration. 

a.   If a DS4000 storage partitioning premium feature has been enabled 

both on a drive’s original and destination DS4000 storage servers, 

assure that the defined host ports, hosts, and host group names 

are unique to each DS4000 Storage Subsystem involved in the 

migration. 

b.   If you must use identical names on both DS4000 Storage 

Subsystems, make the names unique before you perform the drive 

migration. 

If necessary, customize the storage partitioning information on the 

DS4000 Storage Subsystem to which you have migrated the drives 

after you complete the migration. 

__ Step  7.   Delete any flashcopies of the logical drives defined on the drives that 

you plan to migrate. 

__ Step  8.   Remove any remote mirror relationships using the logical drives 

defined on the drives that you plan to migrate. 

__ Step  9.   Ensure that the arrays and logical drives are in optimal state before 

starting the migration process. See the DS4000 Problem Determination 

Guide associated with your particular DS4000 hardware model or 

“Bringing storage subsystems and drive loops into optimal state” on 

page 52 for additional information on how to make this 

determination. 

__ Step 10.   Place the arrays defined in the hard drives that you plan to migrate in 

offline state. To do so, right-click on the name of the array in the 

Storage Subsystem Management window and click Place -> Offline. 

__ Step 11.   If you migrate drive expansion enclosures from a 1 Gbps Fibre 

Channel environment to a 2 Gbps Fibre Channel environment, verify 

that the Fibre Channel hard drives that you plan to migrate are each 

capable of 2 Gbps operation and that you have installed the latest 

firmware enabling them to work properly in a 2 Gbps Fibre Channel 

environment. 

__ Step 12.   Save the DS4000 Storage Subsystem profile of the functioning DS4000 

Storage Subsystem configuration to which the migration will occur in 

a location other than that of the logical drives you plan to migrate. 
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__ Step 13.   If you migrate the drives to a single controller DS4000 Storage 

Subsystem (for example, DS4300 Storage Subsystem, model 6LU or 

6LX), change the logical drive’s preferred owner to Controller A using 

the DS4000 Storage Manager client program before taking it offline 

and removing it from the DS4000 Storage Subsystem. To set Controller 

A as the logical drive preferred owner, right-click the logical drive 

entry in the Subsystem Management window and select Change -> 

Ownership/Preferred Path -> Controller A.

Activity 2: Verifying the drive migration enable settings 

The DS4000 storage subsystem drive migration setting must be set to enable before 

inserting drives with configuration data. If not, the DS4000 controller ignores the 

configuration data in the drive and displays the drive as unconfigured and 

optimal. IBM recommends that you perform the steps to run the 

EnableDriveMigration script to ensure the drive migration setting is set to enable 

before inserting any drives with configuration data. See “Activity 3: Re-enabling 

the drive migration settings” on page 57 for instructions. 

Activity 3: Removing the drives to be migrated 

While the functioning DS4000 Storage Subsystem is still powered on, remove the 

hard drives that you plan to migrate one at a time using the following steps: 

__ Step 1.   Press on the inside of the bottom of the tray handle to release the blue 

latch. 

__ Step 2.   Lift the closed latch to its open position. (The latch is at a 90-degree 

angle to the front of the drive when open.)

Note:  Your drive CRUs might have a different latching mechanism 

than the one shown in Figure 17 on page 64. Refer to the 

Installation, User’s, and Maintenance Guide for your particular 

storage expansion enclosure for details. 

__ Step 3.   Using the handle, slowly pull the drive ½ inch out of its drive slot. 

__ Step 4.   Wait at least 30 seconds to allow the hard drive to spin down before 

fully removing it from the drive slot. 

__ Step 5.   Place the hard drive into an ESD bag or container before moving it to 

the new DS4000 Storage Subsystem. 
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Legend: 

�1� Blue latch 

�2� Drive CRU handle 

�3� Tray 

�4� FC hard drive
Attention: Orient drives horizontally and place them in appropriate 

ESD bags or containers before relocation. When in transit, use only 

moving equipment that prevents shock to the drives. Never stack 

drives.

Activity 4: Inserting the drives to be migrated 

Notes:  

1.   When migrating hard drives from multiple DS4000 Storage Subsystems to a 

single DS4000 Storage Subsystem, move all of the hard drives from the first 

DS4000 Storage Subsystem as an independent ″set″ to the destination DS4000 

Storage Subsystem. Before moving hard drives as a set from subsequent DS4000 

Storage Subsystems, ensure that all of the hard drives from the previous set 

have been successfully transferred to the destination DS4000 Storage 

Subsystem. If you do not transfer hard drives as ″sets″ to the destination 

DS4000 Storage Subsystem, the newly relocated arrays/logical drives that are 

defined using these drives might not appear in the Subsystem Management 

window. 

2.   Make sure the drives are compatible with the storage expansion enclosure. For 

example, insert a 2 GB drive into a storage expansion enclosure that supports 2 

GB drives. 

Perform the following steps to insert the drives to be migrated.
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Figure 17. Drive CRU assembly
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__ Step 1.   While the destination DS4000 Storage Subsystem is powered on, insert 

the migrating drives into the empty drive slots in pairs. Wait (up to 

five minutes) until the inserted drive pair is fully spun up and 

displayed in the DS4000 Storage Subsystem Management window 

before inserting the next drive pair. 

__ Step 2.   As the DS4000 Storage Subsystem recognizes the drives, it reads and 

displays the array and logical drive information in the Logical/Physical 

view of the DS4000 Storage Subsystem Management window. The 

storage subsystem represents arrays in offline state until it recognizes 

that you have inserted all of the drives that comprise an array. 

__ Step 3.   After you migrate all of the drives, manually change the state of the 

arrays and logical drives involved from optimal to online state if it has 

not changed automatically. To do so, right-click on the array name in 

the Storage Subsystem Management window and select Place -> 

Online. If any of the following conditions persist, contact the IBM Help 

Center in your geography for assistance: 

v   The empty drive slot icon ( 

  

) displayed for the drive slot into 

which you inserted the migrating drive. 

v   The Failed unconfigured drive icon ( 

  

) or the Failed configured 

drive icon ( 

  

) displayed for the drive slot into which you 

inserted the migrating drive. 

v   Array configuration data on the drives you have added is 

incomplete. 

v   You cannot bring the array online.
Attention: Do not initialize a drive that you want to keep (by 

right-clicking its icon and selecting Initialize from the pull-down 

menu) if it contains configuration or user data. Initializing any drives 

in a defined array causes all hard drives known to comprise that array 

to return to the Unconfigured Capacity storage pool, deleting their 

array definitions from the DS4000 Storage Subsystem configuration. 

The user data on such drives is lost. 

Result: Once the arrays are online, they are ready to for you to 

configure and map to host servers. You might also then recreate 

flashcopies of the logical drives. 

__ Step 4.   Use the DS4000 Storage Manager program to view the storage 

partitioning definitions and make any necessary corrections. 

__ Step 5.   The DS4000 Storage Subsystem that the drives are migrated from will 

display the logical drives that are defined in these drives as “missing 

LUNs”. In order to remove these “missing LUNs” entries, right-click on 

each entry and select Delete from the pull-down menu.

Migrating arrays within storage subsystems 

 Important:  

1.   Ensure that your controller firmware is at or above the level documented in 

Table 19 on page 45. Do not rearrange more than one array at a time. 

2.   Unmount the file systems to flush I/O from the server cache to disks.
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Notes:  

a.   In a Microsoft Windows environment, remove the drive letter or the mount 

points of the mapped LUNs instead of unmounting the file systems. 

b.   Consult documentation associated with your particular operating system for 

detailed information regarding the Unmount procedure. 

Using the configuration data on existing drives, it is possible to redistribute the 

drives that made up an RAID array across a storage subsystem to which you may 

be adding expansion enclosures. Figure 18 illustrates a storage array distributed 

across three drives on a single storage device before and after reordering. When 

you redistribute each drive to a different position in the same storage enclosure as 

recommended, the array automatically redistributes accordingly. 

 

Figure 19 illustrates a storage array distributed across three drives on a single 

storage device before reordering across two storage devices. When the drives are 

redistributed across an additional storage enclosure in the storage subsystem as 

recommended, the array automatically redistributes accordingly. 

 

Figure 20 on page 67 illustrates two arrays distributed across five drives and two 

storage enclosures before and after reordering the same drives across other drive 

slots in the same two storage enclosures. 

 Important:  

 Before you attempt to reinsert any of the drives from either enclosure, place the 

array into offline state using the DS4000 Storage Manager client and completely 

remove all of the drives of both arrays from both storage enclosures and wait for 

the Storage Manager to remove the arrays/logical drives from the Storage Manager 

GUI window. After you insert the drives associated with the first array, wait until 

that array comes online in a DS4000 Storage Manager Subsystem Management 

window before you insert the drives associated with the second array. 
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Figure 18. Manner recommended for reordering a defined array using empty slots in one 

storage enclosure
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Figure 19. Manner recommended for reordering a defined array using empty slots in two  

storage enclosures
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Perform the following steps to ensure success when you reorder drives that make 

up arrays across different drive slots in the same DS4000 Storage Subsystem 

configuration. 

 1.   Start the DS4000 Storage Manager Client program and open the Subsystem 

Management window (for the DS4000 Storage Subsystem which drives you 

intend to reorder). 

 2.   Set the arrays that you plan to move offline. 

 3.   Mark the drives in the arrays. 

 4.   Unlatch the drives from their respective slots. Wait at least 2 minutes for each 

drive to spin down. 

 5.   Slowly and carefully remove the drives from their slots. 

 6.   Assure that all of the drives that made up the arrays are completely removed 

from their slots. 

 7.   Wait for the storage manager to mark the arrays/logical drives as missing in 

the Subsystem Management window. See Figure 21. 

 CAUTION: 

Do not proceed to step 8 until all of the defined logical drives in the 

array(s) whose drives are removed from the DS4000 enclosures display as 

missing; otherwise, the controller may mark certain drives that are part of 

the array as failed, causing the array to be degraded or failed.987
 

 8.   Carefully reinsert all of the drives that made up a single array into the empty 

slots of the storage enclosure. Do not insert the drives into empty slots that 

are part of another array definition whose drives are still inserted in the 
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Figure 20. Reordering multiple defined arrays across previously used slots in two storage 

enclosures
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Figure 21. Subsystem Management Logical/Physical View of missing logical drives
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storage enclosures. Data on the drives you insert will be replaced with the 

reconstructed data from the previously installed RAID array. 

 9.   The system will recognize the array and bring it online when you finish 

inserting all of the drives. 

10.   Repeat steps 8 on page 67 and 9 for each of the arrays that were removed 

from the storage enclosure. 

11.   Save the storage subsystem profile. See “Saving the storage subsystem profile” 

on page 53 for information on performing this activity.

Note:  Do not reinsert drives from multiple arrays in random order into the 

storage enclosures.
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Chapter  4.  Adding  or  migrating  storage  expansion  enclosures  

Overview and rules 

This chapter provides all the steps necessary to add or migrate storage expansion 

enclosures in a DS4000 Storage Subsystem. 

 Important:  

 Observe proper ESD procedures when handling electronic equipment. See 

“Handling static-sensitive devices” on page 54 for additional information. 

 Attention:  

 Make additions to the DS4000 Storage Subsystem only while it is powered on and 

in optimal state. See “Bringing storage subsystems and drive loops into optimal 

state” on page 52 for additional information on how to make this determination. 

You can complete this process while the DS4000 Storage Subsystem is receiving 

I/O from the host server; however, because the drive loops are interrupted 

momentarily during the addition process, schedule the addition to occur during 

time periods of low I/O between the DS4000 Storage Subsystems and host servers. 

When adding storage expansion enclosures containing new hard drives to an 

existing DS4000 storage subsystem configuration, or migrating one or more DS4000 

storage expansion enclosures already containing hard drives with configuration 

data from a functioning DS4000 Storage Subsystem to another DS4000 Storage 

Subsystem configuration, observe these important rules: 

__ v   Never alter the physical configuration of a DS4000 Storage Subsystem while it 

is powered off unless you are instructed to do so as part of DS4000 Storage 

Subsystem configuration procedure. Specifically, never attach storage 

components to or remove storage components from a configured DS4000 

Storage Subsystem while it is powered off. 

__ v   Any hard drive, whether new or old, might contain configuration data. 

Unless you intend to migrate drives from another DS4000 Storage Subsystem 

(retaining their configuration data), always use the procedure to add one or 

more storage expansion enclosures containing one or more hard drives to a 

functioning DS4000 Storage Subsystem configuration. Do not use the 

migrating storage expansion enclosure procedure if you are unsure of the 

quality of the data on the hard drives. Importing incorrect configuration data 

from hard drives could cause a DS4000 Storage Subsystem failure. 

__ v   When migrating hard drives from multiple DS4000 Storage Subsystems to a 

single DS4000 Storage Subsystem, move all of the hard drives from the first 

DS4000 Storage Subsystem as an independent set to the destination DS4000 

Storage Subsystem. Before moving hard drives as a set from subsequent 

DS4000 Storage Subsystems, ensure that all of the hard drives from the 

previous set have been successfully transferred to the destination DS4000 

Storage Subsystem. If you do not transfer hard drives as sets to the 

destination DS4000 Storage Subsystem, the newly relocated arrays/logical 

drives that are defined in these drives might not appear in the Subsystem 

Management window. 

__ v   Before migrating hard drives, perform the following steps to establish drive 

model compatibility: 
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__ 1.   Check the drive CRU form factor options. 

__ 2.   If the form factors are not the same, there are no replacement parts 

(this includes bezels and drive trays). 

__ 3.   If the form factors are the same, check to see if the drive is supported 

by the DS4000 subsystem. 

__ 4.   Ensure that the drive can operate at the storage subsystem drive 

loop/channel FC speed. See Table 18 on page 42 for more information.
v    Not all combinations of the supported storage expansion enclosures will be 

supported as storage expansion enclosures intermixed behind DS4000 storage 

subsystems. 

v   Do not mix SATA and Fibre Channel drives or enclosures together in the same 

drive loop unless you have met the Fibre Channel/SATA intermix requirements. 

See “Intermixing storage expansion enclosures” on page 4 for that information. 

v   Do not install SATA drives in EXP700 or EXP710 Fibre Channel drive expansion 

enclosures. Do not install Fibre Channel drives in EXP100 SATA drive expansion 

enclosures. EXP810 drive expansion enclosures can accept either Fibre Channel 

(FC) or SATA Enhanced Disk Drive Modules (E-DDMs); however, the intermix 

of FC and SATA E-DDMs in the same EXP810 enclosure is not supported at this 

time. Check the DS4000 interoperability matrix for the support of this capability 

in the future. 

v   Do not attach more than 4 storage expansion enclosures behind a DS4700 

Express or DS4800 controller drive channel port. See the IBM System Storage 

DS4700 Express Storage Subsystem: Installation, User’s and Maintenance Guide or the 

IBM System Storage DS4800 Storage Subsystem Installation, User’s and Maintenance 

Guide, for more information. 

v   Always connect the DS4000 controller drive channel port to either the left or right 

EXP810 or EXP420 ESM drive port that is labeled 1B. 

v   When intermixing the storage expansion enclosures in a redundant drive loop/channel 

pair behind a DS4000 storage subsystem, always group the storage expansion enclosures 

by type; for example, group the EXP100s together, group the EXP700s together, group 

the EXP710s and EXP810s together. The EXP710s and EXP810s are considered 

Switched-ESM types of expansion enclosures even though they have different machine 

types and models. Though there are no restrictions against cabling EXP710 and 

EXP810 storage expansion enclosures together, for ease of future maintenance and to aid 

in problem troubleshooting, IBM strongly recommends that you group, or plan your 

configuration to allow for grouping of, the drive expansion enclosures by type in a 

DS4000 Storage Subsystem redundant drive loop/channel pair. 

v   Make sure the enclosure IDs of each storage expansion enclosure in a redundant drive 

loop/channel pair behind a DS4000 storage subsystem have unique values in the single 

digit (x1) position.

The following procedure combines the steps that are required to add one or more  

DS4000 storage expansion enclosures containing new drives to a functioning 

DS4000 Storage Subsystem configuration and to migrate storage expansion 

enclosure(s) from a DS4000 storage subsystem configuration to another DS4000 

storage subsystem configuration. There will be indicators in the steps if they are 

specific to either adding or migrating enclosure tasks. If you are migrating storage 

expansion enclosures, do not perform the steps that are indicated as being only for 

adding storage expansion enclosures: performing steps designed to add storage 

expansion enclosures might cause the deletion of the logical drive configuration in 

the migrated hard drives. 
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Activity 1: Preliminary activities 

Before adding or migrating storage expansion enclosures, there are preliminary 

steps that must be completed to ensure that your DS4000 Storage Subsystem will 

perform properly once the addition or migration is finished. 

__ Step 1.   Verify that the DS4000 Storage Subsystem is powered on and in 

optimal state. If this is a migrating enclosure task, also ensure that the 

DS4000 subsystem in which the enclosures are to be migrated is 

powered on and is optimal. See the DS4000 Problem Determination Guide 

associated with your particular DS4000 hardware model or “Bringing 

storage subsystems and drive loops into optimal state” on page 52 for 

additional information on how to make this determination. You can 

perform this process while the DS4000 Storage Subsystem is processing 

I/O from or to the host server; however, because the drive loops are 

interrupted momentarily during the addition process, schedule any 

additions to occur during time periods of low I/O between the DS4000 

Storage Subsystem and host servers. 

Note:  Though there are no restrictions against cabling EXP100s with 

EXP700s, or EXP710s with EXP810 storage expansion enclosures, 

for ease of future maintenance and to aid in problem 

troubleshooting, IBM recommends that you group, or plan your 

configuration to allow for grouping of, the drive expansion 

enclosures by type in a DS4000 Storage Subsystem redundant 

drive loop/channel pair. 

Review the readme and the IBM System Storage DS4000 Storage Manager 

Installation and Support Guide associated with the operating system 

environment of the host servers that connect to the DS4000 Storage 

Subsystem for any additional restrictions or required preparation tasks 

specific to your particular operating system environment. You will find 

the IBM System Storage DS4000 Storage Manager installation and support 

guides at: 

www-1.ibm.com/servers/storage/support/disk/ 

__ Step 2.   Verify that the DS4000 Storage Subsystem supports the DS4000 drive 

storage expansion enclosures you trying to add or migrate. 

__ Step 3.   If the new, or to-be-migrated, storage expansion enclosure is not the 

same type as the existing storage expansion enclosures (some or all) see 

“Intermixing storage expansion enclosures” on page 4 for intermix 

information.

Note:  You must group like DS4000 storage expansion enclosure types 

in adjacent positions on the Fibre Channel loop when they are 

intermixed in a DS4000 Storage Subsystem redundant drive loop 

configuration. 

__ Step 4.   If you are adding new enclosures with new drives, proceed with the 

steps in “Adding new expansion enclosures with new hard drives”; 

otherwise, proceed to the steps in “Migrating expansion enclosures 

with hard drives having defined logical drive configurations” on page 

73.

Adding new expansion enclosures with new hard drives 

__ Step 1.   Unpack and mount any additional storage expansion enclosures in the 

rack using the mounting hardware supplied with each storage 

expansion enclosure. 

 Important: 
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Do not fully insert hard drives into the enclosures at this time. Keep 

them unlatched and no less than ½ inch away from their full insertion 

points in the drive slots. 

__ Step 2.   Set the enclosure ID of the additional storage expansion enclosures. 

Each enclosure (including the DS4000 storage subsystem with internal 

drive slots) in the DS4000 Storage Subsystem configuration must have 

a unique enclosure ID. In addition, enclosures (including the DS4000 

storage subsystem with internal drive slots) that are connected together 

in the same redundant drive loop/channel pair must have unique 

single enclosure ID digits (x1s). For example, 01, 02, 03, 04, or 11, 12, 

13, 14, are the correct enclosure IDs of the enclosures, including the 

DS4000 subsystems with internal drives that are connected together in 

a drive loop/channel. Whereas 01, 11, 21, 31, or 11, 11, 22, 33, are not 

the correct enclosure IDs of the enclosures that are connected together 

in a drive loop/channel pair (including the DS4000 subsystems with 

internal drives) because the single digits within each enclosure ID are 

not unique (01, 11, 21, 31) or the enclosure ID itself is not unique (11, 

11, 22, 33). 

In a EXP500 storage expansion enclosure, there is an enclosure ID 

switch mounted on each of two ESM canisters. Set each ESM canister’s 

enclosure ID switch in the EXP500 drive enclosure to the same unique 

number of that in the drive loop. In EXP100, EXP700, and EXP710 

storage expansion enclosures, there is only one enclosure ID switch, 

which is mounted between the power supplies. The EXP420/EXP810 

does not have a physical switch setting for the enclosure ID; instead, it 

has a display that shows its enclosure ID. The controller firmware 

automatically sets the enclosure ID; however, you can change the 

enclosure ID by using the DS4000 Storage Manager Client program. For 

additional information, see the appropriate DS4000 Installation, User’s, 

and Maintenance Guide for the particular storage expansion enclosure. 

Figure 22 illustrates the location of enclosure ID switches on the 

EXP100, EXP500, EXP700, EXP710, and EXP420/EXP810 storage 

enclosures.
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Figure 22. EXP100, EXP500, EXP700, EXP710, and EXP420/EXP810 enclosure ID and 

speed switches
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If the DS4000 Storage Subsystem to which the storage expansion 

enclosure will attach is either a FAStT200, DS4100, DS4200, DS4300, or 

DS4700 Express, the enclosure IDs of additional storage expansion 

enclosures must differ from the FAStT200, DS4100, DS4200, DS4300 or 

DS4700 Express Storage Subsystem enclosure IDs. The enclosure IDs of 

FAStT200, DS4100 and DS4300 are normally set to 00 at the factory. The 

enclosure IDs for the DS4200 and DS4700 Express are normally set to 

85 at the factory. 

__ Step 3.   Verify that the DS4000 Storage Expansion Enclosure speed switch is set 

to the correct drive loop speed, which is the highest speed that all 

enclosures in the drive loop/channel can operate in. For example, if 

there is a mix of drive enclosures that are FC 4 Gbps capable and FC 2 

Gbps capable in the same drive loop/channel, all of the enclosures 

must have the speed switch set at the highest speed that ALL 

enclosures can operate, which is FC 2 Gbps speed. 

Note:  If a Fibre Channel enclosure speed switch was originally set to 1 

Gbps, do not automatically set it to 2 Gbps unless you are sure 

that each Fibre Channel hard drive that it now contains is 

capable of 2 Gbps operation. Be sure you have installed the 

latest firmware to enable hard drive operation in a 2 Gbps Fibre 

Channel environment. Similarly, do not automatically change the 

settings from 2 Gbps to 4 Gbps unless you are sure that the 

installed drives are capable of 4 Gbps operation. Do not 

automatically move up to higher speed unless the installed disk 

drives can operate at a higher speed. 

__ Step 4.   Proceed to “Activity 6: Cabling, powering on, and verifying storage 

expansion unit operation” on page 78. Do not perform Activities 3–5.

Migrating expansion enclosures with hard drives having defined 

logical drive configurations 

__ Step  1.   Verify that controller firmware and NVSRAM in the both the DS4000 

Storage Subsystem that the enclosures will be migrated to and the 

DS4000 Storage Subsystem that has the enclosures to be migrated, are 

at the levels recommended in Table 19 on page 45. 

__ Step  2.   Verify that the firmware of the ESMs in the storage expansion 

enclosures that you plan to migrate are at the levels recommended in 

Table 25 on page 133. 

__ Step  3.   Verify that the firmware of the ESMs in the storage expansion 

enclosures attached to the DS4000 Storage Subsystem to which you 

will migrate your drives is at the levels recommended in Table 20 on 

page 48. 

__ Step  4.    If you migrate storage expansion enclosures from a lower Fibre 

Channel environment to a higher Fibre Channel environment (for 

example, moving from 1 Gbps to 2 Gbps or from 2 Gbps to 4 Gbps), 

verify that each of the Fibre Channel hard drives that you plan to 

migrate are capable of higher FC speed operation and that you have 

installed the latest firmware, if required, enabling them to work 

properly in a higher FC speed Fibre Channel environment. 

Data that may reside on drives you plan to migrate will migrate with 

those drives, when installed on another DS4000 Storage Subsystem. To 

ensure a successful migration, perform steps 5, 6, 7 and 8, that follow. 

__ Step  5.   Verify that the names of the logical drives that are created using the 

hard drives in the migrated storage expansion enclosures are unique 
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in the DS4000 Storage Subsystem to which these storage expansion 

enclosures will migrate. If they are not unique, make any necessary 

changes. 

__ Step  6.   Verify that all of the enclosures IDs of the storage expansion 

enclosures in the redundant drive loop/channel have unique single 

digit (x1) values. 

__ Step  7.   In addition to array configuration information, any storage 

partitioning configuration data that may reside on drives you plan to 

migrate will migrate with those drives when installed on another 

DS4000 Storage Subsystem. For this reason, take the following 

precautions to facilitate the migration process and prevent problems 

in storage partitioning configuration data migration. 

a.   If a DS4000 storage partitioning premium feature has been enabled 

both on a drive’s original and destination DS4000 Storage 

Subsystems, ensure that the defined host ports, hosts, and host 

group names are unique to each DS4000 Storage Subsystem 

involved in the migration. 

b.   If you must use identical names on both DS4000 Storage 

Subsystems, make the names unique before you perform the drive 

migration. If necessary, customize the storage partitioning 

information on the DS4000 Storage Subsystem to which you have 

migrated the drives after you complete the migration.
__ Step  8.   Delete any flash copies of logical drives defined in the hard drives 

that you plan to migrate. 

__ Step  9.   Remove any remote mirror relationships that involve the logical 

drives defined on the drives that you plan to migrate. 

__ Step 10.   Proceed to “Activity 2: Preparing and backing up the drives.”

Activity 2: Preparing and backing up the drives 

Note:  The following steps are for migrating enclosures with drives having defined 

arrays/logical drives only. Do not perform these steps if you are adding 

enclosures with new drives or drives containing unneeded data. 

__ Step 1.   If the arrays and logical drives involved are not in optimal state, 

perform the steps necessary to bring these arrays and logical drives to 

their optimal state before attempting migration. Use the Recovery Guru 

function in the DS4000 Storage Subsystem Management window of the 

DS4000 Storage Manger client program, or see “Bringing storage 

subsystems and drive loops into optimal state” on page 52 for 

additional information on how to make this determination. 

__ Step 2.   If the drive enclosures that you plan to migrate are not in optimal 

state, perform the steps necessary to bring them to their optimal state 

before attempting migration. Use the Recovery Guru function in the 

DS4000 Storage Subsystem Management window of the DS4000 Storage 

Manger client program, or see “Bringing storage subsystems and drive 

loops into optimal state” on page 52 for additional information on how 

to make this determination. 

__ Step 3.   Perform a backup of the logical drives defined in the storage expansion 

enclosures that you plan to migrate. 

__ Step 4.   Monitor the DS4000 Storage Subsystem event log for any errors in the 

drive loop or its components for several days before migrating storage 

expansion enclosures. 
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__ Step 5.   Stop all programs, services or processes in the host servers that access 

the logical drives defined in the migrated hard drives. Ensure that 

there are not any running background programs, services or processes 

that write data to the logical drives. (For example, Microsoft MSCS 

service periodically writes to the “Quorum” disk.) 

__ Step 6.   Unmount the file systems to flush I/O from the server cache to disks. 

Notes:  

a.   In a Microsoft Windows environment, remove the drive letter or the 

mount points of the mapped LUNs instead of unmounting the file 

systems. 

b.   Refer to the documentation associated with your particular 

operating system for detailed information regarding the Unmount 

procedure.
__ Step 7.   Save the DS4000 Storage Subsystem profile of the functioning DS4000 

Storage Subsystem configuration to which the migration will occur in a 

location other than that of the logical drives you plan to migrate. 

__ Step 8.   Place the arrays defined in the storage expansion enclosures that you 

plan to migrate in offline state. In the DS4000 Storage Subsystem 

Management window, right-click on the name of the array and click 

Place -> Offline.

Activity 3: Shutting down and moving the storage expansion 

enclosure(s) 

Note:  The following steps are for migrating enclosures with drives having defined 

arrays/logical drives only. Do not perform these steps if you are adding 

enclosures with new drives or drives containing unneeded data. 

__ Step 1.   Because removing a storage expansion enclosure from a functioning 

DS4000 Storage Subsystem will disrupt its drive loops, shutdown the 

DS4000 Storage Subsystem while you remove its storage expansion 

enclosures for migration to another DS4000 storage subsystem. If you 

cannot shutdown the DS4000 Storage Subsystem, carefully reconfigure 

only one drive loop, making sure that the drive loop that you modify 

is connected correctly and in optimal state before you attempt to 

reconfigure the other drive loop. For additional information on making 

this determination, see “Bringing storage subsystems and drive loops 

into optimal state” on page 52. 

Take this precaution to prevent the arrays from being inadvertently 

failed by the DS4000 Storage Subsystem controllers because two or 

more drives in the arrays cannot be reached through either drive loop 

in the redundant drive loop pair. 

Perform the following steps to verify that the drive loops are in 

optimal state: 

__ a.   Physically trace the actual cable connections making sure that 

connections are properly modified and that the cable connectors 

are firmly inserted into the SFPs or GBICs. 

__ b.   Verify that the following LEDs are not lit or briefly flashed in the 

modified drive loop: 

__ v   ESM Fault 

__ v   port bypass 

__ v   ID conflict
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__ c.   Verify that the controller drive loop LED remains lit. If the 

controller drive loop LED becomes unlit momentary, there are 

problems in the drive loop and the Loop Initialization Primitives 

(LIPs) are generated by the DS4000 Storage Subsystem controller. 

__ d.   In the DS4000 Storage Manager Client Subsystem Management 

window, verify that there are no loss of ESM path redundancy 

errors in the storage expansion enclosures that are not migrated. 

Do not modify the second drive loop in the redundant drive 

loop pair until you are sure that the first modified drive loop is 

operating optimally.
__ Step 2.   Power down the storage expansion enclosures and move them to the 

DS4000 Storage Subsystem to which you plan to migrate them. 

Notes: 

v   A storage expansion enclosure with 14 drives weighs up to 100 lbs. 

(45 kg). If necessary, remove the drives and other storage expansion 

enclosure components to reduce the weight of the unit for easier 

handling. Mark each drive before removing it in order to return it to 

the same drive slot when you reassemble the components at the 

destination location. 

v   Move drives only in a horizontal position using an appropriate ESD 

bag or container and moving equipment that prevents shock to the 

drives during transit. Never stack drives.

Activity 4: Verifying the drive migration enable settings 

Note:  The following steps are for migrating enclosures with drives having defined 

arrays/logical drives only. Do not perform these steps if you are adding 

enclosures with new drives or drives containing unneeded data. 

The DS4000 storage subsystem drive migration setting of the DS4000 storage 

subsystem to which the enclosures will be migrated must be set to enable before 

inserting drives with configuration data. If not, the DS4000 controller ignores the 

configuration data in the drive and displays the drive as unconfigured and 

optimal. Verify the drive migration setting on the DS4000 storage subsystem to 

which the expansion enclosure will be migrated. IBM recommends that you 

perform the steps to run the EnableDriveMigration script to ensure the drive 

migration setting is set to enable before inserting any drives with configuration 

data. See “Activity 3: Re-enabling the drive migration settings” on page 57 for 

instructions. 

Activity 5: Installing and setting storage expansion unit IDs 

and speeds 

Note:  The following steps are for migrating enclosures with drives having defined 

arrays/logical drives only. Do not perform these steps if you are adding 

enclosures with new drives or drives containing unneeded data. 

__ Step 1.   When the storage expansion enclosures and drives are at the location 

of the DS4000 Storage Subsystem to which they will be migrated, 

install them into the rack. If the drives were removed during transit, 

return them to the slots from which they were removed, unlatched and 

no less than 1/2-inch away from their full insertion points in the drive 
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slots. If the drives were not removed, unlatch and pull them out no 

less than 1/2-inch away from their full insertion points in the drive 

slots. 

__ Step 2.   See Figure 22 on page 72 for an illustration of how to set the enclosure 

ID of the storage expansion enclosures. Each enclosure (including the 

DS4000 storage subsystem with internal drive slots) in the DS4000 

Storage Subsystem configuration must have a unique enclosure ID. In 

addition, enclosures (including the DS4000 storage subsystem with 

internal drive slots) that are connected together in the same redundant 

drive loop/channel pair must have unique single enclosure ID digits 

(x1s). For example, 01, 02, 03, 04, or 11, 12, 13, 14, are the correct 

enclosure IDs of the enclosures, including the DS4000 subsystems with 

internal drives that are connected together in a drive loop/channel. 

Whereas 01, 11, 21, 31, or 11, 11, 22, 33, are not the correct enclosure 

IDs of the enclosures that are connected together in a drive 

loop/channel pair (including the DS4000 subsystems with internal 

drives) because the single digits within each enclosure ID are not 

unique (01, 11, 21, 31) or the enclosure ID itself is not unique (11, 11, 

22, 33). 

In an EXP500 Storage Expansion Unit, there is an enclosure ID switch 

mounted on each of two ESM canisters. Set each ESM canister’s 

enclosure ID switch in the EXP500 drive enclosure to the same unique 

number in the drive loop. In the EXP100, EXP700 and EXP710 storage 

expansion enclosures, there is only enclosure ID switch, which is 

mounted between the power supplies. The EXP420 and EXP810 do not 

have physical switch settings for enclosure IDs. Instead it has a LED 

that shows its enclosure ID. The controller firmware automatically sets 

the enclosure ID. However, you can change the enclosure ID by using 

the DS4000 Storage Manager Client program. To access the appropriate 

DS4000 Storage Expansion Unit Installation and User’s Guide for 

additional information, use the following Web link: 

http://www-03.ibm.com/servers/storage/support/disk/ 

 Important: 

 If the DS4000 Storage Subsystem to which the storage expansion 

enclosure will attach is either a FAStT200, DS4100, DS4200, DS4300, or 

DS4700, the enclosure IDs of additional storage expansion enclosures 

must differ from the FAStT200, DS4100, DS4200, DS4300 or DS4700 

Storage Subsystem enclosure IDs. The enclosure IDs of FAStT200, 

DS4100 and DS4300 are normally set to 00 at the factory. The enclosure 

IDs for the DS4200 and DS4700 are normally set to 85 at the factory. 

__ Step 3.   Verify that the DS4000 Storage Expansion Enclosure speed switch is set 

to the correct drive loop speed, which is the highest speed that all 

enclosures in the drive loop/channel can operate in. For example, if 

there is a mix of drive enclosures that are FC 4 Gbps capable and FC 2 

Gbps capable in the same drive loop/channel, all of the enclosures 

must have the speed switch set at the highest speed that ALL 

enclosures can operate, which is FC 2 Gbps speed. 

Note:  If a Fibre Channel enclosure speed switch was originally set to 1 

Gbps, do not automatically set it to 2 Gbps unless you are sure 

that each Fibre Channel hard drive that it now contains is 

capable of 2 Gbps operation. Be sure you have installed the 

latest firmware to enable hard drive operation in a 2 Gbps Fibre 

Channel environment. Similarly, do not automatically change the 
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settings from 2 Gbps to 4 Gbps unless you are sure that the 

installed drives are capable of 4 Gbps operation. Do not 

automatically move up to higher speed unless the installed disk 

drives can operate at a higher speed.

Note:  Before you migrate hard drives, be sure you first establish drive model 

capacity and interface type / speed compatibility. For specific information 

about your drive options in the most current environment, see Table 18. 

Activity 6: Cabling, powering on, and verifying storage 

expansion unit operation 

This activity is for both adding and migrating enclosures. 

To complete addition of DS4000 storage expansion enclosures, cable the storage 

expansion enclosures to the end of the functioning storage expansion enclosure 

drive loop to which you are migrating them. Add only one enclosure at a time to a 

functioning drive loop, if you intend to attach multiple storage expansion 

enclosures. 

It is possible to connect storage expansion enclosures at either end, or in the 

middle, of an existing and functioning storage expansion enclosure drive 

loop.Figure 23 on page 79 shows possible ways of adding enclosures to existing 

and functioning storage expansion enclosure drive loop. The options are: 

1.   The beginning, closest to the controller (at the top, directly attached to 

controller A) as described in Connecting storage expansion enclosures at the 

beginning of (top of) a drive loop. 

2.   The middle, between the existing storage expansion enclosures in the 

redundant drive loop/channel pair, as described in “Connecting storage 

expansion enclosures in the middle of a drive loop” on page 85. 

3.   The end, furthest from the controller (at the bottom, directly attached to 

controller B) as described in Connecting storage expansion enclosures at the 

end of (bottom of) a drive loop.

Of the three options, IBM recommends only option 3—connection to the end (at 

the bottom) of a functioning storage expansion enclosure drive loop, directly 

attached to controller B. This is recommended because if the existing DS4000 

Storage Subsystem configuration is not planned for cabling-in storage expansion 

enclosures at the top or the middle of the drive loop, cluttered or entangled Fibre 

Channel drive loop cabling may hinder drive loop troubleshooting or cause Fibre 

Channel cabling errors. With this in mind, and depending on your requirements, 

follow either of the instruction sets at “Connecting storage expansion enclosures at 

the end of (bottom of) a drive loop” on page 80, “Connecting storage expansion 

enclosures in the middle of a drive loop” on page 85, or “Connecting storage 

expansion enclosures at the beginning of (top of) a drive loop” on page 95. 
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Depending on your DS4000 Storage Subsystem configuration, there might be 

unused drive ports by which you can connect the drive expansion enclosures to 

the DS4000 Storage Subsystem controllers. IBM recommends utilizing the unused 

drive ports when adding storage expansion enclosures to an existing DS4000 

configuration—especially if you are adding enclosures of a different type to the 

configuration. Use the appropriate information in your DS4000 Installation, User’s, 

and Maintenance Guide to attach the drive expansion enclosures to the DS4000 

storage subsystem. 

If your DS4000 Storage Subsystem (such as DS4400 or DS4500) has drive minihubs, 

do not use more than one port per drive minihub. Always leave one of the two 

drive ports empty in each drive minihub. 

The steps and graphics in “Connecting storage expansion enclosures at the end of 

(bottom of) a drive loop” on page 80 and “Connecting storage expansion 

enclosures at the beginning of (top of) a drive loop” on page 95 illustrate how to 
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Figure 23. Example of adding expansion enclosure positions within a functioning drive loop
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connect 10- or 14-drive storage expansion enclosures, for example, an EXP700 or 

EXP710 to a DS4300 storage subsystem drive loop. To connect 16-drive storage 

expansion enclosures—for example, an EXP810 to an existing DS4800 drive 

loop—follow the similar steps; however, note that the port names are different on 

the EXP700 than on the EXP810. 

Connecting storage expansion enclosures at the end of (bottom 

of) a drive loop 

The cabling instructions illustrated in Figure 24 on page 82, Figure 25 on page 83, 

and Figure 26 on page 84 describe cabling a DS4000 14-drive expansion enclosure 

EXP700 to the end (bottom) of a redundant drive loop of a functioning DS4300 

Storage Subsystem (model 60X or 60U). The same procedure can also be used to 

add any 14-drive expansion enclosure to any of the DS4000 storage subsystems. 

Again, IBM recommends that you add storage expansion enclosures to existing 

drive loops only in this manner. 

See also “DS4000 Storage Subsystem drive loop schemes” on page 26. 

To add a 16-drive expansion enclosure—for example, an EXP810 or EXP420 to the 

DS4000 subsystem configuration—you basically follow the same steps as in adding 

the 14-drive enclosure to a DS4000 subsystem configuration; however, the port 

connections on the 16-drive enclosure will be different, as illustrated in Figure 27 

on page 85 and the three steps that follow it. 

__ Step 1.   Insert the small form-factor pluggables (SFPs) or gigabit interface 

converters (GBICs) into only those ports you intend to use. Do not 

leave GBICs or SFPs inserted into port slots without connecting them 

to other ports using cables. 

__ Step 2.   Extend one of the drive loops (that is, drive loop A) in a DS4000 

Storage Subsystem redundant drive loop pair by connecting the OUT 

port of the last storage expansion enclosure to the IN port of the 

storage expansion enclosure as shown in Figure 24 on page 82.

Note:  The port name on an EXP810 is not labeled IN. See Figure 27 on 

page 85 for details.

 Attention:  Carefully reconfigure only one drive loop at a time, 

making sure that the drive loop you modify is properly connected and 

in the optimal state before you attempt to reconfigure another drive 

loop. Take this precaution to prevent the arrays from being 

inadvertently failed by the DS4000 Storage Subsystem controllers, 

which happens when two or more drives in the arrays cannot be 

reached through either drive loop in the redundant drive loop pair. 

__ Step 3.   Power on the added storage expansion enclosure unit. 

__ Step 4.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop A, now extended to the storage expansion enclosure, are 

not lit. Using the DS4000 Storage Manager Client Subsystem 

Management window, verify that the storage expansion enclosure is 

added and displayed in the Logical/Physical view of the window. 

Correct any errors before proceeding to step 5 on page 81. For port 

bypass: 

__ a.   Verify that the SFPs and GBICs or fibre cables are in good 

condition. 

__ b.   Remove and reinsert SFPs, GBICs and fibre cables. 

 

80 Adding  and Migrating Drives and Expansion  Enclosures  to DS4000 Storage  Servers



__ c.   Make sure the drive expansion enclosure speed switch is set to 

the same speed as the existing drive expansion enclosures and 

the DS4000 Storage Subsystem speed setting. 

__ d.   Verify that the ESM is good by physically removing and 

swapping it with the other ESM in the same drive expansion 

enclosure. For enclosure ID conflict, set the drive expansion 

enclosure ID switch to values unique from the current settings in 

the existing drive expansion enclosures and storage server.

Call  the IBM Help Center for assistance, if the problems persist. 

__ Step 5.   In the other drive loop (drive loop B) in a DS4000 Storage Subsystem 

redundant drive loop pair, remove the connection from the storage 

subsystem drive loop port to the OUT port of the last storage expansion 

enclosure and connect it to the OUT port of the drive enclosure as 

shown in Figure 25 on page 83.

Note:  The port name on an EXP810 is not labeled OUT. See Figure 27 on 

page 85 for details. 

__ Step 6.   Wait a few seconds; verify that the port bypass LEDs of the two ports 

in the connection between the storage subsystem drive loop port and 

the OUT port of the drive enclosure are not lit. Using the DS4000 

Storage Manager Client Subsystem Management window, verify that 

the drive enclosure does not indicate the drive enclosure lost 

redundancy path error. See step 4 on page 80 for possible corrective 

actions, as needed.

Note:  The existing storage expansion enclosures will be shown with 

drive enclosure lost redundancy path errors until you 

establish the Fibre Channel cabling connection described in step 

7. 

__ Step 7.   In drive loop B, cable the drive enclosure’s IN port to the OUT port of 

the last enclosure in the already functioning storage expansion 

enclosure drive loop, as shown in Figure 26 on page 84. 

__ Step 8.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop B to which you have added a connection are not lit. 

Using the DS4000 Storage Manager Client Subsystem Management 

window, verify that all of the drive enclosures in the DS4000 redundant 

drive loop pair to which the enclosure was added do not report the 

drive enclosure lost redundancy path error. 

__ Step 9.    Proceed to “Activity 7: Disabling DS4000 Storage Subsystem drive 

migration settings (for adding storage expansion enclosures with new 

drives only)” on page 101, only if you are adding an enclosure with a 

new drive. Proceed to “Activity 10: Inserting hard drives and placing 

logical drives online (for migrating only enclosures with drives 

containing logical drive configuration data)” on page 111,  if you are 

migrating enclosures with drives having logical drive configuration 

data.
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To add an EXP810 to the end of a functioning drive channel, perform the 

procedure in “Connecting storage expansion enclosures at the end of (bottom of) a 

drive loop” on page 80, replacing steps 2, 5, and 7, with steps 1–3, below: 

__ Step 1.   Connect port 1A of the A ESM in the existing EXP810 to port 1B of the 

A ESM in the new EXP810. 

__ Step 2.   Move the existing connection from port 1B of the B ESM in the existing 

EXP810 to port 1B of the B ESM in the new EXP810. 

__ Step 3.   Connect port 1B of the B ESM in the existing EXP810 to port 1A of the 

B ESM in the new EXP810.

Connecting storage expansion enclosures in the middle of a 

drive loop 

The cabling instructions illustrated in Figure 28 on page 88, Figure 29 on page 89, 

Figure 30 on page 90, and Figure 31 on page 91, describe cabling a DS4000 EXP700 

Storage Expansion Enclosure to the middle of a redundant drive loop of a 
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Figure 27. Cabling an EXP810 to the end of a functioning drive loop
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functioning DS4300 Storage Subsystem (model 60X or 60U). The new enclosures 

will be cabled between the two existing storage expansion enclosures in the drive 

loop/channel. IBM does not recommend that you add storage expansion 

enclosures in this manner, especially if there is insufficient rack space to allow the 

methodical, uncluttered, and uniform Fibre Channel cabling of new enclosures. The 

disadvantages of improper planning for adding expansion enclosures in this 

manner, include cable management issues that contribute to troubleshooting 

difficulties. 

To add a 16-drive expansion enclosure—for example, an EXP810 or EXP420 to the 

DS4000 subsystem configuration—you basically follow the same steps as in adding 

the 14-drive enclosure to a DS4000 subsystem configuration; however, the port 

connections on the 16-drive enclosure will be different. Figure 32 on page 92 shows 

an example of connecting a 16-drive storage expansion enclosure (EXP810) between 

two 16-drive expansion enclosures. 

Figure 33 on page 94 illustrates the cabling of EXP810 enclosures between groups 

of EXP100 and EXP710 enclosures in an existing drive loop/channel. 

Note:  In the following steps, enclosures are referred to as Top, Bottom, or New. In 

the illustrations, these labels are found next to the enclosures. 

__ Step 1.   Insert the small form-factor pluggables (SFPs) or gigabit interface 

converters (GBICs) into only those ports you intend to use. Do not 

leave GBICs or SFPs inserted into port slots without using cables to 

connect them to other ports. 

__ Step 2.   Connect the IN port of the right ESM in the bottom EXP700 enclosure 

to the OUT port of the right ESM in the new EXP700 enclosure, rather 

than to the OUT port of the right ESM in the top EXP700 enclosure. 

See Figure 28 on page 88.

Note:  The port names on an EXP810 are not labeled as IN or OUT. 

They are labeled as 1B or 1A.

 Attention:  Carefully reconfigure only one drive loop at a time, 

making sure that the drive loop you modify is properly connected and 

in the optimal state before you attempt to reconfigure another drive 

loop. Take this precaution to prevent the arrays from being 

inadvertently failed by the DS4000 Storage Subsystem controllers, 

which happens when two or more drives in the arrays cannot be 

reached through either drive loop in the redundant drive loop pair. 

__ Step 3.   Connect the IN port of the right ESM in the new EXP700 enclosure to 

the OUT port of the right ESM in the top EXP700 enclosure. See 

Figure 29 on page 89. 

__ Step 4.   Power on the added storage expansion enclosure unit. 

__ Step 5.   Wait a few seconds; verify that the port bypass LEDs, of all of the ports 

in drive loop B now extend to the storage expansion enclosure, are not 

lit. Using the DS4000 Storage Manager Client Subsystem Management 

window, verify that the storage expansion enclosure is added and 

displayed in the Logical/Physical view of the window. Correct any 

errors before proceeding to 6 on page 87. For port bypass: 

__ Step a.   Verify that the SFPs, GBICs, and fibre cables are in good 

condition. 

__ Step b.   Remove and reinsert SFPs, GBICs, and fibre cables. 
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__ Step c.   Make sure the drive expansion enclosure speed switch is 

set to the same speed as the existing drive expansion 

enclosures and the DS4000 Storage Subsystem speed 

setting. 

__ Step d.   Verify that the ESM is good, by physically removing it, then 

swapping it with the other ESM in the same drive 

expansion enclosure. For enclosure ID conflict, set the drive 

expansion enclosure ID switch to values that are unique 

from the current settings in the existing drive expansion 

enclosures and storage server. Call the IBM Help Center for 

assistance, if the problems persist.
__ Step 6.   Connect the OUT port of the left ESM in the top EXP700 enclosure to 

the IN port of the left ESM in the new EXP700 enclosure, rather than to 

the IN port of the left ESM in the bottom EXP700 enclosure. See 

Figure 30 on page 90. 

__ Step 7.   Connect the OUT port of the left ESM in the new EXP700 enclosure to 

the IN port of the left ESM in the bottom EXP700 enclosure. See 

Figure 31 on page 91. 

__ Step 8.    Wait a few seconds; verify that the port bypass LEDs, of the two ports 

in the connection between the drive enclosure ports, are not lit. Using 

the DS4000 Storage Manager Client Subsystem Management window, 

verify that the drive enclosure does not indicate a drive enclosure lost 

redundancy path error. See 5 on page 86 for possible corrective actions, 

if needed. 

Note:  The existing storage expansion enclosures will be shown with 

drive enclosure lost redundancy path errors until you establish 

the Fibre Channel cabling connection described in 7. 

__ Step 9.    Proceed to “Activity 7: Disabling DS4000 Storage Subsystem drive 

migration settings (for adding storage expansion enclosures with new 

drives only)” on page 101, if you are only adding an enclosure with a 

new drive. Proceed to “Activity 10: Inserting hard drives and placing 

logical drives online (for migrating only enclosures with drives 

containing logical drive configuration data)” on page 111,  if you are 

migrating enclosures with drives having logical drive configuration 

data.
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�1�: Connect port IN of the right ESM in the bottom EXP700 enclosure to the port 

OUT of the right ESM in the new EXP700 enclosure, instead of port OUT of the 

right ESM in the top EXP700 enclosure. 
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Figure 28. Connect the bottom EXP700 enclosure to the OUT  port of the right ESM in the 

new EXP700 enclosure
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�1�: Connect port IN of the right ESM in the bottom EXP700 enclosure to port 

OUT of the right ESM in the new EXP700 enclosure, instead of the right ESM in 

the top EXP700 enclosure. 

�2�: Connect port IN of the right ESM in the new EXP700 enclosure to port OUT 

of the right ESM in the top EXP700 enclosure. 
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Figure 29. Connect the new EXP700 enclosure to the OUT  port of the right ESM in the top 

EXP700 enclosure
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�1�: Connect port IN of the right ESM in the bottom of the EXP700 enclosure to 

port OUT of the right ESM in the new EXP700 enclosure, instead of port OUT of 

the right ESM in the top EXP700 enclosure. 

�2�: Connect port IN of the right ESM in the new EXP700 enclosure to port OUT 

of the right ESM in the top EXP700 enclosure. 

�3�: Connect port OUT of the left ESM in the top EXP700 enclosure to port IN of 

the left ESM in the new EXP700 enclosure, instead of port IN of the left ESM in the 

bottom EXP700 enclosure. 
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Figure 30. Connect the top EXP700 enclosure to the IN port of the left ESM in the new 

EXP700 enclosure
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�1�: Connect port IN of the right ESM in the bottom EXP700 enclosure to port 

OUT of the right ESM in the new EXP700 enclosure, instead of port OUT of the 

right ESM in the top EXP700 enclosure. 

�2�: Connect port IN of the right ESM in the new EXP700 enclosure to port OUT 

of the right ESM in the top EXP700 enclosure. 

�3�: Connect port OUT of the left ESM in the top EXP700 enclosure to port IN of 

the left ESM of the new EXP700 enclosure, instead of port IN of the left ESM in the 

bottom EXP700 enclosure. 

�4�: Connect port OUT of the left ESM in the new EXP700 enclosure to port IN of 

the left ESM in the bottom EXP700 enclosure. 
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Figure 31. Connect the new EXP700 enclosure to the IN port of the left ESM in the bottom 

EXP700 enclosure
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To cable the EXP810 between EXP810 enclosures in the drive loop perform the 

“Connecting storage expansion enclosures in the middle of a drive loop” on page 

85 with steps 2, 3, 6, and 7 being replaced by steps 1, 2, 3, and 4, seen immediately 

below. 

__ Step 1.   �1�: Connect port 1A of the B ESM in the bottom EXP810 enclosure, to 

port 1B of the B ESM in the new EXP810 enclosure, rather than to port 

1B of the B ESM in the top EXP810 enclosure. 
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Figure 32. Cabling the EXP810 between EXP810 enclosures in the drive loop: example 1
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__ Step 2.   �2�: Connect port 1A of the B ESM in the new EXP810 enclosure, to 

port 1B of the B ESM in the top EXP810 enclosure. 

__ Step 3.   �3�: Connect port 1A of the A ESM in the top EXP810 enclosure, to 

port 1B of the A ESM in the new EXP810 enclosure, rather than to port 

1B of A ESM in the bottom EXP810 enclosure. 

__ Step 4.   �4�: Connect port 1A of the A ESM in the new EXP810 enclosure, to 

port 1B of the A ESM in the bottom EXP810 enclosure.
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�1�: Connect port IN of the right/B ESM in the bottom EXP100 enclosure to port 

1B of the B ESM in the new EXP810 enclosure, instead of port OUT of the right/B 

ESM in the top EXP710 enclosure. 

�2�: Connect port 1A of the B ESM in the new EXP810 enclosure to port OUT of 

the right/B ESM in the top EXP710 enclosure. 
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Figure 33. Cabling the EXP810 between EXP810 enclosures in the drive loop: example 2
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�3�: Connect port OUT of the left/A ESM in the top EXP710 enclosure to port 1B 

of the A ESM in the new EXP810 enclosure, instead of port IN of the left/A ESM 

in the bottom EXP100 enclosure. 

Connecting storage expansion enclosures at the beginning of 

(top of) a drive loop 

It is possible to add storage expansion enclosures to either the beginning (top) or 

end (bottom) of a functioning storage expansion enclosure drive loop. The cabling 

instructions illustrated in Figure 34 on page 97, Figure 35 on page 98, and Figure 36 

on page 99 describe cabling a DS4000 EXP700 Storage Expansion Enclosure to the 

beginning (top) of a redundant drive loop of a functioning DS4300 Storage 

Subsystem (model 60X or 60U). IBM does not recommend that you add storage 

expansion enclosures in this manner, especially if there is insufficient rack space to 

allow the methodical, uncluttered, and uniform Fibre Channel cabling of such new 

enclosures. Without proper planning, disadvantages of adding expansion 

enclosures in this manner include cable management issues that contribute to 

avoidable troubleshooting difficulties. (For the diagram of a properly planned 

addition of a new expansion enclosure at the beginning (top) of a functioning 

storage expansion enclosure drive loop, see Figure 40 on page 105.) 

To add a 16-drive expansion enclosure—for example, an EXP810 or EXP420 to the 

DS4000 subsystem configuration—you basically follow the same steps as in adding 

the 14-drive enclosure to a DS4000 subsystem configuration; however, the port 

connections on the 16-drive enclosure will be different, as illustrated in Figure 27 

on page 85 and the three steps that follow it. 

See “DS4000 Storage Subsystem drive loop schemes” on page 26. 

__ Step 1.   Insert the small form-factor pluggables (SFPs) or gigabit interface 

converters (GBICs) into only those ports you intend to use. Do not 

leave GBICs or SFPs inserted into port slots without connecting them 

to other ports using cables. 

__ Step 2.   Extend one of the drive loops (that is, drive loop B) in a DS4000 

Storage Subsystem redundant drive loop pair by connecting the IN port 

of the first (existing) storage expansion enclosure to the OUT port of the 

new storage expansion enclosure as shown in Figure 34 on page 97.

Note:  The port name on an EXP810 is not labeled OUT. SeeFigure 37 on 

page 100 for details.

 Attention:  Carefully reconfigure only one drive loop at a time, 

making sure that the drive loop that you modify is properly connected 

and in optimal state before you attempt to reconfigure another drive 

loop. Take this precaution to prevent the arrays from being 

inadvertently failed by the DS4000 Storage Subsystem controllers. This 

happens when two or more drives in the arrays cannot be reached 

through either drive loop in the redundant drive loop pair. 

__ Step 3.   Power on the newly added storage expansion enclosure unit. 

__ Step 4.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop B, now extended to the new storage expansion enclosure, 

are not lit. Using the DS4000 Storage Manager Client Subsystem 

Management window, verify that the new storage expansion enclosure 

is added and displayed in the Logical/Physical view of the window. 

Correct any errors before proceeding to step 5 on page 96. For port 

bypass: 
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__ a.   Verify that the SFPs and GBICs or fibre cables are in good 

condition. 

__ b.   Remove and reinsert SFPs, GBICs and fibre cables. 

__ c.   Ensure that the new drive expansion enclosure speed switch is 

set to the same speed as the existing drive expansion enclosures 

and the DS4000 Storage Subsystem speed setting. 

__ d.   Verify that the ESM is good by physically removing and 

swapping it with the other ESM in the same drive expansion 

enclosure. For enclosure ID conflict, set the drive expansion 

enclosure ID switch to values unique from the current settings in 

the existing drive expansion enclosures and storage server.

Call  the IBM Help Center for assistance if the problems persist. 

__ Step 5.   In the other drive loop (that is, drive loop A) in a DS4000 Storage 

Subsystem redundant drive loop pair, remove the connection from the 

DS4000 Storage Subsystem drive loop port to the IN port of the first 

storage expansion enclosure and connect it to the IN port of the new 

drive enclosure as shown in Figure 35 on page 98.

Note:  The port name on an EXP810 is not labeled IN. See Figure 37 on 

page 100 for details. 

__ Step 6.   Wait a few seconds; verify that the port bypass LEDs of the two ports 

in the connection between the storage subsystem drive loop port and 

the IN port of the new drive enclosure are not lit. Using the DS4000 

Storage Manager Client Subsystem Management window, verify that 

the new drive enclosure does not indicate the drive enclosure lost 

redundancy path error. See the preceding step 5 for possible corrective 

actions, if needed. Until you establish the Fibre Channel cabling 

connection described in step 4 on page 95, the existing storage 

expansion enclosures will appear in the Storage Manager Client 

Subsystem Management window with drive enclosure lost 

redundancy path errors. 

__ Step 7.   In drive loop A, cable the new drive enclosure’s OUT port to the IN port 

of the first enclosure in the already functioning storage expansion 

enclosure drive loop as shown in Figure 36 on page 99. 

__ Step 8.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop A to which you have added a new connection are not lit. 

Using the DS4000 Storage Manager Client Subsystem Management 

window, verify that all of the drive enclosures in the DS4000 redundant 

drive loop pair to which the new enclosure was added does not report 

the drive enclosure lost redundancy path error. 

__ Step 9.    Proceed to “Activity 7: Disabling DS4000 Storage Subsystem drive 

migration settings (for adding storage expansion enclosures with new 

drives only)” on page 101, if you are only adding an enclosure with a 

new drive. Proceed to “Activity 10: Inserting hard drives and placing 

logical drives online (for migrating only enclosures with drives 

containing logical drive configuration data)” on page 111,  if you are 

migrating enclosures with drives having logical drive configuration 

data.
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To add an EXP810 to the top of a functioning drive channel, perform the procedure 

in “Connecting storage expansion enclosures at the beginning of (top of) a drive 

loop” on page 95, replacing steps 2, 5, and 7, with steps 1–3, below: 

__ Step 1.   Connect port 1A of the B ESM in the existing EXP810 to port 1B of the 

B ESM in the new EXP810. 

__ Step 2.   Move the existing connection from port 1B of the A ESM in the existing 

EXP810 to port 1B of the A ESM in the new EXP810. 

__ Step 3.   Connect port 1B of the A ESM in the existing EXP810 to port 1A of the 

A ESM in the new EXP810.

  

Figure 37. Cabling an EXP810 to the top of a functioning drive loop
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Activity 7: Disabling DS4000 Storage Subsystem drive 

migration settings (for adding storage expansion enclosures 

with new drives only) 

Attention:  Do not perform this activity if you want to migrate enclosures with 

drives having logical drive configuration and data; otherwise, the logical drive 

configuration will be deleted. 

When you have completed cabling the new storage expansion enclosures, disable 

DS4000 Storage Subsystem drive migration settings as follows: 

__ Step 1.   Open the Storage Manager Client program Enterprise Management 

window. 

__ Step 2.   Right-click on the name of the DS4000 Storage Subsystem to which you 

want to add drives, and select Execute Script. 

__ Step 3.   A script editor window opens. Click File -> Load Script. 

__ Step 4.   A Load Script file selection window opens. Locate and select the 

DisableDriveMigration.scr file and click OK. The file 

DisableDriveMigration.scr file is normally in the SCRIPTS directory of 

the IBM DS4000 Storage Manager Installation CD. This file is used to 

reset the DS4000 Storage Subsystem setting, in order to treat all 

newly-discovered hard drives as “new” drives, and to ignore any 

configuration information that might exist in the new hard drives. 

Figure 16 on page 60 contains the DisableDriveMigration.scr file listing. 

__ Step 5.   Click Tools -> Verify and Execute to run the script. 

__ Step 6.   When the script execution completes, reset both DS4000 controllers to 

make the disable drive migration settings effective. If you used the 

DisableDriveMigration.scr file described in this document in Figure 16 

on page 60, you do not need to perform this step because the last two 

commands in the script file automatically reset the controllers. To reset 

the controllers, open the Storage Subsystem Management window and 

alternately (one at a time) reset each controller by clicking Advanced -> 

Reset Controller and following the instructions in the Reset Controller 

window when it opens.

Activity 8: Inserting drives and cabling additional storage 

expansion enclosures 

This activity is only for adding enclosures with new drives. 

__ Step 1.   After you have disabled DS4000 Storage Subsystem drive migration 

settings, insert drives and connect additional storage expansion 

enclosures to complete the installation process as follows: 

__ Step 2.   Insert the appropriate drives into empty drive slots in the new 

enclosure in pairs (two at a time). Wait (up to 5 minutes) until the 

inserted drive pair fully spins up and displays in the DS4000 Storage 

Subsystem Management window before inserting the next drive pair. 

__ Step 3.   To connect additional storage expansion enclosures to a functioning 

drive loop pair, repeat the steps of the appropriate procedure in 

Activity 6; depending on whether you are adding new storage 

expansion enclosures to the end (bottom), the middle, or the beginning 

(top) of the drive loop, follow with steps 1 and 2 of this activity 

(“Activity 8: Inserting drives and cabling additional storage expansion 

enclosures”): 
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Figure 38 on page 103 shows the final cabling diagram after adding the 

second 14-drive enclosure (an EXP700) to the end of a drive 

loop/channel. Figure 39 on page 104 and Figure 40 on page 105 show 

the final results of adding the second 14-drive enclosure (an EXP700) to 

the beginning of the drive loop. Figure 40 on page 105 is the preferred 

scheme for cabling to the beginning of the drive loop, if the 

configuration and rack space allow for it. Figure 41 on page 106 

illustrates what the cabling will look like as a result of adding the 

second 14-drive enclosure to the middle of a drive loop. 

Figure 42 on page 107, Figure 43 on page 108, and Figure 44 on page 

109, respectively, illustrate the cabling after adding the second EXP810 

to the end, beginning, or middle of a drive loop/channel. 

Figure 45 on page 110 illustrates adding the second EXP810 between 

EXP710 and EXP10 enclosures in the same drive loop/channel. 

When you have completed adding enclosures, proceed to Activity 9: 

Re-enabling drive migration settings step1 on page 111,  to re-enable the 

drive migration settings.
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Figure 38. Cabling a second drive enclosure to the end of a functioning drive loop
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Figure 43. Cabling a second EXP810 drive enclosure to the top of a functioning drive loop
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Activity 9: Re-enabling drive migration settings 

If you performed steps 1 on page 101 through 6 on page 101 of Activity 7: 

Disabling DS4000 Storage Subsystem drive migration settings (for adding storage 

expansion enclosures with new drives only) to disable DS4000 Storage Subsystem 

… to DS4000 storage subsystem drive ports ...
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added

Top
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New
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0 0

0 0
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Figure 45. Cabling the second EXP810 between EXP710 and EXP10 enclosures in the same 

drive loop/channel
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drive migration settings, perform the following steps 1 through 6 to re-enable the 

drive migration settings. If you should ever momentarily remove a drive from the 

DS4000 Storage Subsystem, the storage subsystem clears its configuration data 

when it later recognize it. When this happens, the drive displays as unconfigured. 

Attention: In order to prevent data loss, set the DS4000 Storage Subsystem drive 

migration setting to enable after you complete the hard drive addition process. 

__ Step 1.   Open the Storage Manager Client program Enterprise Management 

window. 

__ Step 2.   Right-click on the name of the DS4000 Storage Subsystem to which you 

want to add drives and click Execute Script. 

__ Step 3.   A script editor window opens. Click File -> Load Script. 

__ Step 4.   A Load Script file selection window opens. Locate and select the 

EnableDriveMigration.scr file and click OK. The file 

EnableDriveMigration.scr file is normally in the SCRIPTS directory of 

the IBM DS4000 Storage Manager Installation CD. Use this file to reset 

the DS4000 Storage Subsystem setting in order to check for any 

configuration data that might exist on the newly discovered hard 

drives. 

__ Step 5.   Click Tools -> Verify and Execute to run the script. 

__ Step 6.   When the script execution completes, reset both DS4000 controllers to 

make the setting effective. 

If you use the EnableDriveMigration.scr script associated with this 

document and described in Figure 15 on page 59, it is not necessary for 

you to perform this step because the last two commands in that script 

file automatically reset the controllers. To reset the controllers, open the 

Storage Subsystem Management window and alternately (one at a 

time) reset each controller by clicking Advanced -> Reset Controller 

and following the instructions in the Reset Controller window when it 

opens. 

__ Step 7.   Verify (and update, if needed) the DS4000 Storage Expansion Enclosure 

ESM firmware and drive firmware with the latest version from the 

following IBM DS4000 support web site. 

www-1.ibm.com/servers/storage/support/disk/ 

Result: You have completed the procedure for adding enclosures. The newly 

added drives are now ready for you to configure and map to host servers. 

Note:  Listings of the EnableDriveMigration.scr and DisableDriveMigration.scr 

files are found in Figure 15 on page 59 and Figure 16 on page 60. 

Activity 10: Inserting hard drives and placing logical drives 

online (for migrating only enclosures with drives containing 

logical drive configuration data) 

Note:  When migrating hard drives from multiple DS4000 Storage Subsystems to a 

single DS4000 Storage Subsystem, move all of the hard drives from the first 

DS4000 Storage Subsystem as an independent “set” to the destination 

DS4000 Storage Subsystem. Before moving hard drives as a set from 

subsequent DS4000 Storage Subsystems, ensure that all of the hard drives 

from the previous set have been successfully transferred to the destination 

DS4000 Storage Subsystem. If you do not transfer hard drives as “sets” to 
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the destination DS4000 Storage Subsystem, the newly relocated array may 

not appear in the Subsystem Management window. 

__ Step 1.   For each additional enclosure that you intend to migrate to the 

functioning drive loop pair, perform Activity 5: Installing and setting 

storage expansion unit IDs and speeds step 1 on page 76 through step 

3 on page 77, Activity 6: Cabling, powering on, and verifying storage 

expansion unit operation step 1 on page 80 through step 4 on page 80. 

Figure 38 on page 103 shows the final cabling diagram after adding the 

second 14-drive enclosure (an EXP700) to the end of a drive 

loop/channel. Figure 39 on page 104 and Figure 40 on page 105 show 

the final results of adding the second 14-drive enclosure (an EXP700) to 

the beginning of the drive loop. Figure 40 on page 105 is the preferred 

scheme for cabling to the beginning of the drive loop, if the 

configuration and rack space allow for it. Figure 41 on page 106 

illustrates what the cabling will look like as a result of adding the 

second 14-drive enclosure to the middle of a drive loop. 

Figure 42 on page 107, Figure 43 on page 108, and Figure 44 on page 

109, respectively, illustrate the cabling after adding the second EXP810 

to the end, beginning, or middle of a drive loop/channel. 

Figure 45 on page 110 illustrates adding the second EXP810 between 

EXP710 and EXP10 enclosures in the same drive loop/channel. When 

you have completed adding enclosures, proceed to step 2. 

__ Step 2.   Insert the drives into the empty drive slots in the new enclosure, one at 

a time. Wait (up to 5 minutes) until each drive pair has fully spun up 

and displayed in the DS4000 Storage Subsystem Management window 

before inserting the next drive pair. 

__ Step 3.   As the DS4000 Storage Subsystem recognizes the drives, it reads and 

displays the array and logical drive information on the drives in the 

Logical/Physical view of the DS4000 Storage Subsystem Management 

window. The storage subsystem places the array in offline state until 

it recognizes that you have inserted all of the drives that comprise the 

array. 

__ Step 4.   Once you insert all of the drives and the DS4000 Storage Subsystem 

recognizes them, change the state of the arrays or logical drives to the 

online state by right-clicking on the array name in the Storage 

Subsystem window and clicking Place -> Online. 

If any of the following conditions persist, contact the IBM Help Center 

in your geography for assistance. 

__    The empty drive slot icon ( 

  

) displayed for the drive slot into 

which you inserted the migrating drive. 

__    The Failed unconfigured drive icon ( 

  

) or the Failed 

configured drive icon ( 

  

) displayed for the drive slot into 

which you inserted the migrating drive. 

__    Array configuration data on the drives you have added is 

incomplete. 

__    You cannot bring the array online.

Attention: Do not initialize a drive that you want to keep (by 

right-clicking its icon and selecting Initialize from the pull-down 

menu) if it contains configuration or user data. Initializing any of the 

drives in a defined array causes all hard drives that comprise an array 
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to return to the Unconfigured Capacity storage pool, deleting their 

array definitions from the DS4000 Storage Subsystem configuration. 

The user data on such drives is lost. 

Result: Once the arrays are online, they are ready for you to configure 

and map to host servers. You might also then recreate flashcopies and 

remote mirror relationships. 

__ Step 5.   Use the DS4000 Storage Manager program to view the storage 

partitioning definitions and make any necessary corrections. 

__ Step 6.   The DS4000 Storage Subsystem that the drives are migrated from will 

display the logical drives that are defined in these drives as “missing 

LUNs.” In order to remove these “missing LUNs” entries, right-click on 

each entry and select Delete from the pull-down menu. 

You have completed the procedure for migrating enclosures. 
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Chapter  5.  Upgrading  a storage  subsystem  in  a functioning  

configuration  

Note:  When migrating hard drives from multiple DS4000 Storage Subsystems to a 

single DS4000 Storage Subsystem, move all of the hard drives from the first 

DS4000 Storage Subsystem as an independent set to the destination DS4000 

Storage Subsystem. Before moving hard drives as a set from subsequent 

DS4000 Storage Subsystems, ensure that all of the hard drives from the 

previous set have been successfully transferred to the destination DS4000 

Storage Subsystem. If you do not transfer hard drives as sets to the 

destination DS4000 Storage Subsystem, the newly relocated arrays/logical 

drives that are defined in these drives might not appear in the Subsystem 

Management window. 

This procedure details the steps that are required to upgrade a DS4000 Storage 

Subsystem in a functioning DS4000 configuration. Where either an identical or 

newer DS4000 Storage Subsystem model is involved, this upgrade involves only 

the replacement of the DS4000 storage controller to be upgraded. DS4000 storage 

expansion enclosures that had been attached to drives containing configuration 

data will be connected to the new DS4000 Storage Subsystem. The upgraded 

(original) DS4000 Storage Subsystem being replaced will be either scrapped or 

returned to operation (redeployed) at a later date with new drives and/or new 

storage expansion enclosures. 

Table 21 on page 117 associates each DS4000 Storage Subsystem with its supported 

replacements. 

 Important:  

 IBM Support is available to supply assistance and guidance to those who choose to 

upgrade a DS4000 Storage Subsystem. 

Preliminary considerations: Storage Subsystem upgrade 

While upgrading a DS4000 Storage Subsystem in a functioning configuration, 

remain aware of these important considerations: 

v   Observe proper ESD handling procedures when handling electronic equipment. 

See “Handling static-sensitive devices” on page 54 for additional information. 

v   IBM assigns premium feature entitlements only to specific DS4000 Storage 

Subsystems. In order to enable premium features in a replacement DS4000 

Storage Subsystem configuration that had been enabled in an original DS4000 

Storage Subsystem configuration, you must purchase appropriate entitlements 

for the replacement DS4000 Storage Subsystem. In addition, IBM assigns host 

kits only to specific DS4000 Storage Subsystems. You must also purchase the 

appropriate host kits for new DS4000 Storage Subsystems. 

v   See the appropriate DS4000 Storage Controller’s Installation and User’s Guide for 

information on the proper power on and power off sequences.

Note:  The remainder of this topic pertains to the original DS4000 Storage 

Subsystem that is designated for replacement as either the original or old 

DS4000 Storage Subsystem.
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This task requires that you shut down the DS4000 Storage Subsystem 

configuration. In addition, after the upgrade, premium features previously enabled 

in the original DS4000 Storage Subsystem along with the enable-by-default 

premium features in the new DS4000 Storage Subsystem will automatically be 

placed in Out-of-Compliance state. Full data availability is retained, but you must 

generate new premium feature SAFE keys in order to re-enable premium features. 

Because IBM assigns premium feature entitlements only to specific DS4000 Storage 

Subsystems, you must purchase the appropriate entitlement for the new DS4000 

Storage Subsystem. You can generate new SAFE keys by contacting the IBM Help 

Center. Be sure to have the necessary proof of purchase. Alternately, you can also 

generate new SAFE keys by using instructions located at the following Web site: 

www.storage.ibm.com/pfeatures.html/ 

The new DS4000 Storage Subsystem controller identifies itself using a new 

Worldwide Name (WWN)  that is different from the WWN  used by the original 

DS4000 Storage Subsystem controller. For this reason, additional tasks might be 

required after the upgrade for any host applications or drivers that rely on the 

WWNs  to identify logical drives defined in a given DS4000 Storage Subsystem. See 

your application program’s documentation, your driver’s user guide, or related 

documentation for detailed instructions on how to update the WWN  of the DS4000 

Storage Subsystem in the application or driver. Additionally, review the readme file 

and the related IBM System Storage DS4000 Storage Manager Installation and Support 

Guide for information about any preparation tasks required in addition or 

operating system-specific restrictions. IBM System Storage DS4000 Storage Manager 

installation and support guides are located at the following Web site: 

www.ibm.com/servers/storage/support/disk/ 

 Attention:  Depending on your existing DS4000 Storage Subsystem configuration, 

you might not be able to migrate all of your drives and storage expansion 

enclosures to a new DS4000 Storage Subsystem configuration. For example, you 

cannot migrate 1 Gbps EXP500 drive expansion enclosures from a FAStT500 

Storage Subsystem to a DS4300 Storage Subsystem or you cannot migrate a EXP700 

drive expansion enclosures to the DS4800 Storage Subsystem before upgrading 

them to EXP710 drive expansion enclosures first. See Table 4 on page 6 and 

Table 21 on page 117 for additional information on DS4000 Storage Subsystem and 

storage expansion enclosure compatibility. 

Contact your IBM reseller or representative if you have questions regarding the 

compatibility of drives and drive expansion enclosures in an existing DS4000 

Storage Subsystem configuration with a new DS4000 Storage Subsystem 

configuration. 

If you are planning to consolidate drive expansion enclosures from multiple 

DS4000 Storage Subsystem configurations into a single configuration with a new 

DS4000 Storage Subsystem, perform the DS4000 Storage Subsystem replacement 

using drive expansion enclosures (and drives) from a given DS4000 Storage 

Subsystem configuration first. After the DS4000 Storage Subsystem migration has 

been successfully completed, use the procedure describe in Chapter 6 to migrate 

the drive expansion enclosures from the rest of the DS4000 Storage Subsystem 

configurations to the new DS4000 Storage Subsystem. 

Table 21 on page 117 associates each DS4000 Storage Subsystem with its supported 

replacements. Select View -> Rotate View -> Clockwise to optimize the 

appearance of this chart.
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Note:  If you are migrating from the FAStT200 or FAStT500, see Table 22.

 Table 22. Legacy (FAStT200 / FAStT500) storage subsystems by their supported 

replacements 

Supported replacement DS4000 Storage Subsystem 

DS4000 Storage 

Subsystem
1, 3 

FAStT200 FAStT500
2 

FAStT200 U U 

FAStT500
2 

U 

DS4400 U 

DS4500 U 

1.   IBM does not currently support replacement of SATA or Fibre Channel controllers with 

one another. Contact your IBM support representative for assistance with this issue 

should the need arise. 

2.   Set the DS4000 EXP700 storage expansion enclosure’s speed switch to 1 Gbps when 

migrating from 2 Gbps configurations to a FAStT500 Storage Subsystem 1 Gbps 

configuration. 

3.   Migrating from a configuration with an integrated drive/RAID controller DS4000 

storage subsystem, to the one with the RAID controller only DS4000 storage subsystem, 

will require an additional storage expansion enclosure for the drives that are installed 

inside the integrated drive/RAID controller DS4000 storage subsystem chassis.
  

Preliminary considerations: Firmware behavior during subsystem 

upgrade 

This section describes technical considerations regarding basic DS4000 Storage 

Subsystem controller firmware behavior during a DS4000 Storage Subsystem 

upgrade. It covers firmware behavior during system upgrade, where a new DS4000 

Storage Subsystem connects to functioning drives and storage expansion 

enclosures, as well as firmware behavior during system redeployment, where the 

original (old) DS4000 Storage Subsystem serves as a logically distinct entity, 

optionally, using some of the drives from the original system. 

DS4000 configuration behavior after upgrade and DS4000 

Storage Subsystem replacement 

The new DS4000 Storage Subsystem that powers up in a functioning storage 

expansion enclosure configuration as part of the DS4000 Storage Subsystem 

upgrade process impacts the following areas of the DS4000 Storage Subsystem 

identification and premium features: 

1.   Worldwide Name (WWN): 

The worldwide names that were used by the original DS4000 Storage 

Subsystem prior to the upgrade are not returned when the upgrade is 

complete. Rather, the new DS4000 Storage Subsystem begins to advertise itself 

using WWNs  that are based on an embedded unique identifier from its 

controller blades. This statement applies to both the port WWNs  and the node 

WWNs. Consequently, any hosts that were aware of the logical drives in the 

original DS4000 Storage Subsystem based on the original DS4000 Storage 

Subsystem’s WWN  values will likely be confused. The data volumes that 

resided behind the previously known WWNs  now reside behind a seemingly 

new device with different WWNs. 
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2.   Storage Array Identifier (SAI or SA Identifier): 

The storage array identifier, or SA Identifier, is the identification value used by 

the DS4000 Storage Manager host software (SMclient) to uniquely identify 

managed storage subsystems. The DS4000 Storage Manager SMclient program 

maintains SA Identifier records of previously discovered storage subsystems in 

the host resident file, which allows it to retain discovery information in a 

persistent fashion. This identifier is stored on DACstore, and persists across 

reboots, power cycles, and so on. The new DS4000 Storage Subsystem that 

powers up in a functioning storage expansion enclosure configuration as part 

of the DS4000 Storage Subsystem upgrade process continues to use the SA 

Identifier of the original DS4000 Storage Subsystem. 

3.   SAFE Premium Feature Identifier (SAFE ID) and Premium Feature Enable 

Status: 

The new DS4000 Storage Subsystem retains the SAFE ID of the original DS4000 

Storage Subsystem. It also retains all of the features previously enabled on the 

original DS4000 Storage Subsystem. The feature states, however, are set to the 

Out-of-Compliance state. As a result, the system sends alert notices and 

establishes a Needs Attention condition. Also, any features that are marked in 

the new controller’s NVSRAM for automatic enablement are enabled, though 

their feature states are also set to Out-of-Compliance. You must re-enable the 

premium features by using premium feature SAFE key files. Because IBM 

assigns premium feature entitlements only to specific DS4000 Storage 

Subsystems, you must purchase the appropriate entitlements for the new 

DS4000 Storage Subsystem to enable all of the premium features previously 

enabled on the original DS4000 Storage Subsystem.

Redeployed DS4000 configuration behavior in an original 

(replaced) DS4000 Storage Subsystem 

 Important:  

 IBM Support is available to supply assistance and guidance to those who choose to 

redeploy a replaced DS4000 Storage Subsystem. 

 When you redeploy DS4000 Storage Subsystem hardware in another DS4000 

Storage Subsystem’s configuration, identification and premium features of the 

redeployed system behave somewhat differently from information described in 

“DS4000 configuration behavior after upgrade and DS4000 Storage Subsystem 

replacement” on page 119. This section describes those relevant behavioral 

differences. 

v   Worldwide Name (WWN): 

The worldwide names that were used by the original DS4000 Storage Subsystem 

are retained on the redeployed system. These values are based on an embedded 

unique identifier from the original DS4000 Storage Subsystem controller blades, 

and are stored in the NVSRAM on each controller board within the controller 

blade. Assuming that both controllers remain fully optimal after the 

redeployment, they recognize the stored value and continue to use it. 

Consequently, any hosts that were aware of the original DS4000 Storage 

Subsystem, based on its WWN  values, will likely be confused. The logical drives 

that used to reside behind the previously-known WWNs  no longer reside there, 

because they are now part of the new DS4000 Storage Subsystem, which has a 

different WWN.  

v   Storage Array Identifier or SA Identifier: 
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If you return one or more drives that were originally moved from a DS4000 

Storage Subsystem back to the original DS4000 Storage Subsystem configuration 

before it is redeployed, it is possible that the SA Identifier that was used on the 

original DS4000 Storage Subsystem system will also be reused in the redeployed 

DS4000 Storage Subsystem configuration. Whether this occurs depends on the 

specific selection of transported drives. If certain conditions are met, however, 

the redeployed unit adopts the same SA Identifier that was retained by the new 

DS4000 Storage Subsystem. Otherwise, or in cases in which only new drives are 

used in the redeployed configuration, the redeployed DS4000 Storage Subsystem 

generates a new (and unique) SA Identifier that does not conflict with the one 

that was retained by the upgraded unit. 

If both the new and the redeployed DS4000 Storage Subsystem have the same 

SA Identifier, serious problems will result when you start the DS4000 Storage 

Manager SMclient program. Since there will be two DS4000 Storage Subsystems 

with the same SA Identifier, the DS4000 Storage Manager SMclient program will 

respond by arbitrarily selecting either the new or the redeployed DS4000 Storage 

Subsystem. The storage subsystem that the DS4000 Storage Manager SMclient 

program arbitrarily selects will be manageable, and the other storage subsystem 

will be unmanageable. 

v   SAFE Premium Feature Identifier (SAFE ID) 

Premium Feature Enable status: 

If you return any drives from an original DS4000 Storage Subsystem, along with 

the original DS4000 Storage Subsystem controllers, to a redeployed DS4000 

configuration, the SAFE ID of the original DS4000 Storage Subsystem will be 

retained, and all enabled features will remain fully enabled and compliant. 

If you do not move any drives from an original DS4000 Storage Subsystem, it 

generates a new SAFE ID when redeployed, enabling none of the premium 

features from the original system. This new SAFE ID prevents the system from 

using any previously-acquired SAFE key files and re-enabling any premium 

features. In cases where the original DS4000 Storage Subsystem was pre-loaded 

with NVSRAM codes to enable certain premium features, NVSRAM codes are 

cleared from the DS4000 Storage Subsystem when redeployed and powered on 

for the first time. Therefore, premium features that were enabled as standard 

features do not reactivate on the redeployed system. The system retains full data 

availability, but you must generate new premium feature SAFE keys in order to 

re-enable premium features. You can generate new SAFE keys by contacting the 

IBM Help Center in your geography. Be sure to have the necessary proof of 

purchase. Alternately, you can also generate new SAFE keys by using 

instructions located at the following Web site: 

www.storage.ibm.com/pfeatures.html/ 

v   Controller IP addresses: 

When the DS4000 Storage Subsystem controllers were assigned static IP 

addresses, the IP addresses were stored in the NVSRAM of the controller board 

as well as the DACstore on the disks. If the new (replacement) DS4000 Storage 

Subsystem controllers were assigned the same IP addresses as the original 

(replaced) DS4000 Storage Subsystem controllers, network problem will arise 

when the original (replaced) DS4000 Storage Subsystem is eventually 

redeployed. The problem will occur because two devices have the same IP 

address in the Ethernet network. The best practice is to assign new unique IP 

addresses to new (replacement) DS4000 Storage Subsystem controllers instead of 

using the same IP addresses as the DS4000 controllers that they replace.
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Upgrading storage subsystems in functioning DS4000 configurations 

Before you perform the following upgrade procedure, review and perform the 

steps detailed in Chapter 2, “Prerequisites to adding capacity and hard drive 

migration,” on page 41. 

Complete the following activities to upgrade your DS4000 Storage Subsystem: 

Activity 1: Preliminary activities 

Perform the following steps before you disconnect storage expansion enclosures 

from an original DS4000 Storage Subsystem that is being replaced to ensure a 

successful DS4000 Storage Subsystem upgrade. 

__ Step  1.   Verify that the original DS4000 Storage Subsystem’s controller 

firmware and NVSRAM are at the levels shown in Table 19 on page 

45. 

__ Step  2.   Verify that the firmware of the ESMs in the storage expansion 

enclosures is at the levels shown in Table 20 on page 48. 

__ Step  3.   Disable or delete any flashcopies of the logical drives. 

__ Step  4.   Delete any remote mirror relationships. 

__ Step  5.   If the arrays (logical drives) are not in optimal state, perform the steps 

necessary to bring the arrays (logical drives) into their optimal state 

before you attempt their migration. See the DS4000 Problem 

Determination Guide associated with your particular DS4000 hardware 

model or “Bringing storage subsystems and drive loops into optimal 

state” on page 52 for additional information on how to make this 

determination. 

__ Step  6.   If the drive enclosures are not in optimal state, perform the steps 

necessary to bring them to optimal state before attempting migration. 

Perform the following steps to verify that the drive loops are in 

optimal state: 

__ Step a.   Physically trace the actual cable connections making sure 

that connections are properly modified and that the cable 

connectors are firmly inserted into the SFPs or GBICs. 

__ Step b.   Verify that the following LEDs are not lit or briefly flashed 

in the modified drive loop: 

v   ESM fault 

v   port bypass 

v   ID conflict
__ Step c.   Verify that the controller drive loop LED remains lit. If the 

controller drive loop LED becomes unlit momentary, there 

are problems in the drive loop and the LIPs are generated 

by the DS4000 Storage Subsystem controller. 

__ Step d.   In the DS4000 Storage Manager Client Subsystem 

Management window, verify that there are no loss of ESM 

path redundancy errors in the drives expansion enclosures 

that are not migrated. 

Do not modify the second drive loop in a redundant drive 

loop pair until you are sure that the first modified drive 

loop is operating optimally. See the DS4000 Problem 

Determination Guide associated with your particular 

DS4000 hardware model or “Bringing storage subsystems 
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and drive loops into optimal state” on page 52 for 

additional information on how to make this 

determination.
__ Step  7.   Perform a full backup of the original DS4000 Storage Subsystem and 

schedule it for down time. This is necessary because you must power 

down the DS4000 Storage Subsystem configuration during the 

upgrade procedure. 

__ Step  8.   Save the DS4000 Storage Subsystem profile of the original DS4000 

Storage Subsystem configuration in a location other than that in 

which the logical drives are defined in the original DS4000 Storage 

Subsystem configuration. 

__ Step  9.   Stop all programs, services or processes in the host servers that access 

the logical drives defined in the migrated hard drives. Ensure that 

there are not any running background programs, services or processes 

that write data to the logical drives. (For example, Microsoft MSCS 

service periodically writes to the “Quorum” disk.) 

__ Step 10.   Unmount the file systems to flush I/O from the server cache to disks. 

Notes:  

a.   In a Microsoft Windows environment, remove the drive letter or 

the mount points of the mapped LUNs instead of unmounting the 

file systems. 

b.   Consult documentation associated with your particular operating 

system for detailed information regarding the Unmount procedure.
__ Step 11.   Place the arrays defined on the DS4000 Storage Subsystem in offline 

state. In the Storage Subsystem Management window, right-click on 

the name of the array and select Place -> Offline. 

__ Step 12.   Retrieve proofs of purchase for both the original and new DS4000 

Storage Subsystems and for the additional premium feature 

entitlements on the new and original DS4000 Storage Subsystems. 

IBM support personnel will require this information to regenerate 

premium feature SAFE key files that were enabled in the original 

DS4000 Storage Subsystem for use on the new DS4000 Storage 

Subsystem.

Activity 2: Powering off the original DS4000 Storage 

Subsystem 

Power down the original DS4000 Storage Subsystem and remove it from the 

DS4000 configuration. Do not redeploy this DS4000 Storage Subsystem in the same 

management domain as its upgrade (replacement) DS4000 Storage Subsystem until 

you regenerate its SA identifier using the instructions in “Redeploying the original 

(replaced) DS4000 Storage Subsystem” on page 126.

Note:  See the appropriate DS4000 Storage Controller’s Installation and User’s Guide 

for details on the correct power off sequence. 

Activity 3: Installing new DS4000 Storage Subsystems and 

setting minihub speed 

Install the new DS4000 Storage Subsystem. For DS4400 and DS4500 storage servers, 

set the drive minihub speed switch to the speed of the storage expansion enclosure 

ports to which they are connected. 
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Note:  The DS4300 drive loop port operates only at 2 Gbps. If you migrate storage 

expansion enclosures from a 1 Gbps Fibre Channel environment to a 2 Gbps 

Fibre Channel environment, do not automatically change the storage 

expansion enclosure speed settings from 1 Gbps to 2 Gbps. Before you do, 

verify that each Fibre Channel drive involved is capable of 2 Gbps operation 

and that you have installed the latest firmware enabling them to work 

properly in a 2 Gbps Fibre Channel environment. 

 Important:  

 If the new DS4000 Storage Subsystem is either a FAStT200 or DS4300 Storage 

Subsystem, set the FAStT200 or DS4300 enclosure ID to a value unique from other 

EXP storage expansion enclosures in the Fibre Channel drive loop. These IDs are 

normally set to “0” at the factory. 

Activity 4: Making connections 

Insert the SFPs or GBICs into the DS4000 Storage Subsystem drive port slots and 

make the connections from the DS4000 Storage Subsystem to the storage expansion 

enclosures. For detailed information, see the appropriate DS4000 Storage Controller’s 

Installation and User Guide. 

Ensure that all of the DS4000 storage expansion enclosures are set to the correct 

Fibre Channel speed for the drive loop of the new DS4000 Storage Subsystem. 

Activity 5: Powering on the expansion unit and setting IP 

addresses 

__ Step 1.   Verify that all of the storage expansion enclosures are powered on and 

in optimal state by examining the expansion enclosure LED states. 

Then, power on the new DS4000 Storage Subsystem. Using the DS4000 

Storage Manager client program, verify that the DS4000 Storage 

Subsystem is operational and that all of the drives are recognized and 

in optimal state. See the DS4000 Problem Determination Guide associated 

with your particular DS4000 hardware model or “Bringing storage 

subsystems and drive loops into optimal state” on page 52 for 

additional information on how to make this determination.

Notes:  

a.   Your storage subsystem will identify the new DS4000 Storage 

Subsystem as the machine type it replaced until you download the 

appropriate NVSRAM file for the new storage subsystem. For 

example, if you replace a FAStT500 with a DS4500, the DS4500 will 

be reported as a FAStT500 until you download the appropriate 

NVSRAM file for the DS4500. 

b.   See the appropriate DS4000 Storage Controller’s Installation and User 

Guide for information on the proper power on sequence.
__ Step 2.   If the new DS4000 Storage Subsystem is managed out-of-band, perform 

the steps for setting the IP addresses for new DS4000 Storage 

Subsystem controllers defined in the IBM System Storage DS4000 Storage 

Manager Installation and Support Guide associated with your operating 

system environment. DS4000 Storage Manager installation and support 

guides are located at the following Web site: 

www.ibm.com/servers/storage/support/disk/
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Changing DS4000 Storage Subsystem IP addresses 

__ Step  1.   Open the Storage Manager client program’s Enterprise Management 

window.

Note:  The new DS4000 Storage Subsystem will have the same IP 

addresses as the DS4000 Storage Subsystem previously 

removed. 

__ Step  2.   Select the entry of the DS4000 Storage Subsystem that you want to 

manage. 

__ Step  3.   Right click and select Manage Device from the pop-up menu. The 

DS4000 Storage Manager Client Subsystem Management window 

opens. 

__ Step  4.   In the Logical/Physical view of the window, select Controller -> 

Change -> Network Configuration. The Change Network 

Configuration window opens. 

__ Step  5.   Select the Slot A tab. 

__ Step  6.   Select the radio button labeled Specify Configuration Setting. 

__ Step  7.   Type in the new IP address, subnet mask, and gateway information. 

__ Step  8.   Click OK. 

__ Step  9.   Select the Slot B tab. 

__ Step 10.   Select the radio button labeled Specify Configuration Setting. 

__ Step 11.   Type in the new IP address, subnet mask, and gateway information. 

__ Step 12.   Click OK to enable the IP address changes. 

__ Step 13.   Close the DS4000 Storage Manager Client Subsystem Management 

window. 

__ Step 14.   Select the entry of the DS4000 Storage Subsystem whose IP address 

you just changed. Right click. 

__ Step 15.   Select Remove Device from the pop-up menu. 

__ Step 16.   Click Yes to confirm removal of each device. 

__ Step 17.   Select Edit -> Add Device. The Add Device window opens. 

__ Step 18.   Type in the name or new IP address of controller A and close the 

window. 

__ Step 19.   Type in the name or new IP address of controller B and close the 

window.

Activity 6: Downloading firmware and NVSRAM and returning 

arrays online 

__ Step 1.   Use the DS4000 Storage Manager client program to download the 

firmware and the NVSRAM for the new DS4000 Storage Subsystem. 

__ Step 2.   Return the offline arrays to online state by right-clicking on the array 

and selecting Place -> Online. If any of the following conditions 

persist, contact the IBM Help Center for assistance: 

v   The empty drive slot icon ( 

  

) displayed for the drive slot into 

which you inserted the migrating drive. 

v   The Failed unconfigured drive icon ( 

  

) or the Failed configured 

drive icon ( 

  

) displayed for the drive slot into which you 

inserted the migrating drive. 
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v   Array configuration data on the drives you have added is 

incomplete. 

v   You cannot bring the array online.

Activity 7: Generating and applying premium feature SAFE 

key files 

Generate the new premium feature SAFE key files using the new DS4000 Storage 

Subsystem Feature Enable Identifier. Apply premium feature SAFE keys to remove 

Out-of-Compliance errors on enabled premium features. 

Result: You are now able to recreate flashcopies and remote mirror relationships, if 

required. 

Redeploying the original (replaced) DS4000 Storage Subsystem 

As a safety measure, force generation of a new SA Identifier when you redeploy an 

original (replaced) DS4000 Storage Subsystem. Use the controller shell commands 

to generate a new SA Identifier. To gain access to the controller shell, you will 

require a null modem cable and a terminal emulation program that is capable of 

sending a BREAK signal. The setting for the terminal emulation session is 8-N-1 (8 

data bits, no parity bit and 1 stop bit). Once you enter the controller shell, use the 

following command sequence to force the controller to generate a new SA 

Identifier: 

ld </Debug 

symbolGenerateNewSAIdentifier 

Note:  It is necessary for you to run this command sequence on only one controller.
Then, reset both DS4000 Storage Subsystem controllers and proceed with the 

normal DS4000 Storage Subsystem installation and configuration process. 

Accessing the DS4000 Storage Subsystem controller shell 

The following steps describe how to access the DS4000 Storage Subsystem 

controller shell using the terminal emulation program of your choice. One example 

of such a terminal emulation program for which IBM neither makes nor implies a 

warranty, HyperTerminal, Private Edition; version 6.3 or higher, is available for 

your consideration at the following Web site: 

www.hilgraeve.com 

A generic version of steps involved in accessing the DS4000 Storage Subsystem 

controller shell using the terminal emulation program of your choice follows: 

__ Step  1.   Stop all I/O on the DS4000 Storage Subsystem. 

__ Step  2.   Connect a null modem serial cable from one of the DS4000 Storage 

Subsystem controller communications (COM) ports to a system with 

an available terminal emulator. 

__ Step  3.   Open the terminal emulation program of your choice, such as the 

HyperTerminal, Private Edition program and from the menu bar, click 

File -> Properties -> Configure. Establish the following property 

settings: 

v   Bits per second: 38400 

v   Data bits: 8 

v   Parity: None 

v   Stop Bit: 1 
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v   Flow Control: None
__ Step  4.   Connect to the DS4000 Storage Subsystem controller shell by sending 

a BREAK signal. (If you are using the HyperTerminal, Private Edition 

program, press the Ctrl and BREAK keys simultaneously to send the 

BREAK signal.) 

__ Step  5.   Repeat step 4 until the following message displays: 

“Press the space bar for baud rate within 5 seconds.” 

__ Step  6.   Press the space bar within the time limit to establish the correct baud 

rate setting. 

__ Step  7.   Send another BREAK signal. The following message is displayed: 

“Press within 5 seconds: ESC for SHELL, BREAK for baud rate.” 

__ Step  8.   Press the ESC key within the time limit to access the controller shell. 

__ Step  9.   When prompted, type the following password: 

infiniti 

__ Step 10.   You are now accessing the DS4000 Storage Subsystem controller shell. 

 Important: 

 Be careful when entering commands in the DS4000 Storage Subsystem 

controller shell. Improper use of DS4000 Storage Subsystem controller 

shell commands could result in loss of configuration data.
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Appendix  A.  IBM  System  Storage  DS4000  Fibre  Channel  and  

Serial  ATA  Intermix  Premium  Feature  Installation  Overview  

Note:  For the most current information on the DS4000 Fibre Channel and Serial 

ATA (FC/SATA) Intermix premium feature, including the latest version of 

this Installation overview, see the IBM System Storage Support Web site: 

www.ibm.com/servers/storage/support/disk/ 

The DS4000 FC/SATA Intermix premium feature supports the concurrent 

attachment of Fibre Channel and SATA storage expansion enclosures to a single 

DS4000 controller configuration. 

With this premium feature, you can create and manage distinct arrays or logical 

drives that are built from either Fibre Channel disks or SATA disks in a DS4000 

Storage Subsystem, and allocate the drives to the appropriate applications in the 

attached host servers. 

Note:  You must purchase the DS4000 FC/SATA Enclosure Intermix premium 

feature for each DS4000 Storage Subsystem that will have drive 

channels/loops intermixing SATA and Fibre Channel technology drives. 

Table 23 shows the combinations of DS4000 storage subsystems and storage 

expansion enclosures that this DS4000 FC/SATA Intermix premium feature 

currently supports. 

 Table 23. FC/SATA Intermix premium feature - supported configurations 

DS4000 Storage 

Subsystem 

Model 

Intermixing with ... (see note 7) 

EXP100 

EXP810 

(with 

SATA 

E-DDMs)  

EXP710 

and 

EXP100 

EXP710 

and/or 

EXP700, 

and 

EXP100 

EXP710 

and/or 

EXP810 

with FC 

E-DDMs,  

and 

EXP810 

with 

SATA 

E-DDMs  

EXP710s 

and/or 

EXP810s 

with FC 

E-DDMs,  

and 

EXP100s 

and/or 

EXP810s 

with 

SATA 

E-DDMs  

DS4100 DS4100 storage subsystems do not support the Intermix premium 

feature. 

DS4200 Express DS4200 Express storage subsystems do not currently support the 

Intermix premium feature. (See note 11.) 

DS4300 (standard 

or Turbo 

dual-controller) 

without FC 

drives in internal 

slots 

N/A
(See note 

8) 

N/A
(See note 

8) 

Yes Yes Yes
(See note 

4) 

Yes
(See note 

4) 
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Table 23. FC/SATA Intermix premium feature - supported configurations (continued) 

DS4000 Storage 

Subsystem 

Model 

Intermixing with ... (see note 7) 

EXP100 

EXP810 

(with 

SATA 

E-DDMs)  

EXP710 

and 

EXP100 

EXP710 

and/or 

EXP700, 

and 

EXP100 

EXP710 

and/or 

EXP810 

with FC 

E-DDMs,  

and 

EXP810 

with 

SATA 

E-DDMs  

EXP710s 

and/or 

EXP810s 

with FC 

E-DDMs,  

and 

EXP100s 

and/or 

EXP810s 

with 

SATA 

E-DDMs  

DS4300 (standard 

or Turbo 

dual-controller) 

with FC drives in 

internal slots 

Yes Yes Yes Yes Yes
(See note 

4) 

Yes
(See note 

4) 

DS4400 N/A
(See note 

9) 

N/A
(See note 

9) 

Yes Yes No No 

DS4500 N/A
(See note 

9) 

N/A
(See note 

9) 

Yes Yes Yes
(See note 

4) 

Yes
(See note 

4) 

DS4700 with 

SATA E-DDMs  

only, in internal 

slots 

No
(See note 

1) 

N/A
(See note 

10) 

No
(See note 

1) 

No
(See notes 

1 and 3) 

Yes
(See note 

5) 

No
(See note 

6) 

DS4700 with FC 

E-DDMs  in 

internal slots 

Yes Yes No
(See note 

1) 

No
(See notes 

1 and 3) 

Yes
(See note 

5) 

No
(See note 

6) 

DS4800 N/A
(See note 

9) 

N/A
(See note 

9) 

Yes
(See note 

2) 

No
(See note 

3) 

Yes
(See note 

5) 

No
(See note 

6)
  

Notes for Table 1:  

 1.   DS4700s do not support EXP100s. 

 2.   Requires DS4800 controller firmware version 6.15.xx.xx. 

 3.   DS4700s and DS4800s do not support EXP700s. 

 4.   Requires DS4300 or DS4500 controller firmware version 6.19.xx.xx or later. 

 5.   Requires DS4700 or DS4800 controller firmware version 6.16.88.xx or later. 

 6.   DS4700s and DS4800s do not currently support intermixing EXP810s and 

EXP100s. Please contact your IBM reseller for information about future 

support. 

 7.   EXP810s cannot be intermixed with EXP700s. You must upgrade your EXP700 

to an EXP710 using the DS4000 EXP700 Models 1RU-1RX Switched-ESM 

Option Upgrade Kit before you can intermix with EXP810s. 

 8.   For a DS4300 subsystem with no drives in its internal drive slots, the 

FC/SATA Intermix premium feature is not required to connect to a storage 

expansion enclosure with SATA drives only, such as an EXP100 or an EXP810 

(with SATA E-DDMs only). However, a special NVSRAM file must be 

installed in the DS4300 subsystem to disable its internal drive slots. 
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Note:  To find the NVSRAM file, look in the following directory of the 

controller firmware upgrade package:

...\NVSRAM\DS4300_FAStT600_Turbo\ 

For_attachment_of_EXP100-EXP810(SATA)_enclosures_only 

 9.   The FC/SATA Intermix premium feature is not required to connect a DS4400, 

DS4500, or DS4800 storage subsystem to a storage expansion enclosure with 

SATA drives only, such as an EXP100 or an EXP810 (with SATA E-DDMs 

only). 

10.   For a DS4700 subsystem with SATA drives in its internal drive slots, the 

FC/SATA Intermix premium feature is not required to connect to a storage 

expansion enclosure with SATA drives only, such as an EXP810 (with SATA 

E-DDMs only). 

11.   Configurations that are not supported at the time of publication might be 

supported in the future. For the most current information on the DS4000 Fibre 

Channel and Serial ATA (FC/SATA) Intermix premium feature, see the IBM 

System Storage Support Web site: 

www.ibm.com/servers/storage/support/disk/ 

12.   The FC/SATA Intermix premium feature is required if you want to intermix a 

DS4700 with SATA E-DDMs in its internals slots with Fibre Channel 

enclosures, such as the EXP710 or the EXP810 with Fibre Channel E-DDMs

For  information regarding future support for other Fibre Channel/SATA intermix 

combinations of DS4000 storage subsystems and storage expansion enclosures, 

contact your IBM reseller or representative or check the DS4000 Interoperability 

Matrix at the following Web site:

www-1.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 

Firmware requirements 

The FC/SATA Intermix premium feature requires that you upgrade the DS4000 

Storage Manager and controller firmware. See Table 24 for the versions that are 

applicable to your DS4000 storage subsystem model. 

Important:  Before you begin the upgrade, see the readme files that are packaged 

with the DS4000 Storage Manager host software or controller firmware 

for any prerequisites and for any required updating sequences. You can 

also refer to the DS4000 Installation, User’s, and Maintenance Guides 

for your specific storage subsystem and disk expansion enclosures for 

more information.

 Table 24. Required DS4000 Storage Manager and subsystem controller firmware levels, by 

DS4000 subsystem model type 

DS4000 Subsystem 

Model 

DS4000 Storage Manager 

version 

DS4000 controller firmware 

version 

DS4300 9.19 or later 6.19.xx.xx or later 

DS4400 9.19 or later 6.12.2x.xx 

DS4500 9.19 or later 6.19.xx.xx or later 

DS4700 9.19 or later 6.16.88.xx or later. 
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Table 24. Required DS4000 Storage Manager and subsystem controller firmware levels, by 

DS4000 subsystem model type (continued) 

DS4000 Subsystem 

Model 

DS4000 Storage Manager 

version 

DS4000 controller firmware 

version 

DS4800 9.19 or later 6.15.xx.xx when intermixing 

EXP710s and EXP100s only. 

(DS4800 controller firmware 

version 6.15.xx.xx does not 

currently support EXP810s.) 

Note: Even though controller 

firmware version 6.14.xx.xx 

supports the intermixing of 

EXP100 and EXP710 expansion 

enclosures together, it is 

strongly recommended that you 

use version 6.15.xx.xx. 

6.16.88.xx or later when 

intermixing EXP810s with 

SATA E-DDMs  and EXP710s, 

and/or EXP810s with Fibre 

Channel E-DDMs.  

Note: DS4800 controller 

firmware version 6.16.xx.xx 

does not support EXP100s.
  

Note:  For the most current version of the DS4000 Storage Manager and storage 

subsystem controller firmware, see the IBM System Storage Support Web 

site: 

www.ibm.com/servers/storage/support/disk/ 
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FC/SATA  Intermix Option installation kit 

The FC/SATA Intermix Option installation kit includes the following items: 

v   IBM System Storage DS4000 Fibre Channel and Serial ATA Intermix Premium Feature 

Installation Overview (this publication) 

v   The DS4000 FC/SATA Intermix premium feature entitlement document 

v   The DS4000 FC/SATA Intermix premium feature activation document, which 

includes the feature activation code and the instructions about how to generate 

the key file

Installing the FC/SATA  Intermix premium feature 

Complete the following steps to install the FC/SATA Intermix premium feature 

upgrade: 

1.   Purchase an IBM System Storage DS4000 Fibre Channel/SATA Intermix 

entitlement. Contact your IBM reseller or representative for additional 

information.
2.   Upgrade your DS4000 ESM firmware to the level that is compatible with each 

particular enclosure type. 

 Attention:  You should perform any required ESM code upgrades before you 

perform any other code upgrades. See Table 25 to find the ESM firmware levels 

that are compatible with each enclosure type. 

 Table 25. ESM firmware levels by storage expansion enclosure type 

Storage expansion enclosure type ESM firmware level 

DS4000 EXP100 9563 or later (9565 is current). See note a, 

below. 

DS4000 EXP700 9326 or later (9330 is current). See notes b 

and c, below. 

DS4000 EXP710 9629 or later (9640 is current). 

DS4000 EXP810 9878 or later.
  

Notes:  

a.   If a DS4000 storage subsystem has an EXP100 ESM firmware version earlier 

than 9554 installed, you must upgrade the firmware to version 9554 before 

upgrading to version 9563 or 9565. (Please note that the controller firmware 

version must be version 5.41.1x.xx in order to upgrade the earlier version of 

ESM firmware to version 9554.) 

b.   You must upgrade the EXP700 ESM firmware to version 9326 or later before 

you upgrade the DS4000 storage subsystem controller firmware to version 

06.1x.xx.xx. 

c.   DS4700 and DS4800 storage subsystems do not support DS4000 EXP700 

expansion enclosures. Also, DS4300 and DS4500 storage subsystems do not 

support intermixing EXP700 expansion enclosures with EXP810 expansion 

enclosures. However, you can remove these restrictions by upgrading the 

EXP700 to an EXP710 by purchasing and implementing the DS4000 EXP700 

Models 1RU/1RX Switched-ESM Option Upgrade Kit.
3.   If necessary, upgrade your host software to DS4000 Storage Manager version 

9.19 or later. You can download Storage Manager software from the IBM 

DS4000 Storage Manager Support Web site: 

www.ibm.com/servers/storage/support/disk/ 
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Refer to the appropriate Storage Manager Installation and Support Guide for 

your host operating system. 

4.   Upgrade your DS4000 Storage Subsystem controller firmware to the 

appropriate version for your storage subsystem model, as indicated in Table 24 

on page 131. For more information, see the IBM DS4000 Storage Manager 

Installation and Support Guide for your host operating system. You can 

download the latest versions of the DS4000 Storage Subsystem controller 

firmware and Storage Manager host software from the DS4000 System Storage 

Support Web site (see link in Note 3 on page 133). 

5.   The DS4000 FC/SATA Intermix premium feature is entitled, and therefore it 

requires the use of a feature key to enable the option. To obtain the feature key 

identifier, you need a feature activation code, which is printed on the IBM 

premium feature activation card (included with this DS4000 FC/SATA Intermix 

premium feature kit). You also need your controller unit IBM serial number, 

which is printed on the label on the back of your DS4000 storage subsystem. 

Using the instructions in the DS4000 FC/SATA Intermix premium feature 

activation card, generate the FC/SATA Intermix premium feature key to enable 

FC/SATA Intermix functionality. 

Attention:  Before activating the FC/SATA Intermix premium feature, be sure to 

check the controller firmware readme files for the most up-to-date 

information. The readme files might include updated code 

prerequisites, specific Intermix cabling requirements, or other 

important information that you might need. Failure to check the 

readme files for this information can cause undesired results.

Note:   Save the premium feature enable key file in a safe place.

Restrictions 

Important:  When you add drive expansion enclosures of different types, the 

grouping of the enclosure types might force the new enclosures to be 

cabled in the middle of the drive loop. In this case, it is strongly 

recommended that you power down the configuration or schedule 

your installations during offpeak I/O periods. You can use the 

performance monitor function in the DS4000 Storage Manager 

Subsystem Management window to determine offpeak I/O periods. 

If you cannot power down the configuration to install a new enclosure in the 

middle of the loop, you must use DS4000 Storage Manager to verify that the 

interrupted drive loop is in Optimal state before you modify the other drive loop. 

This minimizes the possibility that arrays might fail as a result of cabling errors. 

Therefore, it is also important to plan for additions to the configuration prior to 

your initial installation. It is also best practice to take these same precautions when 

you add new enclosures to either end of the redundant drive loop. 

For more information, see the IBM System Storage DS4000 Hard Drive and Storage 

Expansion Enclosure Installation and Migration Guide. 

The following restrictions apply to the use of the DS4000 FC/SATA Intermix 

premium feature: 
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Compatible storage subsystems 

Only the following DS4000 Storage Subsystems support the FC/SATA 

Intermix premium feature: 

v   DS4300 Standard/Base or Turbo 

v   DS4400 

v   DS4500 

v   DS4700 

v   DS4800

Limitations: 

v   DS4400 storage subsystems do not currently support EXP810 expansion 

enclosures. 

v   DS4700 storage subsystems do not support EXP100 expansion 

enclosures. 

v   EXP810 FC/SATA Intermix is supported at the enclosure level only. You 

cannot intermix Fibre Channel and SATA drives within the same EXP810 

enclosure. 

v   DS4800 storage subsystems do not support intermixing EXP810 

expansion enclosures (with either Fibre Channel or SATA drives) with 

EXP100 expansion enclosures. 

v   You cannot attach more than four EXP810s to one drive port that is part 

of a two-ported drive channel (for example, DS4700 and DS4800 

subsystems have a two-port drive channel). 

Note:  This restriction does not apply when you are connecting 

enclosures to DS4300 and DS4500 drive ports.

For  information regarding future DS4000 FC/SATA Intermix 

interoperability, contact your IBM reseller or representative or check the 

DS4000 Interoperability Matrix at the following Web site:

www-1.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 

Setting Enclosure IDs with unique single digit values 

Ensure that the single digit (x1) of the enclosure ID for every enclosure in a 

redundant drive loop pair is unique. (In addition to expansion enclosures, 

this includes any storage subsystem that has drives installed.) 

 Enclosure IDs (sometimes known as tray IDs, or server IDs) consist of two 

digits: x10 and x1. In 14-drive expansion enclosures (EXP100/EXP700/
EXP710), you can set the enclosure ID manually. In 16-drive expansion 

enclosures (EXP810), the enclosure ID is set automatically by the EXP810 

ESM and the controller firmware. (Please refer to the appropriate 

Installation, User’s, and Maintenance Guides for your enclosures for 

information on how to manually set the switches.) 

 If you do not set a unique single digit (x1) of the enclosure ID for every 

enclosure in a redundant drive loop pair, then drive loop errors might be 

randomly posted in the DS4000 subsystem Major Event Log (MEL) when 

you intermix different types of storage expansion enclosures in a 

redundant drive loop pair (such as an EXP100 with an EXP810). For 

example, with four enclosures attached to a DS4500 in a redundant drive 

loop pair, the correct enclosure ID settings should be x1, x2, x3, and x4 

(where x can be any digits that can be set). Examples of incorrect settings 

would be 11, 21, 31, 41;  or 12, 22, 32 62. These examples are incorrect 

because the x1 digits are the same in all enclosure IDs (either 1 or 2). 
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If the enclosure IDs in your DS4000 subsystem configuration are not 

currently set to have unique single digit values for the enclosures in the 

same redundant drive loop pair, make the changes to the enclosure IDs in 

the next maintenance schedule. This will prevent unnecessary downtime 

when you add enclosures of different type (especially EXP810s) to the 

existing enclosures in the redundant drive loop pair.

Grouping DS4000 storage expansion enclosures in a redundant drive loop 

 

 

Attention: 

Configurations that do not follow this DS4000 storage expansion 

enclosures grouping restriction are not supported.

 When mixing enclosures with Fibre Channel and SATA drives in a drive 

loop (DS4300/DS4400/DS4500) or behind a drive channel port 

(DS4700/DS4800), always group them by enclosure type. Table 23 on page 

129 shows three different types of enclosures. 

 Note: For enclosures such as EXP710s and EXP810s – which are considered 

to be the same switch-ESM enclosure type even though they have different 

machine type, model and physical characteristics – group them next to 

each other by model type. See “Recommendations” on page 143 for 

recommended cabling diagrams. 

 Figure 46 on page 137 shows a correct way and an incorrect way to group 

expansion enclosures that are attached to a DS4300, DS4400 or DS4500 

storage subsystem:
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You must group enclosure model types together, as the configuration on 

the left shows. In the configuration on the left, the EXP700s are grouped 

together at the top of the loop, followed by the EXP710s, which are 

grouped together at the middle of the loop, followed by the EXP100s, 

which are grouped together closest to the controller. 

Note:  The storage expansion enclosure model type is indicated in the 

lower right corner of each enclosure. 

 In the configuration on the right, the enclosures are cabled in a random 

order and are not grouped by type. IBM does not support DS4000 Storage 

Subsystem Fibre Channel/SATA intermix configurations when they are 

cabled in this way. 

 Figure 47 on page 139 shows another incorrect way to group the expansion 

enclosures. In this case, the configuration is incorrect because the EXP100s 

are cabled between the EXP710s and the EXP810s. 

EXP100 EXP710

EXP100 EXP100

EXP710 EXP700

EXP710 EXP100

EXP700 EXP710

EXP700 EXP700

d
s
h
0
0
0
3
0

Correct Intermix Configuration
(note expansion unit type)

Incorrect Intermix Configuration
(note expansion unit type)

  

Figure 46. Correct and incorrect ways to group expansion enclosures in a redundant drive 

loop (DS4300 and DS4500 storage subsystems)
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Note: The controller firmware considers EXP810s and EXP710s to be the 

same enclosure type – a switched storage expansion unit type, which has 

an ESM with an embedded Fibre Channel loop switch – even though they 

are different models. Therefore, you must group these two enclosure 

models next to each other if they are contained within a drive loop or 

drive channel. However, you still need to group all of the EXP710s 

together, and group all of the EXP810s together, in the drive loop/channel. 
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Figure 48 on page 140 shows the correct way to group expansion 

enclosures that are attached to a DS4700 or DS4800 storage subsystem:
 

ESM BESM A

OutIn OutIn

EXP100

EXP810

ESM B

Port 1BPort 1A

Port 1APort 1B

ESM A

ESM BESM A

OutIn OutIn

EXP100

EXP810

ESM B

Port 1BPort 1A

Port 1APort 1B

ESM A

ESM BESM A

OutIn OutIn

EXP710

ESM BESM A

OutIn OutIn

EXP710

EXP100s

EXP810s

EXP710s

d
s
4
k
0
0
0
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Figure 47. Second example of incorrect expansion enclosure grouping
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Note:  These figures are for illustrative purpose only. The representations of 

the DS4000 storage subsystems and expansion enclosures might not 

accurately reflect the rear view of the DS4000 products. (The cabling 

diagrams are correct.)

EXP810 with FC drive options

EXP810 with SATA drive options

EXP710 with FC drive options

EXP810 with SATA drive options

EXP810 with SATA drive options

EXP710 with FC drive options

58

8 5

Controller A

Controller B

DS4800
  

Figure 48. Grouping expansion enclosures by type behind a drive channel port (DS4700 and 

DS4800 storage subsystems)

 

140 Adding  and Migrating Drives and Expansion  Enclosures  to DS4000 Storage  Servers



Attention: 

For the purposes of the storage expansion enclosure grouping 

restriction, note the following considerations: 

v   All models of the EXP100 are considered to be the same from a 

grouping perspective. For example, the EXP100 1710-10X, 1710-10U, 

and the 1724-1XP are considered like enclosure types and must be 

grouped together. 

v   All models of the EXP700 are considered to be the same from a 

grouping perspective. For example, the EXP700 1740-1RU, and the 

1740-1RX are considered like enclosure types and must be grouped 

together. 

v   After the EXP700 has been upgraded with the DS4000 EXP700 

Models 1RU/1RX Switched-ESM Option Upgrade Kit, it is considered 

an EXP710, regardless of the machine type and model (as labeled in 

the EXP700 chassis). 

v   The controller firmware considers EXP810s and EXP710s to be the 

same enclosure type – a switched storage expansion unit type, 

which has an ESM with an embedded Fibre Channel loop switch – 

even though they are different models. Therefore, you must group 

these two enclosure models next to each other if they are contained 

within a drive loop or drive channel. However, you still need to 

group all of the EXP710s together, and group all of the EXP810s 

together, in the drive loop/channel.

 For more information, see the IBM System Storage DS4000 Hard Drive and 

Storage Expansion Enclosure Installation and Migration Guide. 

Cannot mix drive types  

Arrays must consist exclusively of either Fibre Channel or SATA drives. 

You cannot mix drive types in an array. 

Cannot mix Fibre Channel and SATA drives in the same DS4000 storage 

subsystem or storage expansion enclosure 

 You cannot mix Fibre Channel and SATA drives in the same DS4000 

storage subsystem or storage expansion enclosure. Even though the drive 

trays for the DS4700 and EXP810 Fibre Channel Disk Drive Modules (DDMs) 

and the 500GB SATA Enhanced Disk Drive Modules (E-DDMs) are the same, 

the trays must be filled with either SATA or Fibre Channel drives, but not 

both. 

 For example, if one drive slot in the DS4700 or EXP810 enclosure is filled 

with a SATA drive, the rest of the drive slots in that enclosure must be 

filled with SATA drives only. This statement is similarly true with Fibre 

Channel drives. 

 For information about the removal of this restriction in the future, contact 

your IBM reseller or representative, or check the DS4000 Interoperability 

Matrix at the following Web site:

www-1.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 
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Table 26 lists the drive types and their corresponding DS4000 storage 

subsystems and storage expansion enclosures. 

  Table 26. Drive types and their corresponding DS4000 storage subsystems and storage 

expansion enclosures 

Drive type (see 

note 1) 

Storage subsystem type Storage expansion enclosure type 

SATA DS4100 

DS4700 (see note 2) 

DS4000 EXP100 

DS4000 EXP810 (see note 2) 

Fibre Channel DS4300 Standard/Base or Turbo 

DS4400 

DS4500 

DS4700 (see note 3) 

DS4800 

DS4000 EXP700 

DS4000 EXP710 

DS4000 EXP810 (see note 3) 

  

Notes:  

1.   The drive trays for the DS4700/EXP810 Fibre Channel drives and SATA 

E-DDMs are the same. However, this is not true of the DS4100/EXP100 

SATA DDMs and the DS4300/EXP710/700 Fibre Channel DDMs, which 

have different drive trays from each other and from the 

DS4700/EXP810 Fibre Channel or SATA E-DDMs. 

2.   These devices are considered to be SATA drive types when populated 

with SATA E-DDMs. 

3.   These devices are considered to be Fibre Channel drive types when 

populated with Fibre Channel E-DDMs.

Cannot intermix drive types for hot spares 

SATA drives can function as hot spares for SATA drives only. 

 Fibre Channel drives can function as hot spares for Fibre Channel drives 

only. 

DS4300 Standard/Base or Turbo Intermix configuration restrictions 

In DS4300 Intermix configurations, with the FC/SATA Intermix premium 

feature enabled and the correct NVSRAM file installed, the maximum 

number of expansion enclosures in a drive loop is limited to seven. This is 

true whether or not there are drives in the DS4300 storage subsystem drive 

slots.
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Recommendations 

Please note the following recommendations when you cable your configuration: 

Connect only one type of expansion enclosure behind each controller drive port 

Connect only one type of expansion enclosure behind each DS4700 or 

DS4800 controller drive port. Figure 49 shows three EXP710s and three 

EXP810s, not mixed together, behind the same drive port of a given drive 

channel.
  

EXP810

EXP710

DS4700

DS4700
  

Figure 49. Example of connecting only one type of expansion enclosure (EXP710 or 

EXP810) behind a DS4700 controller drive port
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Group EXP810s by technology type behind each controller drive port 

If you are using EXP810 expansion enclosures, connect only those that 

have the same type of technology (Fibre Channel or SATA) behind each 

DS4700 or DS4800 controller drive port. Figure 50 shows three EXP810s 

with SATA E-DDMs and three EXP810s with Fibre Channel, not mixed 

together, behind the same drive port of a given drive channel.
  

EXP810 with Fibre

Channel drive options

DS4700

DS4700

EXP810 with
SATA drive

options

  

Figure 50. Example of connecting only one type of EXP810 expansion enclosure (SATA 

E-DDM  or Fibre Channel) behind a DS4700 controller drive port
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Group EXP710 and EXP810s by model type behind each controller drive port 

If it is not possible to separate EXP810 and other expansion enclosures 

behind different controller drive ports, group the expansion enclosures by 

model type behind each controller drive port. Figure 51 shows EXP710 and 

EXP810 enclosures that are mixed together behind a drive port, grouped 

together by model type. In addition, the three EXP810s with the SATA 

drive option are connected to a different drive channel than the EXP810 

and EXP710 with the Fibre Channel drive option.
  

58

8 5

Controller A

Controller B

DS4800

EXP710 & EXP810 with FC drive options
EXP810 with SATA drive options

EXP710 & EXP810 with SATA drive options

  

Figure 51. Example of grouping EXP810 and EXP710 model types together behind a 

DS4800 controller drive port
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Group EXP100s and EXP810s by model type behind each DS4300 or DS4500 

controller drive port 

When intermixing the EXP100s and EXP810s behind a DS4300 or DS4500 

storage subsystem, you might not be able to cable the EXP100s in a 

separate redundant drive loop pair from the EXP810s because of hardware 

limitations. For example, in the DS4300 only one redundant drive loop is 

available; or in the DS4500, one redundant drive loop might be full with 

other storage expansion enclosures. In this case, it is recommended that 

you group the enclosures by type in the redundant drive loop pair. As 

shown in Figure 52, cable the group of EXP100s followed by the group of 

EXP810s, and EXP810s followed by EXP100s.
  

EXP810

ESM B

ESM A

Port 1B

Port 1APort 1B

ESM BESM A

OutIn OutIn

EXP100

ESM BESM A

OutIn OutIn

EXP100

ESM BESM A

OutIn

EXP100

EXP810

ESM B

ESM A

Port 1BPort 1A

Port 1APort 1B

ESM BESM A

EXP100

EXP100s

EXP810s

EXP810

ESM B

Port 1BPort 1A

EXP810

ESM B

ESM A

Port 1BPort 1A

Port 1APort 1B
EXP810s

EXP100s

OutIn

OutIn OutIn

Port 1APort 1B

ESM A

Port 1A

d
s
4

k
0

0
0

4

  

Figure 52. Example of grouping EXP810s and EXP100 model types behind a DS4300 or 

DS4500 controller drive port
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Group EXP100s, EXP710s, and EXP810s behind a DS4500 controller drive port 

When intermixing the EXP100s, EXP710s, and EXP810s behind a DS4500 

storage subsystem, it is recommended that you cable the EXP100s in a 

separate redundant drive loop pair from the EXP810s and EXP710s, if 

possible. In Figure 53, the redundant drive loop pair on the left has 

EXP810s and EXP710s intermixed; the redundant drive loop pair on the 

right has only EXP100s.
  

ESM BESM A

OutIn OutIn

EXP100EXP810

ESM B

Port 1BPort 1A

Port 1APort 1B

ESM A

EXP810

ESM B

Port 1BPort 1A

Port 1APort 1B

ESM A ESM BESM A

OutIn OutIn

EXP100

ESM BESM A

OutIn OutIn

EXP100

ESM BESM A

OutIn OutIn

EXP710

ESM BESM A

OutIn OutIn

EXP710 d
s
4
k
0
0
0
5

  

Figure 53. Example of grouping EXP100s, EXP710s, and EXP810s behind a DS4500 

controller drive port
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Group EXP100s, EXP710s, and EXP810s behind a DS4300 or DS4500 controller 

drive port 

When intermixing the EXP100s, EXP710s, and EXP810s behind a DS4300 or 

DS4500 storage subsystem, if it is not possible to cable the EXP100s in a 

separate redundant drive loop pair from the EXP810s and EXP710s, it is 

recommended that you group the enclosures in such a way that the 

EXP810s are placed between the EXP100s and EXP710s, as shown in 

Figure 54 on page 149 and Figure 55 on page 151.

Requirement:  For the DS4300, this is currently a requirement.
 

 

148 Adding  and Migrating Drives and Expansion  Enclosures  to DS4000 Storage  Servers



ESM BESM A

OutIn OutIn
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EXP810
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Port 1BPort 1A
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OutIn OutIn
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EXP100s
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Figure 54. First example of grouping EXP100s, EXP710s, and EXP810s behind a DS4300 or 

DS4500 controller drive port
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Appendix  B.  Cabling  storage  expansion  enclosures  

ESM BESM A

OutIn OutIn

EXP100

EXP810

ESM B

Port 1BPort 1A
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ESM BESM A

OutIn OutIn
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EXP100s
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4
k
0
0
0
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Figure 55. Second example of grouping EXP100s, EXP710s, and EXP810s behind a DS4300 

or DS4500 controller drive port
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General rules and recommendations for cabling storage expansion 

enclosures 

Refer to these general rules and recommendations when you complete the steps 

described in “Activity 6: Cabling, powering on, and verifying storage expansion 

unit operation” on page 78. 

Note:  This section also refers to the cabling diagrams in “Storage expansion 

enclosure cabling diagrams” on page 154. 

The following are general rules or limitations to follow as a guideline when you 

connect storage expansion enclosures to the storage subsystem: 

v   The DS4000 Storage Subsystem supports the connection of a maximum of two 

redundant drive loop pairs. The maximum number of drive enclosures per drive 

loop depends on the type of storage expansion enclosure and whether 

intermixing storage expansion enclosures of different drive slots. 

v   The DS4000 currently supports a maximum of 110 drives in 11 10-drive storage 

expansion enclosures or 112 drives in either eight 14-drive or seven 16-drive 

expansion enclosures per drive loop in each controller. Two drive loops from the 

DS4000 drive mini hubs must be connected to the same set of expansion 

enclosures to provide drive loop redundancy. 

v   When connecting the storage expansion enclosures to drive mini hubs, do not 

use all ports in each of the drive mini hubs. Connect the FC cable to only one 

port of the drive mini hub and leave the other port unoccupied. 

v   When cabling different types of storage expansion enclosures, if possible, do not 

mix different types of storage expansion enclosures in the same redundant drive 

loop pair. Also, when mixing different types of storage expansion enclosures in 

the same drive channel pair, the Link Rate Setting must be the same for each 

storage expansion enclosure. IBM does not support different enclosure speed 

settings in the same drive loop.

In addition to the previously outlined general rules, it is strongly recommended 

that you observe the following rules when connecting storage expansion enclosures 

to the storage subsystem: 

v   Ensure that the enclosure ID of all enclosures in a DS4000 storage subsystem 

configuration (including the DS4000 storage subsystem with internal drive slots) 

is unique. Enclosure IDs (sometimes known as tray IDs) consist of two digits 

(x10 and x1). The tens digit (x10) portion of the enclosure ID should be used to 

differentiate enclosures from different redundant drive loop/channel pairs, and 

the singles digit (x1) portion should be used to differentiate enclosures in the 

same redundant drive loop/channel pair. In 14-drive expansion enclosures, the 

enclosure ID must be set manually. In 16-drive expansion enclosures, the 

enclosure ID is set automatically. Refer to the Installation, User’s, and 

Maintenance Guide for your appropriate enclosure for information on how to 

manually set the switches. If the enclosure IDs are not unique, an error will be 

posted in the DS4300 storage subsystem Major Event Log (MEL), and the ID 

conflict LED on the enclosure with same enclosure ID will be lit. 

In addition, ensure that the single digit (x1) of the enclosure ID for every 

enclosure in a redundant drive loop pair is unique (including the DS4000 storage 

subsystem with internal drive slots). If you do not set the single digit of the 

enclosure IDs to be unique among enclosures in a redundant drive loop pair, 

then drive loop errors might be randomly posted in the DS4000 storage 

subsystem Major Event Log (MEL), especially in the cases where different 

storage expansion enclosure types are intermixed in the same drive 
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loop/channel behind a DS4000 subsystem configuration. For example, with four 

enclosures attached to the DS4000 storage subsystem drive loop, the correct 

enclosure ID settings should be x1, x2, x3, and x4 (where x can be any digit that 

can be set). Examples of incorrect settings would be 11, 21, 31, and 41 or 12, 22, 

32, and 62; these examples are incorrect because the x1 digits are the same in all 

enclosure IDs (either 1 or 2). 

 Important: 

 Changing enclosure IDs on 14-drive enclosures—and in storage subsystems with 

the mechanical enclosure ID switches—requires the power cycle of the DS4000 

storage subsystem, and all enclosures in the configuration, to activate the new 

settings. Changing the enclosure IDs on 16-drive enclosures and storage 

subsystems (EXP420s, EXP810s, DS4700s, or DS4200s) does not require the 

power cycle of all enclosures and the DS4000 subsystem, if there are no 14-drive 

enclosures being intermixed in the configuration or if the 16-drive enclosures are 

only connected to a DS4000 controller with 16 internal drive slots (DS4200 or 

DS4700). If the enclosure IDs of the enclosures or storage subsystems with the 

mechanical enclosure ID switches in your DS4000 subsystem configuration are 

not currently set to have unique single digit values for the enclosures in the 

same redundant drive loop pair, make the changes to the enclosure IDs in the 

next maintenance schedule. This will prevent unnecessary downtime when you 

add enclosures of different types (especially EXP810s) to the existing enclosures 

in the redundant drive loop pair. 

v   If it is not possible to avoid mixing different enclosures types in the same 

redundant drive loop pair, this rule must be strictly observed. When mixing 

EXP810 and EXP710 enclosures in the same drive loop with EXP100 enclosures, 

all of the EXP810s and EXP710s must be grouped together with the EXP100 

connected to either end of the EXP810/EXP710 drive expansion enclosure group. 

The primary reason for this grouping is because the controller firmware 

considers the EXP810s and EXP710s to be the same enclosure type (switched 

disk expansion unit type, which have an ESM-embedded Fibre Channel loop 

switch) despite being different models. These two enclosure models must be 

grouped together if they are contained within a drive loop.

Note:  You must cable all of the EXP810s together, followed by all of the 

EXP710s. Figure 56 on page 155 and Figure 57 on page 156 are examples 

of correctly cabling the intermix of EXP100 with EXP810 and EXP710 

enclosures. Figure 58 on page 157 and Figure 59 on page 158 are examples 

of incorrectly cabling the intermix of these enclosures. One shows the 

EXP100s cabled between the EXP810s and EXP710s, while the other shows 

the EXP810s and EXP710s intermingled, not with the EXP810s grouped 

separately from the EXP710s, as recommended. 

v   The drive mini hub port must always be connected to the EXP810 port 1B, 

regardless of whether the port is on the EXP810 ESM A or ESM B. Figure 60 on 

page 159 is an example of correctly cabling the EXP810 1B ports to the drive 

mini hub port. Figure 61 on page 160 is an example of incorrect cabling showing 

the connection from the drive mini hub port to the incorrect EXP810 port, 

labeled 1A. 

v   The drive mini hub port must always be connected to the 10- or 14-drive storage 

expansion enclosure left ESM In port of the last enclosure in the group of 

enclosures that are cabled in a redundant drive loop pair. In addition, the drive 

mini hub port must always be connected to the 10- or 14-drive storage 

expansion enclosure right ESM Out port of the first enclosure in the group of 

enclosures that are cabled in a redundant drive loop pair. Figure 62 on page 161 

shows this correct cabling to the 10- or 14-drive storage expansion enclosure 

ESM ports.
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Storage expansion enclosure cabling diagrams 

These diagrams help describe the information provided in “General rules and 

recommendations for cabling storage expansion enclosures” on page 152. 

Note:  The controllers depicted in these cabling diagrams are intended to be 

generic and do not correlate to any specific DS4000 Storage Subsystem. 
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Figure 56. Correct cabling for an intermix of EXP100, EXP710, and EXP810 expansion 

enclosures (example 1)
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Figure 57. Correct cabling for an intermix of EXP100, EXP710, and EXP810 expansion 

enclosures (example 2)
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Figure 58. Incorrect cabling for an intermix of EXP100, EXP710, and EXP810 expansion 

enclosures (example 1)
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Figure 59. Incorrect cabling for an intermix of EXP100, EXP710, and EXP810 expansion 

enclosures (example 2)
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Appendix  C.  Additional  DS4000  documentation  

The following tables present an overview of the IBM System Storage DS4000 

Storage Manager, Storage Subsystem, and Storage Expansion Enclosure product 

libraries, as well as other related documents. Each table lists documents that are 

included in the libraries and what common tasks they address. 

You can access the documents listed in these tables at both of the following Web 

sites: 

www.ibm.com/servers/storage/support/disk/ 

www.ibm.com/shop/publications/order/ 

DS4000 Storage Manager Version 9 library 

Table 27 on page 162 associates each document in the DS4000 Storage Manager 

Version 9 library with its related common user tasks.
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Figure 62. Incorrect cabling to the EXP500/EXP100/EXP700/EXP710 ports
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Table 27. DS4000 Storage Manager Version 9 titles by user tasks 

Title User tasks 

Planning Hardware 

installation 

Software 

installation 

Configuration Operation and 

administration 

Diagnosis and 

maintenance 

IBM System Storage 

DS4000 Storage 

Manager Version 9 

Installation and 

Support Guide for 

Windows 2000/Server 

2003, NetWare, ESX 

Server, and Linux 

U U U 

IBM System Storage 

DS4000 Storage 

Manager Version 9 

Installation and 

Support Guide for 

AIX,  UNIX,  Solaris 

and Linux on 

POWER  

U U U 

IBM System Storage 

DS4000 Storage 

Manager Version 9 

Copy Services User’s 

Guide 

U U U U 

IBM TotalStorage 

DS4000 Storage 

Manager Version 9 

Concepts Guide 

U U U U U U 

IBM System Storage 

DS4000 Fibre 

Channel and Serial 

ATA Intermix 

Premium Feature 

Installation Overview 

U U U U 

  

DS4800 Storage Subsystem library 

Table 28 associates each document in the DS4800 Storage Subsystem library with its 

related common user tasks.

 Table 28. DS4800 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4800 Storage 

Subsystem 

Installation, User’s 

and Maintenance 

Guide 

U U U U U 
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Table 28. DS4800 Storage Subsystem document titles by user tasks (continued) 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4800 Storage 

Subsystem Installation 

and Cabling Overview 

U 

IBM TotalStorage 

DS4800 Controller 

Cache Upgrade Kit 

Instructions 

U U U 
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DS4700 Storage Subsystem library 

Table 29 associates each document in the DS4700 Storage Subsystem library with its 

related common user tasks.

 Table 29. DS4700 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4700 Storage 

Subsystem 

Installation, User’s 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

DS4700 Storage 

Subsystem Fibre 

Channel Cabling 

Guide 

U 
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DS4500 Storage Subsystem library 

Table 30 associates each document in the DS4500 (previously FAStT900) Storage 

Subsystem library with its related common user tasks.

 Table 30. DS4500 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4500 Storage 

Subsystem 

Installation, User's, 

and Maintenance 

Guide 

U U U U U 

IBM TotalStorage 

DS4500 Storage 

Subsystem Cabling 

Instructions 

U U 

IBM TotalStorage 

DS4500 Rack 

Mounting 

Instructions 

U U 
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DS4400 Storage Subsystem library 

Table 31 associates each document in the DS4400 (previously FAStT700) Storage 

Subsystem library with its related common user tasks. 

 Table 31. DS4400 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4400 Fibre 

Channel Storage 

Server User’s Guide 

U U U U U 

IBM TotalStorage 

DS4400 Fibre 

Channel Storage 

Server Installation 

and Support Guide 

U U U U 

IBM TotalStorage 

DS4400 Fibre 

Channel Cabling 

Instructions 

U U 
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DS4300 Storage Subsystem library 

Table 32 associates each document in the DS4300 (previously FAStT600) Storage 

Subsystem library with its related common user tasks.

 Table 32. DS4300 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4300 Storage 

Subsystem 

Installation, User’s, 

and Maintenance 

Guide 

U U U U U 

IBM TotalStorage 

DS4300 Rack 

Mounting 

Instructions 

U U 

IBM TotalStorage 

DS4300 Storage 

Subsystem Cabling 

Instructions 

U U 

IBM TotalStorage 

DS4300 SCU Base 

Upgrade Kit 

U U 

IBM TotalStorage 

DS4300 SCU Turbo 

Upgrade Kit 

U U 

IBM TotalStorage 

DS4300 Turbo Models 

6LU/6LX Upgrade Kit 

U U 
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DS4200 Express Storage Subsystem library 

Table 33 associates each document in the DS4200 Express Storage Subsystem 

library with its related common user tasks.

 Table 33. DS4200 Express Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4200 Express 

Storage Subsystem 

Installation, User’s 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

DS4200 Express 

Storage Subsystem 

Cabling Guide 

U 
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DS4100 Storage Subsystem library 

Table 34 associates each document in the DS4100 (previously FAStT100) Storage 

Subsystem library with its related common user tasks.

 Table 34. DS4100 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4100 Storage 

Server Installation, 

User’s and 

Maintenance Guide 

U U U U U 

IBM TotalStorage 

DS4100 Storage 

Server Cabling Guide 

U 
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DS4000 Storage Expansion Enclosure documents 

Table 35 associates each of the following documents with its related common user 

tasks. 

 Table 35. DS4000 Storage Expansion Enclosure document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4000 EXP810 

Storage Expansion 

Enclosure Installation, 

User’s, and 

Maintenance Guide 

U U U U U 

IBM TotalStorage 

DS4000 EXP700 and 

EXP710 Storage 

Expansion Enclosures 

Installation, User’s, 

and Maintenance 

Guide 

U U U U U 

IBM DS4000 EXP500 

Installation and 

User’s Guide 

U U U U U 

IBM System Storage 

DS4000 EXP420 

Storage Expansion 

Enclosure Installation, 

User’s, and 

Maintenance Guide 

U U U U U 

IBM System Storage 

DS4000 Hard Drive 

and Storage 

Expansion Enclosures 

Installation and 

Migration Guide 

U U 

  

 

 

170 Adding  and Migrating Drives and Expansion  Enclosures  to DS4000 Storage  Servers



Other DS4000 and DS4000-related documents 

Table 36 associates each of the following documents with its related common user 

tasks. 

 Table 36. DS4000 and DS4000–related document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM Safety 

Information 

U 

IBM TotalStorage 

DS4000 Hardware 

Maintenance Manual 

¹ 

U 

IBM System Storage 

DS4000 Problem 

Determination Guide 

U 

IBM Fibre Channel 

Planning and 

Integration: User’s 

Guide and Service 

Information 

U U U U 

IBM TotalStorage 

DS4000 FC2-133 

Host Bus Adapter 

Installation and 

User’s Guide 

U U 

IBM TotalStorage 

DS4000 FC2-133 

Dual Port Host Bus 

Adapter Installation 

and User’s Guide 

U U 

IBM Netfinity® Fibre 

Channel Cabling 

Instructions 

U 

IBM Fibre Channel 

SAN  Configuration 

Setup Guide 

U U U U 

Notes:  

1.   The IBM TotalStorage DS4000 Hardware Maintenance Manual does not contain maintenance information for the IBM 

System Storage DS4100, DS4200, DS4300, DS4500, DS4700, or DS4800 storage subsystems. You can find 

maintenance information for these products in the IBM System Storage DSx000 Storage Subsystem Installation, 

User's, and Maintenance Guide for the particular subsystem.
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Notices  

This publication was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in 

other countries. Consult your local IBM representative for information on the 

products and services currently available in your area. Any reference to an IBM 

product, program, or service is not intended to state or imply that only that IBM 

product, program, or service may be used. Any functionally equivalent product, 

program, or service that does not infringe any IBM intellectual property right may 

be used instead. However, it is the user’s responsibility to evaluate and verify the 

operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 

described in this document. The furnishing of this document does not give you 

any license to these patents. You can send license inquiries, in writing, to: 

   IBM Director of Licensing 

   IBM Corporation 

   North Castle Drive 

   Armonk, NY 10504-1785 

   U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 

PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER 

EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS 

FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of 

express or implied warranties in certain transactions, therefore, this statement may 

not apply to you. 

This information could include technical inaccuracies or typographical errors. 

Changes are periodically made to the information herein; these changes will be 

incorporated in new editions of the publication. IBM may make improvements 

and/or changes in the product(s) and/or the program(s) described in this 

publication at any time without notice. 

Any references in this publication to non-IBM Web sites are provided for 

convenience only and do not in any manner serve as an endorsement of those Web 

sites. The materials at those Web sites are not part of the materials for this IBM 

product, and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it 

believes appropriate without incurring any obligation to you. 

Trademarks  

The following terms are trademarks of International Business Machines 

Corporation in the United States, other countries, or both: 

 FlashCopy Netfinity 

IBM ServerProven® 

IBMLink System Storage
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Intel® is a trademark of Intel Corporation in the United States, other countries, or 

both. 

Java™ and all Java-based trademarks and logos are trademarks or registered 

trademarks of Sun Microsystems, Inc. in the United States, other countries, or both. 

Other company, product, or service names may be trademarks or service marks of 

others. 

Important notes 

Processor speeds indicate the internal clock speed of the microprocessor; other 

factors also affect application performance. 

CD-ROM drive speeds list the variable read rate. Actual speeds vary and are often 

less than the maximum possible. 

When referring to processor storage, real and virtual storage, or channel volume, 

KB stands for approximately 1000 bytes, MB stands for approximately 1 000 000 

bytes, and GB stands for approximately 1 000 000 000 bytes. 

When referring to hard disk drive capacity or communications volume, MB stands 

for 1 000 000 bytes, and GB stands for 1 000 000 000 bytes. Total user-accessible 

capacity may vary depending on operating environments. 

Maximum internal hard disk drive capacities assume the replacement of any 

standard hard disk drives and population of all hard disk drive bays with the 

largest currently supported drives available from IBM. 

Maximum memory may require replacement of the standard memory with an 

optional memory module. 

IBM makes no representation or warranties regarding non-IBM products and 

services that are ServerProven, including but not limited to the implied warranties 

of merchantability and fitness for a particular purpose. These products are offered 

and warranted solely by third parties. 

IBM makes no representations or warranties with respect to non-IBM products. 

Support (if any) for the non-IBM products is provided by the third party, not IBM. 

Some software may differ from its retail version (if available), and may not include 

user manuals or all program functionality. 

Electronic emission notices 

This section gives the electronic emission notices or statements for the United 

States and other countries or regions. 

Federal Communications Commission (FCC) statement 

Note: This equipment has been tested and found to comply with the limits for a 

Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are 

designed to provide reasonable protection against harmful interference when the 

equipment is operated in a commercial environment. This equipment generates, 

uses, and can radiate radio frequency energy and, if not installed and used in 

accordance with the instruction manual, may cause harmful interference to radio 
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communications. Operation of this equipment in a residential area is likely to cause 

harmful interference, in which case the user will be required to correct the 

interference at his own expense. 

Properly shielded and grounded cables and connectors must be used in order to 

meet FCC emission limits. Properly shielded and grounded cables and connectors 

must be used in order to meet FCC emission limits. IBM is not responsible for any 

radio or television interference caused by using other than recommended cables 

and connectors or by using other than recommended cables and connectors or by 

unauthorized changes or modifications to this equipment. Unauthorized changes 

or modifications could void the user’s authority to operate the equipment. 

This device complies with Part 15 of the FCC Rules. Operation is subject to the 

following two conditions: (1) this device may not cause harmful interference, and 

(2) this device must accept any interference received, including interference that 

may cause undesired operation. 

Chinese class A compliance statement 

Attention:  This is a class A statement. In a domestic environment, this product 

might cause radio interference in which case the user might be required to take 

adequate measures. 

  

 

Industry Canada Class A emission compliance statement 

This Class A digital apparatus complies with Canadian ICES-003. 

Avis de conformité à la réglementation d’Industrie Canada 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du 

Canada. 

Australia and New Zealand Class A statement 

Attention:  This is a Class A product. In a domestic environment this product may 

cause radio interference in which case the user may be required to take adequate 

measures. 

United Kingdom telecommunications safety requirement 

Notice to Customers 

This apparatus is approved under approval number NS/G/1234/J/100003 for 

indirect connection to public telecommunication systems in the United Kingdom. 

European Union EMC Directive conformance statement 

This product is in conformity with the protection requirements of EU Council 

Directive 89/336/EEC on the approximation of the laws of the Member States 

relating to electromagnetic compatibility. IBM cannot accept responsibility for any 
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failure to satisfy the protection requirements resulting from a nonrecommended 

modification of the product, including the fitting of non-IBM option cards. 

This product has been tested and found to comply with the limits for Class A 

Information Technology Equipment according to CISPR 22/European Standard EN 

55022. The limits for Class A equipment were derived for commercial and 

industrial environments to provide reasonable protection against interference with 

licensed communication equipment. 

 Attention:   This is a Class A product. In a domestic environment this product 

may cause radio interference in which case the user may be required to take 

adequate measures. 

Taiwan  Class A warning statement 

  

 

Japanese Voluntary  Control Council for Interference (VCCI) 

statement 
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Glossary  

This glossary provides definitions for the 

terminology and abbreviations used in IBM 

TotalStorage DS4000 publications. 

If you do not find the term you are looking for, 

see the IBM Glossary of Computing Terms located at 

the following Web site: 

www.ibm.com/ibm/terminology 

This glossary also includes terms and definitions 

from: 

v   Information Technology Vocabulary by 

Subcommittee 1, Joint Technical Committee 1, 

of the International Organization for 

Standardization and the International 

Electrotechnical Commission (ISO/IEC 

JTC1/SC1). Definitions are identified by the 

symbol (I) after the definition; definitions taken 

from draft international standards, committee 

drafts, and working papers by ISO/IEC 

JTC1/SC1 are identified by the symbol (T) after 

the definition, indicating that final agreement 

has not yet been reached among the 

participating National Bodies of SC1. 

v   IBM Glossary of Computing Terms. New York: 

McGraw-Hill, 1994.

The following cross-reference conventions are 

used in this glossary: 

See Refers you to (a) a term that is the 

expanded form of an abbreviation or 

acronym, or (b) a synonym or more 

preferred term. 

See also 

Refers you to a related term.

Abstract Windowing Toolkit (AWT).  A Java graphical 

user interface (GUI). 

accelerated graphics port (AGP).  A bus specification 

that gives low-cost 3D graphics cards faster access to 

main memory on personal computers than the usual 

peripheral component interconnect (PCI) bus. AGP  

reduces the overall cost of creating high-end graphics 

subsystems by using existing system memory. 

access volume.  A special logical drive that allows the 

host-agent to communicate with the controllers in the 

storage subsystem. 

adapter.  A printed circuit assembly that transmits user 

data input/output (I/O) between the internal bus of 

the host system and the external fibre-channel (FC) link 

and vice versa. Also called an I/O adapter, host 

adapter, or FC adapter. 

advanced technology (AT) bus architecture.  A bus 

standard for IBM compatibles. It extends the XT bus 

architecture to 16 bits and also allows for bus 

mastering, although only the first 16 MB of main 

memory are available for direct access. 

agent.  A server program that receives virtual 

connections from the network manager (the client 

program) in a Simple Network Management 

Protocol-Transmission Control Protocol/Internet 

Protocol (SNMP-TCP/IP) network-managing 

environment. 

AGP.  See accelerated graphics port. 

AL_PA.   See arbitrated loop physical address. 

arbitrated loop.  One  of three existing fibre-channel 

topologies, in which 2 - 126 ports are interconnected 

serially in a single loop circuit. Access to the Fibre 

Channel-Arbitrated Loop (FC-AL) is controlled by an 

arbitration scheme. The FC-AL topology supports all 

classes of service and guarantees in-order delivery of 

FC frames when the originator and responder are on 

the same FC-AL. The default topology for the disk 

array is arbitrated loop. An arbitrated loop is 

sometimes referred to as a Stealth Mode. 

arbitrated loop physical address (AL_PA).  An 8-bit 

value that is used to uniquely identify an individual 

port within a loop. A loop can have one or more 

AL_PAs. 

array.  A collection of fibre-channel or SATA hard 

drives that are logically grouped together. All  the 

drives in the array are assigned the same RAID level. 

An array is sometimes referred to as a ″RAID set.″ See 

also redundant array of independent disks (RAID), RAID 

level. 

asynchronous write mode.  In remote mirroring, an 

option that allows the primary controller to return a 

write I/O request completion to the host server before 

data has been successfully written by the secondary 

controller. See also synchronous write mode, remote 

mirroring, Global Copy,Global Mirroring. 

AT.  See advanced technology (AT) bus architecture. 

ATA.  See AT-attached. 
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AT-attached.  Peripheral devices that are compatible 

with the original IBM AT computer standard in which 

signals on a 40-pin AT-attached (ATA) ribbon cable 

followed the timings and constraints of the Industry 

Standard Architecture (ISA) system bus on the IBM PC 

AT computer. Equivalent to integrated drive electronics 

(IDE). 

auto-volume transfer/auto-disk transfer (AVT/ADT).  

A function that provides automatic failover in case of 

controller failure on a storage subsystem. 

AVT/ADT.   See auto-volume transfer/auto-disk transfer. 

AWT.   See Abstract Windowing Toolkit. 

basic input/output system (BIOS).  The personal 

computer code that controls basic hardware operations, 

such as interactions with diskette drives, hard disk 

drives, and the keyboard. 

BIOS.  See basic input/output system. 

BOOTP.   See bootstrap protocol. 

bootstrap protocol (BOOTP).  In Transmission Control 

Protocol/Internet Protocol (TCP/IP) networking, an 

alternative protocol by which a diskless machine can 

obtain its Internet Protocol (IP) address and such 

configuration information as IP addresses of various 

servers from a BOOTP  server. 

bridge.  A storage area network (SAN)  device that 

provides physical and transport conversion, such as 

Fibre Channel to small computer system interface 

(SCSI) bridge. 

bridge group.  A bridge and the collection of devices 

connected to it. 

broadcast.  The simultaneous transmission of data to 

more  than one destination. 

cathode ray tube (CRT).  A display device in which 

controlled electron beams are used to display 

alphanumeric or graphical data on an 

electroluminescent screen. 

client.  A computer system or process that requests a 

service of another computer system or process that is 

typically referred to as a server. Multiple clients can 

share access to a common server. 

command.  A statement used to initiate an action or 

start a service. A command consists of the command 

name abbreviation, and its parameters and flags if 

applicable. A command can be issued by typing it on a 

command line or selecting it from a menu. 

community string.  The name of a community 

contained in each Simple Network Management 

Protocol (SNMP) message. 

concurrent download.  A method of downloading and 

installing firmware that does not require the user to 

stop I/O to the controllers during the process. 

CRC.   See cyclic redundancy check. 

CRT.  See cathode ray tube. 

CRU.   See customer replaceable unit. 

customer replaceable unit (CRU).   An assembly or 

part that a customer can replace in its entirety when 

any of its components fail. Contrast with field replaceable 

unit (FRU). 

cyclic redundancy check (CRC).  (1) A redundancy 

check in which the check key is generated by a cyclic 

algorithm. (2) An error detection technique performed 

at both the sending and receiving stations. 

dac.  See disk array controller. 

dar.  See disk array router. 

DASD.   See direct access storage device. 

data striping.  See striping. 

default host group.  A logical collection of discovered 

host ports, defined host computers, and defined host 

groups in the storage-partition topology that fulfill the 

following requirements: 

v   Are not involved in specific logical drive-to-LUN 

mappings 

v   Share access to logical drives with default logical 

drive-to-LUN mappings

device type.  Identifier used to place devices in the 

physical map, such as the switch, hub, or storage. 

DHCP.   See Dynamic Host Configuration Protocol. 

direct access storage device (DASD).   A device in 

which access time is effectively independent of the 

location of the data. Information is entered and 

retrieved without reference to previously accessed data. 

(For example, a disk drive is a DASD,  in contrast with 

a tape drive, which stores data as a linear sequence.) 

DASDs  include both fixed and removable storage 

devices. 

direct memory access (DMA).   The transfer of data 

between memory and an input/output (I/O) device 

without processor intervention. 

disk array controller (dac).  A disk array controller 

device that represents the two  controllers of an array. 

See also disk array router. 

disk array router (dar).  A disk array router that 

represents an entire array, including current and 

deferred paths to all logical unit numbers (LUNs) 

(hdisks on AIX). See also disk array controller. 
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DMA.   See direct memory access. 

domain.  The most significant byte in the node port 

(N_port) identifier for the fibre-channel (FC) device. It 

is not used in the Fibre Channel-small computer system 

interface (FC-SCSI) hardware path ID.  It is required to 

be the same for all SCSI targets logically connected to 

an FC adapter. 

drive channels.  The DS4200, DS4700, and DS4800 

subsystems use dual-port drive channels that, from the 

physical point of view, are connected in the same way  

as two  drive loops. However, from the point of view of 

the number of drives and enclosures, they are treated 

as a single drive loop instead of two  different drive 

loops. A group of storage expansion enclosures are 

connected to the DS4000 storage subsystems using a 

drive channel from each controller. This pair of drive 

channels is referred to as a redundant drive channel 

pair. 

drive loops.  A drive loop consists of one channel from 

each controller combined to form one pair of redundant 

drive channels or a redundant drive loop. Each drive 

loop is associated with two  ports. (There are two  drive 

channels and four associated ports per controller.) For 

the DS4800, drive loops are more  commonly referred to 

as drive channels. See drive channels. 

DRAM.   See dynamic random access memory. 

Dynamic Host Configuration Protocol (DHCP).  A 

protocol defined by the Internet Engineering Task Force 

that is used for dynamically assigning Internet Protocol 

(IP) addresses to computers in a network. 

dynamic random access memory (DRAM).   A storage 

in which the cells require repetitive application of 

control signals to retain stored data. 

ECC.   See error correction coding. 

EEPROM.   See electrically erasable programmable 

read-only memory. 

EISA.  See Extended Industry Standard Architecture. 

electrically erasable programmable read-only memory 

(EEPROM).  A type of memory chip which can retain 

its contents without consistent electrical power. Unlike 

the PROM which can be programmed only once, the 

EEPROM can be erased electrically. Because it can only 

be reprogrammed a limited number of times before it 

wears out, it is appropriate for storing small amounts 

of data that are changed infrequently. 

electrostatic discharge (ESD).  The flow of current that 

results when objects that have a static charge come into 

close enough proximity to discharge. 

environmental service module (ESM) canister.  A 

component in a storage expansion enclosure that 

monitors the environmental condition of the 

components in that enclosure. Not  all storage 

subsystems have ESM canisters. 

E_port.  See expansion port. 

error correction coding (ECC).  A method for encoding 

data so that transmission errors can be detected and 

corrected by examining the data on the receiving end. 

Most ECCs  are characterized by the maximum number 

of errors they can detect and correct. 

ESD.  See electrostatic discharge. 

ESM canister.  See environmental service module canister. 

automatic ESM firmware synchronization.  When you 

install a new ESM into an existing storage expansion 

enclosure in a DS4000 storage subsystem that supports 

automatic ESM firmware synchronization, the firmware 

in the new ESM is automatically synchronized with the 

firmware in the existing ESM. 

EXP.  See storage expansion enclosure. 

expansion port (E_port).  A port that connects the 

switches for two  fabrics. 

Extended Industry Standard Architecture (EISA).  A 

bus standard for IBM compatibles that extends the 

Industry Standard Architecture (ISA) bus architecture to 

32 bits and allows more than one central processing 

unit (CPU) to share the bus. See also Industry Standard 

Architecture. 

fabric.  A Fibre Channel entity which interconnects and 

facilitates logins of N_ports attached to it. The fabric is 

responsible for routing frames between source and 

destination N_ports using address information in the 

frame header. A fabric can be as simple as a 

point-to-point channel between two  N-ports, or as 

complex as a frame-routing switch that provides 

multiple and redundant internal pathways within the 

fabric between F_ports. 

fabric port (F_port).  In a fabric, an access point for 

connecting a user’s N_port. An F_port facilitates 

N_port logins to the fabric from nodes connected to the 

fabric. An F_port is addressable by the N_port 

connected to it. See also fabric. 

FC.  See Fibre Channel. 

FC-AL.  See arbitrated loop. 

feature enable identifier.  A unique identifier for the 

storage subsystem, which is used in the process of 

generating a premium feature key. See also premium 

feature key. 

Fibre Channel (FC).  A set of standards for a serial 

input/output (I/O) bus capable of transferring data 

between two  ports at up to 100 Mbps, with standards 

proposals to go to higher speeds. FC supports 

point-to-point, arbitrated loop, and switched topologies. 
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Fibre Channel-Arbitrated Loop (FC-AL).  See arbitrated 

loop. 

Fibre Channel Protocol (FCP) for small computer 

system interface (SCSI).  A high-level fibre-channel 

mapping layer (FC-4) that uses lower-level 

fibre-channel (FC-PH) services to transmit SCSI 

commands, data, and status information between a 

SCSI initiator and a SCSI target across the FC link by 

using FC frame and sequence formats. 

field replaceable unit (FRU).  An assembly that is 

replaced in its entirety when any one of its components 

fails. In some cases, a field replaceable unit might 

contain other field replaceable units. Contrast with 

customer replaceable unit (CRU). 

FlashCopy.  A premium feature for DS4000 that can 

make an instantaneous copy of the data in a volume. 

F_port.  See fabric port. 

FRU.   See field replaceable unit. 

GBIC.   See gigabit interface converter 

gigabit interface converter (GBIC).  A transceiver that 

performs serial, optical-to-electrical, and 

electrical-to-optical signal conversions for high-speed 

networking. A GBIC can be hot swapped. See also small 

form-factor pluggable. 

Global Copy.  Refers to a remote logical drive mirror 

pair that is set up using asynchronous write mode 

without the write consistency group option. This is also 

referred to as ″Asynchronous Mirroring without 

Consistency Group.″ Global Copy does not ensure that 

write requests to multiple primary logical drives are 

carried out in the same order on the secondary logical 

drives as they are on the primary logical drives. If it is 

critical that writes to the primary logical drives are 

carried out in the same order in the appropriate 

secondary logical drives, Global Mirroring should be 

used instead of Global Copy. See also asynchronous write 

mode, Global Mirroring, remote mirroring, Metro Mirroring. 

Global Mirroring.  Refers to a remote logical drive 

mirror pair that is set up using asynchronous write 

mode with the write consistency group option. This is 

also referred to as ″Asynchronous Mirroring with 

Consistency Group.″ Global Mirroring ensures that 

write requests to multiple primary logical drives are 

carried out in the same order on the secondary logical 

drives as they are on the primary logical drives, 

preventing data on the secondary logical drives from 

becoming inconsistent with the data on the primary 

logical drives. See also asynchronous write mode, Global 

Copy, remote mirroring, Metro Mirroring. 

graphical user interface (GUI).  A type of computer 

interface that presents a visual metaphor of a 

real-world scene, often of a desktop, by combining 

high-resolution graphics, pointing devices, menu bars 

and other menus, overlapping windows, icons, and the 

object-action relationship. 

GUI.   See graphical user interface. 

HBA.   See host bus adapter. 

hdisk.  An AIX  term representing a logical unit 

number (LUN)  on an array. 

heterogeneous host environment.  A host system in 

which multiple host servers, which use different 

operating systems with their own  unique disk storage 

subsystem settings, connect to the same DS4000 storage 

subsystem at the same time. See also host. 

host.  A system that is directly attached to the storage 

subsystem through a fibre-channel input/output (I/O) 

path. This system is used to serve data (typically in the 

form of files) from the storage subsystem. A system can 

be both a storage management station and a host 

simultaneously. 

host bus adapter (HBA).  An interface between the 

fibre-channel network and a workstation or server. 

host computer.  See host. 

host group.  An entity in the storage partition topology 

that defines a logical collection of host computers that 

require shared access to one or more logical drives. 

host port.  Ports that physically reside on the host 

adapters and are automatically discovered by the 

DS4000 Storage Manager software. To give a host 

computer access to a partition, its associated host ports 

must be defined. 

hot swap.  To replace a hardware component without 

turning off the system. 

hub.  In a network, a point at which circuits are either 

connected or switched. For example, in a star network, 

the hub is the central node; in a star/ring network, it is 

the location of wiring concentrators. 

IBMSAN driver.  The device driver that is used in a 

Novell NetWare environment to provide multipath 

input/output (I/O) support to the storage controller. 

IC.   See integrated circuit. 

IDE.  See integrated drive electronics. 

in-band.  Transmission of management protocol over 

the fibre-channel transport. 

Industry Standard Architecture (ISA).  Unofficial 

name for the bus architecture of the IBM PC/XT 

personal computer. This bus design included expansion 

slots for plugging in various adapter boards. Early 

versions had an 8-bit data path, later expanded to 16 

bits. The ″Extended Industry Standard Architecture″ 
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(EISA) further expanded the data path to 32 bits. See 

also Extended Industry Standard Architecture. 

initial program load (IPL).  The initialization 

procedure that causes an operating system to 

commence operation. Also referred to as a system 

restart, system startup, and boot. 

integrated circuit (IC).  A microelectronic 

semiconductor device that consists of many 

interconnected transistors and other components. ICs  

are constructed on a small rectangle cut from a silicon 

crystal or other semiconductor material. The small size 

of these circuits allows high speed, low power 

dissipation, and reduced manufacturing cost compared 

with board-level integration. Also known as a chip. 

integrated drive electronics (IDE).  A disk drive 

interface based on the 16-bit IBM personal computer 

Industry Standard Architecture (ISA) in which the 

controller electronics reside on the drive itself, 

eliminating the need for a separate adapter card. Also 

known as an Advanced Technology Attachment 

Interface (ATA). 

Internet Protocol (IP).  A protocol that routes data 

through a network or interconnected networks. IP acts 

as an intermediary between the higher protocol layers 

and the physical network. 

Internet Protocol (IP) address.  The unique 32-bit 

address that specifies the location of each device or 

workstation on the Internet. For example, 9.67.97.103 is 

an IP address. 

interrupt request (IRQ).  A type of input found on 

many processors that causes the processor to suspend 

normal processing temporarily and start running an 

interrupt handler routine. Some processors have several 

interrupt request inputs that allow different priority 

interrupts. 

IP.  See Internet Protocol. 

IPL.  See initial program load. 

IRQ.   See interrupt request. 

ISA.  See Industry Standard Architecture. 

Java Runtime Environment (JRE).  A subset of the 

Java Development Kit  (JDK)  for end users and 

developers who  want to redistribute the Java Runtime 

Environment (JRE). The JRE consists of the Java virtual 

machine, the Java Core  Classes, and supporting files. 

JRE.  See Java Runtime Environment. 

label.  A discovered or user entered property value 

that is displayed underneath each device in the 

Physical and Data Path maps. 

LAN.   See local area network. 

LBA.  See logical block address. 

local area network (LAN).  A computer network 

located on a user’s premises within a limited 

geographic area. 

logical block address (LBA).  The address of a logical 

block. Logical block addresses are typically used in 

hosts’ I/O commands. The SCSI disk command 

protocol, for example, uses logical block addresses. 

logical partition (LPAR).  (1) A subset of a single 

system that contains resources (processors, memory, 

and input/output devices). A logical partition operates 

as an independent system. If hardware requirements 

are met, multiple logical partitions can exist within a 

system. (2) A fixed-size portion of a logical volume. A 

logical partition is the same size as the physical 

partitions in its volume group. Unless the logical 

volume of which it is a part is mirrored, each logical 

partition corresponds to, and its contents are stored on, 

a single physical partition. (3) One  to three physical 

partitions (copies). The number of logical partitions 

within a logical volume is variable. 

logical unit number (LUN).  An identifier used on a 

small computer system interface (SCSI) bus to 

distinguish among up to eight devices (logical units) 

with the same SCSI ID.  

loop address.  The unique ID of a node in 

fibre-channel loop topology sometimes referred to as a 

loop ID.  

loop group.  A collection of storage area network 

(SAN)  devices that are interconnected serially in a 

single loop circuit. 

loop port.  A node port (N_port) or fabric port (F_port) 

that supports arbitrated loop functions associated with 

an arbitrated loop topology. 

LPAR.   See logical partition. 

LUN.   See logical unit number. 

MAC.   See medium access control. 

management information base (MIB).  The 

information that is on an agent. It is an abstraction of 

configuration and status information. 

man  pages.  In UNIX-based operating systems, online 

documentation for operating system commands, 

subroutines, system calls, file formats, special files, 

stand-alone utilities, and miscellaneous facilities. 

Invoked by the man  command. 

MCA.   See micro channel architecture. 

media scan.  A media scan is a background process 

that runs on all logical drives in the storage subsystem 

for which it has been enabled, providing error detection 

on the drive media. The media scan process scans all 
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logical drive data to verify that it can be accessed, and 

optionally scans the logical drive redundancy 

information. 

medium access control (MAC).   In local area networks 

(LANs), the sublayer of the data link control layer that 

supports medium-dependent functions and uses the 

services of the physical layer to provide services to the 

logical link control sublayer. The MAC sublayer 

includes the method of determining when a device has 

access to the transmission medium. 

Metro Mirroring.  This term is used to refer to a 

remote logical drive mirror pair which is set up with 

synchronous write mode. See also remote mirroring, 

Global Mirroring. 

MIB.  See management information base. 

micro channel architecture (MCA).   Hardware  that is 

used for PS/2 Model 50 computers and above to 

provide better growth potential and performance 

characteristics when compared with the original 

personal computer design. 

Microsoft Cluster Server (MSCS).  MSCS,  a feature of 

Windows NT Server (Enterprise Edition), supports the 

connection of two  servers into a cluster for higher 

availability and easier manageability. MSCS  can 

automatically detect and recover from server or 

application failures. It can also be used to balance 

server workload and provide for planned maintenance. 

mini hub.  An interface card or port device that 

receives short-wave fiber channel GBICs  or SFPs. These 

devices enable redundant Fibre Channel connections 

from the host computers, either directly or through a 

Fibre Channel switch or managed hub, over optical 

fiber cables to the DS4000 Storage Server controllers. 

Each DS4000 controller is responsible for two  mini 

hubs. Each mini hub has two  ports. Four host ports 

(two on each controller) provide a cluster solution 

without use of a switch. Two host-side mini hubs are 

shipped as standard. See also host port, gigabit interface 

converter (GBIC), small form-factor pluggable (SFP). 

mirroring.  A fault-tolerance technique in which 

information on a hard disk is duplicated on additional 

hard disks. See also remote mirroring. 

model.  The model identification that is assigned to a 

device by its manufacturer. 

MSCS.   See Microsoft Cluster Server. 

network management station (NMS).  In the Simple 

Network Management Protocol (SNMP), a station that 

runs management application programs that monitor 

and control network elements. 

NMI.   See non-maskable interrupt. 

NMS.   See network management station. 

non-maskable interrupt (NMI).  A hardware interrupt 

that another service request cannot overrule (mask). An 

NMI bypasses and takes priority over interrupt 

requests generated by software, the keyboard, and 

other such devices and is issued to the microprocessor 

only in disastrous circumstances, such as severe 

memory errors or impending power failures. 

node.  A physical device that allows for the 

transmission of data within a network. 

node port (N_port).  A fibre-channel defined hardware 

entity that performs data communications over the 

fibre-channel link. It is identifiable by a unique 

worldwide name. It can act as an originator or a 

responder. 

nonvolatile storage (NVS).  A storage device whose 

contents are not lost when power is cut off. 

N_port.  See node port. 

NVS.   See nonvolatile storage. 

NVSRAM.   Nonvolatile storage random access 

memory. See nonvolatile storage. 

Object Data Manager (ODM).   An AIX  proprietary 

storage mechanism for ASCII  stanza files that are 

edited as part of configuring a drive into the kernel. 

ODM.   See Object Data Manager. 

out-of-band.  Transmission of management protocols 

outside of the fibre-channel network, typically over 

Ethernet. 

partitioning.  See storage partition. 

parity check.  (1) A test to determine whether the 

number of ones (or zeros) in an array of binary digits is 

odd or even. (2) A mathematical operation on the 

numerical representation of the information 

communicated between two  pieces. For example, if 

parity is odd, any character represented by an even 

number has a bit added to it, making it odd, and an 

information receiver checks that each unit of 

information has an odd value. 

PCI  local bus.  See peripheral component interconnect 

local bus. 

PDF.  See portable document format. 

performance events.  Events related to thresholds set 

on storage area network (SAN)  performance. 

peripheral component interconnect local bus (PCI 

local bus).  A local bus for PCs, from Intel, that 

provides a high-speed data path between the CPU  and 

up to 10 peripherals (video, disk, network, and so on). 

The PCI bus coexists in the PC with the Industry 

Standard Architecture (ISA) or Extended Industry 

Standard Architecture (EISA) bus. ISA and EISA boards 
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plug into an IA or EISA slot, while high-speed PCI  

controllers plug into a PCI  slot. See also Industry 

Standard Architecture, Extended Industry Standard 

Architecture. 

polling delay.  The time in seconds between successive 

discovery processes during which discovery is inactive. 

port.  A part of the system unit or remote controller to 

which cables for external devices (such as display 

stations, terminals, printers, switches, or external 

storage units) are attached. The port is an access point 

for data entry or exit. A device can contain one or more 

ports. 

portable document format (PDF).  A standard 

specified by Adobe Systems, Incorporated, for the 

electronic distribution of documents. PDF  files are 

compact; can be distributed globally by e-mail, the 

Web, intranets, or CD-ROM;  and can be viewed with 

the Acrobat Reader, which is software from Adobe 

Systems that can be downloaded at no cost from the 

Adobe Systems home page. 

premium feature key.  A file that the storage 

subsystem controller uses to enable an authorized 

premium feature. The file contains the feature enable 

identifier of the storage subsystem for which the 

premium feature is authorized, and data about the 

premium feature. See also feature enable identifier. 

private loop.  A freestanding arbitrated loop with no 

fabric attachment. See also arbitrated loop. 

program temporary fix (PTF).  A temporary solution 

or bypass of a problem diagnosed by IBM in a current 

unaltered release of the program. 

PTF.  See program temporary fix. 

RAID.   See redundant array of independent disks (RAID). 

RAID  level.  An array’s RAID level is a number that 

refers to the method used to achieve redundancy and 

fault tolerance in the array. See also array, redundant 

array of independent disks (RAID). 

RAID  set.  See array. 

RAM.   See random-access memory. 

random-access memory (RAM).   A temporary storage 

location in which the central processing unit (CPU)  

stores and executes its processes. Contrast with DASD. 

RDAC.   See redundant disk array controller. 

read-only memory (ROM).   Memory in which stored 

data cannot be changed by the user except under 

special conditions. 

recoverable virtual shared disk (RVSD).  A virtual 

shared disk on a server node configured to provide 

continuous access to data and file systems in a cluster. 

redundant array of independent disks (RAID).   A 

collection of disk drives (array) that appears as a single 

volume to the server, which is fault tolerant through an 

assigned method of data striping, mirroring, or parity 

checking. Each array is assigned a RAID level, which is 

a specific number that refers to the method used to 

achieve redundancy and fault tolerance. See also array, 

parity check, mirroring, RAID level, striping. 

redundant disk array controller (RDAC).   (1) In 

hardware, a redundant set of controllers (either 

active/passive or active/active). (2) In software, a layer 

that manages the input/output (I/O) through the 

active controller during normal operation and 

transparently reroutes I/Os to the other controller in 

the redundant set if a controller or I/O path fails. 

remote mirroring.  Online, real-time replication of data 

between storage subsystems that are maintained on 

separate media. The Enhanced Remote Mirror Option is 

a DS4000 premium feature that provides support for 

remote mirroring. See also Global Mirroring, Metro 

Mirroring. 

ROM.   See read-only memory. 

router.  A computer that determines the path of 

network traffic flow. The path selection is made from 

several paths based on information obtained from 

specific protocols, algorithms that attempt to identify 

the shortest or best path, and other criteria such as 

metrics or protocol-specific destination addresses. 

RVSD.   See recoverable virtual shared disk. 

SAI.  See Storage Array Identifier. 

SA Identifier.  See Storage Array Identifier. 

SAN.   See storage area network. 

SATA.  See serial ATA. 

scope.  Defines a group of controllers by their Internet 

Protocol (IP) addresses. A scope must be created and 

defined so that dynamic IP addresses can be assigned 

to controllers on the network. 

SCSI.  See small computer system interface. 

segmented loop port (SL_port).  A port that allows 

division of a fibre-channel private loop into multiple 

segments. Each segment can pass frames around as an 

independent loop and can connect through the fabric to 

other segments of the same loop. 

sense data.  (1) Data sent with a negative response, 

indicating the reason for the response. (2) Data 

describing an I/O error. Sense data is presented to a 

host system in response to a sense request command. 
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serial ATA.  The standard for a high-speed alternative 

to small computer system interface (SCSI) hard drives. 

The SATA-1 standard is equivalent in performance to a 

10 000 RPM  SCSI drive. 

serial storage architecture (SSA).  An interface 

specification from IBM in which devices are arranged 

in a ring topology. SSA, which is compatible with small 

computer system interface (SCSI) devices, allows 

full-duplex packet multiplexed serial data transfers at 

rates of 20 Mbps in each direction. 

server.  A functional hardware and software unit that 

delivers shared resources to workstation client units on 

a computer network. 

server/device events.  Events that occur on the server 

or a designated device that meet criteria that the user 

sets. 

SFP.  See small form-factor pluggable. 

Simple Network Management Protocol (SNMP).  In 

the Internet suite of protocols, a network management 

protocol that is used to monitor routers and attached 

networks. SNMP  is an application layer protocol. 

Information on devices managed is defined and stored 

in the application’s Management Information Base 

(MIB). 

SL_port.  See segmented loop port. 

SMagent.  The DS4000 Storage Manager optional 

Java-based host-agent software, which can be used on 

Microsoft Windows, Novell NetWare, AIX, HP-UX, 

Solaris, and Linux on POWER  host systems to manage 

storage subsystems through the host fibre-channel 

connection. 

SMclient.  The DS4000 Storage Manager client 

software, which is a Java-based graphical user interface 

(GUI)  that is used to configure, manage, and 

troubleshoot storage servers and storage expansion 

enclosures in a DS4000 storage subsystem. SMclient can 

be used on a host system or on a storage management 

station. 

SMruntime.  A Java compiler for the SMclient. 

SMutil.  The DS4000 Storage Manager utility software 

that is used on Microsoft Windows, AIX, HP-UX, 

Solaris, and Linux on POWER  host systems to register 

and map  new logical drives to the operating system. In 

Microsoft Windows, it also contains a utility to flush 

the cached data of the operating system for a particular 

drive before creating a FlashCopy. 

small computer system interface (SCSI).  A standard 

hardware interface that enables a variety of peripheral 

devices to communicate with one another. 

small form-factor pluggable (SFP).  An optical 

transceiver that is used to convert signals between 

optical fiber cables and switches. An SFP is smaller 

than a gigabit interface converter (GBIC). See also 

gigabit interface converter. 

SNMP.   See Simple Network Management Protocol and 

SNMPv1. 

SNMP  trap event.  (1) (2) An event notification sent by 

the SNMP  agent that identifies conditions, such as 

thresholds, that exceed a predetermined value. See also 

Simple Network Management Protocol. 

SNMPv1.  The original standard for SNMP  is now 

referred to as SNMPv1, as opposed to SNMPv2, a 

revision of SNMP.  See also Simple Network Management 

Protocol. 

SRAM.   See static random access memory. 

SSA.  See serial storage architecture. 

static random access memory (SRAM).  Random 

access memory based on the logic circuit know as 

flip-flop. It is called static because it retains a value as 

long as power is supplied, unlike dynamic random 

access memory (DRAM),  which must be regularly 

refreshed. It is however, still volatile, meaning that it 

can lose its contents when the power is turned off. 

storage area network (SAN).  A dedicated storage 

network tailored to a specific environment, combining 

servers, storage products, networking products, 

software, and services. See also fabric. 

Storage Array Identifier (SAI or SA Identifier).  The 

Storage Array Identifier is the identification value used 

by the DS4000 Storage Manager host software 

(SMClient) to uniquely identify each managed storage 

server. The DS4000 Storage Manager SMClient program 

maintains Storage Array Identifier records of 

previously-discovered storage servers in the host 

resident file, which allows it to retain discovery 

information in a persistent fashion. 

storage expansion enclosure (EXP).  A feature that can 

be connected to a system unit to provide additional 

storage and processing capacity. 

storage management station.  A system that is used to 

manage the storage subsystem. A storage management 

station does not need to be attached to the storage 

subsystem through the fibre-channel input/output 

(I/O) path. 

storage partition.  Storage subsystem logical drives 

that are visible to a host computer or are shared among 

host computers that are part of a host group. 

storage partition topology.  In the DS4000 Storage 

Manager client, the Topology view of the Mappings 

window displays the default host group, the defined 

host group, the host computer, and host-port nodes. 

The host port, host computer, and host group 
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topological elements must be defined to grant access to 

host computers and host groups using logical 

drive-to-LUN mappings. 

striping.  Splitting data to be written into equal blocks 

and writing blocks simultaneously to separate disk 

drives. Striping maximizes performance to the disks. 

Reading the data back is also scheduled in parallel, 

with a block being read concurrently from each disk 

then reassembled at the host. 

subnet.  An interconnected but independent segment 

of a network that is identified by its Internet Protocol 

(IP) address. 

sweep method.  A method of sending Simple Network 

Management Protocol (SNMP) requests for information 

to all the devices on a subnet by sending the request to 

every device in the network. 

switch.  A fibre-channel device that provides full 

bandwidth per port and high-speed routing of data by 

using link-level addressing. 

switch group.  A switch and the collection of devices 

connected to it that are not in other groups. 

switch zoning.  See zoning. 

synchronous write mode.  In remote mirroring, an 

option that requires the primary controller to wait for 

the acknowledgment of a write operation from the 

secondary controller before returning a write I/O 

request completion to the host. See also asynchronous 

write mode, remote mirroring, Metro Mirroring. 

system name.  Device name assigned by the vendor’s 

third-party software. 

TCP.   See Transmission Control Protocol. 

TCP/IP.  See Transmission Control Protocol/Internet 

Protocol. 

terminate and stay resident program (TSR program).  

A program that installs part of itself as an extension of 

DOS  when it is executed. 

topology.  The physical or logical arrangement of 

devices on a network. The three fibre-channel 

topologies are fabric, arbitrated loop, and 

point-to-point. The default topology for the disk array 

is arbitrated loop. 

TL_port.  See translated loop port. 

transceiver.  A device that is used to transmit and 

receive data. Transceiver is an abbreviation of 

transmitter-receiver. 

translated loop port (TL_port).  A port that connects to 

a private loop and allows connectivity between the 

private loop devices and off loop devices (devices not 

connected to that particular TL_port). 

Transmission Control Protocol (TCP).  A 

communication protocol used in the Internet and in 

any network that follows the Internet Engineering Task 

Force (IETF) standards for internetwork protocol. TCP 

provides a reliable host-to-host protocol between hosts 

in packed-switched communication networks and in 

interconnected systems of such networks. It uses the 

Internet Protocol (IP) as the underlying protocol. 

Transmission Control Protocol/Internet Protocol 

(TCP/IP).  A set of communication protocols that 

provide peer-to-peer connectivity functions for both 

local and wide-area networks. 

trap.  In the Simple Network Management Protocol 

(SNMP), a message sent by a managed node (agent 

function) to a management station to report an 

exception condition. 

trap recipient.  Receiver of a forwarded Simple 

Network Management Protocol (SNMP) trap. 

Specifically, a trap receiver is defined by an Internet 

Protocol (IP) address and port to which traps are sent. 

Presumably, the actual recipient is a software 

application running at the IP address and listening to 

the port. 

TSR program.  See terminate and stay resident program. 

uninterruptible power supply.  A source of power 

from a battery that is installed between a computer 

system and its power source. The uninterruptible 

power supply keeps the system running if a 

commercial power failure occurs, until an orderly 

shutdown of the system can be performed. 

user action events.  Actions that the user takes, such as 

changes in the storage area network (SAN), changed 

settings, and so on. 

worldwide port name (WWPN).   A unique identifier 

for a switch on local and global networks. 

worldwide name (WWN).   A globally unique 64-bit 

identifier assigned to each Fibre Channel port. 

WORM.   See write-once read-many. 

write-once read many (WORM).   Any  type of storage 

medium to which data can be written only a single 

time, but can be read from any number of times. After 

the data is recorded, it cannot be altered. 

WWN.   See worldwide name. 

zoning.  (1) In Fibre Channel environments, the 

grouping of multiple ports to form a virtual, private, 

storage network. Ports that are members of a zone can 

communicate with each other, but are isolated from 

ports in other zones. (2) A function that allows 

segmentation of nodes by address, name, or physical 

port and is provided by fabric switches or hubs.
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A
access controller shell 126 

add
new hard drives 55 

single drive  enclosure
final connection 83,  98,  103, 104 

first connection 81, 96 

second  connection 82, 97 

storage  expansion  enclosures 69 

license requirement  1 

used hard drives 56 

AppWare  45 

array
cannot  bring  online  65 

configuration data  for  drives 

incomplete 65 

RAID-level modification 52 

redundancy  checking 52 

return online  125 

arrays, migrating 65 

attention 57,  65,  71, 75, 110, 112 

automatically reset controllers 57, 58, 

101, 111 

B
backup

logical drives 61,  74 

storage  subsystem data 41,  123 

bag  or container, ESD 115 

beginning  of drive  loop,  connect storage 

expansion enclosures 95 

BootWare  45 

bottom  of drive  loop,  connect storage 

expansion enclosures 80 

C
cable

connections  82, 83, 97,  98,  103, 104 

EXP500  to EXP700  12 

EXP700  to EXP500  12 

EXP710  to EXP810  23 

trace connections  75, 122  

cabling,  incorrect 26 

cabling,  powering  on
verifying storage  expansion  unit  

operation 78 

cannot  bring  array online  65 

catastrophic failure 53 

change  Fibre  Channel  speed settings 11 

change  storage server IP address 125  

check drive  firmware  level 51,  52 

check for  configuration data 58 

on newly  discovered drives 111 

Class A electronic emission notice 174 

clear configuration data 102  

compliant  state 121 

Concepts  Guide  161  

concurrent  firmware download  50 

configuration
behavior  after replacement 119 

data, clear 102 

configuration data 61 

configure  drives 58 

connecting expansion enclosures
rules  152 

container or bag,  ESD 115 

controller
blade, embedded  unique  

identifier 120 

drive  loop  LED 76,  122 

firmware download  during  I/O 49 

firmware version 41 

by machine  type  45 

by model  number  45 

by NVSRAM  version 45 

current 48 

firmware, verify level 41, 48, 62, 122 

reset automatically 57, 58, 101, 111 

shell, accessing 126 

controller firmware 44 

controller IP addresses 121 

Copy  Services Guide  161 

copyback,  logical drive  52 

customize storage partitioning 

information 62 

D
DACstore  119, 121  

DCE 52 

disable drive  migration settings 57,  101 

become  effective 58 

DisableDriveMigration.scr script 59 

documentation
DS4000 161  

DS4000 Storage  Manager  161 

DS4000-related documents  171 

DS4100 SATA Storage  Subsystem 169 

DS4200 Express Storage  

Subsystem 168 

DS4300 Fibre  Channel  Storage  

Subsystem 167 

DS4400 Fibre  Channel  Storage  

Subsystem 166 

DS4500 Storage  Subsystem 165 

DS4700 Storage  Subsystem 164 

DS4800 Storage  Subsystem 162 

download  firmware with I/O 50 

downloading  drive  firmware 49 

drive  displays as unconfigured  110 

drive  expansion enclosure weight  76 

drive  firmware
downloading  49 

drive  firmware  download  49 

drive  firmware  levels, determining 37 

drive  firmware, level  51, 52 

drive  ID and model,  determining 39 

drive  loop
optimal state 52 

drive  loop (continued)
pairs, maximum  allowable  1 

speed change  procedure  11 

drive  loop pairs, maximum  14 

drive  loop schemes 26 

drive  loop state, determine 41 

drive  loops  A and B 80, 81, 95,  96 

drive  migration
prerequisites 41 

settings
disable 57,  101 

enable 110 

re-enable 57, 102 

drive  migration enable settings
verifying 76 

drives
CRU assembly 63 

do not  appear  marked as Failed 65 

do not  display 65 

maximum  allowable  1 

remove
configuration data  57 

will not  spin up 55, 69 

DS4000
Hardware  Maintenance Manual  171  

Problem  Determination Guide  171 

Storage  Expansion  Enclosure  

documentation  170 

DS4000 documentation  161  

DS4000 Problem  Determination 

Guide  122 

DS4000 Storage  Manager
documentation  161 

related documents  171 

DS4000 Storage  Manager  

publications  39 

DS4000 Storage  Subsystem
firmware 44 

NVSRAM 44 

profile 44 

DS4000 support
Web site 48 

DS4000/FAStT product  renaming  xv 

DS4100
Storage  Subsystem library 169 

DS4100 dual  controller replacement  with 

single controller 118 

DS4100 single controller replacement with 

dual  controller 118 

DS4200 Express
Storage  Subsystem library 168 

DS4300
1 Gbps  Fibre  Channel  drives 69 

enclosure IDs  73 

Storage  Subsystem firmware and  

NVSRAM  45 

Storage  Subsystem library 167 

Turbo  Storage  Subsystem  firmware  

and NVSRAM 45 

DS4300 Storage  Subsystem 

migration 118 
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DS4400
Storage  Subsystem library 166 

DS4400  Storage  Subsystem firmware and 

NVSRAM  45 

DS4500
Storage  Subsystem library 165 

DS4500  Storage  Subsystem firmware and 

NVSRAM  45 

DS4700
Storage  Subsystem library 164 

DS4800
Storage  Subsystem library 162 

dual  controller replacement  with single 

controller 118 

dual  drive  loop  1 

DVE 52 

dynamic
capacity expansion,  DCE 52 

volume  expansion,  DVE 52 

E
electronic emission Class  A notice 174 

Electronic emission notices
Australia and New Zealand Class A 

statement 175  

European  Union  EMC Directive 

conformance  statement 175 

Federal  Communications  Commission  

(FCC)  statement 174 

Industry Canada  Class  A emission 

compliance  statement 175 

Japanese Voluntary Control  Council  

for  Interference (VCCI)  

statement 176  

Taiwanese Class A warning  

statement 176  

United Kingdom  telecommunications 

safety requirement  175 

electrostatic discharge  (ESD)  bags  64 

electrostatic discharge  (ESD)  

procedure  55 

electrostatic discharge  procedure  54 

empty  drive  icon 65 

emulation program,  sample  126  

EnableDriveMigration.scr script 58, 111 

enclosure ID 31 

end of drive  loop,  connect storage  

expansion  enclosures 80 

environmental  service module  (ESM)  

firmware  12 

errors
drive  enclosure lost redundancy  

path 80, 81, 95,  96 

loss of ESM path redundancy  76, 122 

management  event  log  (MEL)  41 

out-of-compliance 126  

ESD bag  or container  76, 115 

ESD procedures  54 

ESM Fault  LED 75,  122 
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Readers’  comments  —  we  would  like  to hear  from  you.  

IBM System Storage DS4000 

Hard Drive and Storage Expansion Enclosure Installation and Migration Guide 

 Publication No.  GC26-7849-01 

 We appreciate your comments about this publication. Please comment on specific errors or omissions, accuracy, 

organization, subject matter, or completeness of this book. The comments you send should pertain to only the 

information in this manual or product and the way  in which the information is presented. 

For technical questions and information about products and prices, please contact your IBM branch office, your 

IBM business partner, or your authorized remarketer. 

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any 

way  it believes appropriate without incurring any obligation to you. IBM or any other organizations will only use 

the personal information that you supply to contact you about the issues that you state on this form. 

Comments: 

 Thank you for your support. 

Submit your comments using one of these channels: 

v   Send your comments to the address on the reverse side of this form. 

If you would like a response from IBM, please fill in the following information: 

 

Name
 

Address 

Company or Organization
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